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Microsoft license terms 
This courseware is the copyrighted work of Microsoft and/or its suppliers, and is 
licensed, not sold, to you. Microsoft grants you a license to use this courseware, but only 
in accordance with the “Guidelines” below. Except as expressly provided for herein, you 
may not copy, adapt, modify, prepare derivative works of, distribute, publicly display, sell 
or use this courseware, in whole or in part, for any commercial purpose without the 
express prior written consent of Microsoft Corporation. 

This courseware is provided to you “as-is.” Microsoft makes no warranties as to this 
courseware, express or implied.  MICROSOFT CORPORATION HEREBY DISCLAIMS ALL 
WARRANTIES AND CONDITIONS WITH REGARD TO THE SOFTWARE, INCLUDING ALL 
WARRANTIES AND CONDITIONS OF MERCHANTABILITY, WHETHER EXPRESS, IMPLIED 
OR STATUTORY, FITNESS FOR A PARTICULAR PURPOSE, TITLE AND NON-
INFRINGEMENT. Microsoft may change or alter the information in this courseware, 
including URL and other Internet Web site references, without notice to you. 

Examples depicted herein are provided for illustration purposes only and are fictitious. 
No real association or connection is intended or should be inferred. 

This courseware does not provide you with any legal rights to any intellectual property 
in or to any Microsoft products. 

The Microsoft Terms of Use are incorporated herein by reference. 

Guidelines 
This courseware is only for use by instructors and only to teach a class for current 
Microsoft Imagine Academy program members. If you are not an instructor, you are not 
permitted to use this courseware. The following terms apply to your use of this 
courseware: 

 You may distribute this courseware only to those students enrolled in your class 
using the courseware, or publish this courseware on a secured website that is 
restricted to students enrolled in that class, provided that if you distribute this 
courseware: 

 you will not grant any rights to copy, adapt, modify, prepare derivative works of, 
distribute, publicly display or sell this courseware; 

 you may not distribute this courseware under terms that would permit 
commercial use, or under terms that purport to require that this courseware, in 
whole or in part, be sublicensed to others or redistributable at no charge; and 

 you will maintain and not alter, obscure or remove any copyright or other 
protective notices, identifications or branding in or on the courseware. 

https://aka.ms/Terms_of_Use
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 If you are using this courseware in Microsoft OneNote format, you may use 
supplemental materials in addition to and in conjunction with your classes, provided 
that you: 

 will only use supplemental materials developed by you and not by, or in 
collaboration with, any third party; 

 clearly differentiate the supplemental materials from the Microsoft content, 
including this courseware, by inserting prominent notice on the supplemental 
materials clearly indicating to students that they are not Microsoft materials. Such 
notices must: (i) clearly identify the supplemental materials, and (ii) not state or 
imply that Microsoft authored or endorsed the supplemental materials; and 

 warrant and represent that the supplemental materials will not infringe or violate 
any intellectual property, proprietary, personal or any other rights of any third 
party. 

© 2019 Microsoft. All rights reserved. 
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Module overview 
Description 
To maximize the use of the features of any application, it's important to be well versed 
with its interface and its basic uses. This will help you save time when learning how to 
use different features. 

This module introduces you to Microsoft Word 2019 with a tour of the application 
interface through various activities and discussions. You'll also have plenty of 
opportunities to apply these learned concepts. 

You'll begin by learning how to identify elements of the user interface (UI), manage the 
ribbon and Quick Access Toolbar, and understand the status bar and Tell Me feature. 
Next, you'll create new documents and save documents as different file types. You'll 
learn how to add content and apply simple formatting options. Finally, you'll discover 
how to search for and replace text and how to navigate to searched content in the 
document. Get ready to build a strong foundation in Word for your certifications 
through the lessons outlined in the following table. 

Lesson Learning objective Exam objectives 

Getting started 
with Word 

Identify the location and purpose of key 
elements of the Word interface 

• Not mapped 

Customizing 
toolbars 

Work with the Quick Access Toolbar, 
the status bar, and the Tell Me feature 
to improve your productivity 

• Not mapped 

Creating, opening, 
and saving 
documents 

Create, open, and save documents as 
different file types 

• 1.3.1 

Formatting text Manage text formatting and text effects • 2.2.4 
• 2.2.5 
• 2.2.1 
• 2.2.2 
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Lesson Learning objective Exam objectives 

Formatting 
paragraphs 

Manage paragraphs by using line and 
paragraph spacing and by changing the 
indentation 

• 2.2.3 

Navigating within 
documents 

Use the Navigation pane to search for 
text or to go to a specific location in a 
document 

• 1.1.1 
• 1.1.2 
• 1.1.3 

Cornerstone Format and update a booth event list 
and finish an inherited call-for-vendors 
letter for the upcoming Blueberries and 
Balloons Festival at Munson’s Pickles 
and Preserves Farm 

• All of the 
preceding exam 
objectives 

Table 1: Objectives by lesson 

Scenario 
At Munson’s Pickles and Preserves Farm, a high point of the summer is the Blueberries 
and Balloons Festival. This has been a yearly tradition for a while, and thousands attend 
it for fun, family activities, and good food. 

Assume that Munson’s has recruited you as an intern and that you've worked for a few 
weeks with their marketing team. They now need your help with promotional material 
for the festival, most of which they've created in Word. Besides needing you to update 
this material, Munson’s has just revised its branding with new logos and a new color 
theme, which you'll need to implement. This is a fun way for you to apply what you'll 
learn in this module! 
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Cornerstone 
At the end of this module, you’ll complete a Cornerstone project to put what you learn 
into practice. You'll open and format documents according to the requirements of 
Munson’s marketing department. You’ll also add links and bookmarks within documents 
and ensure that they're user friendly and meet the marketing guidelines that Munson’s 
has in place. You'll save your documents in different file formats to make them more 
shareable and easier for a large audience to use. To do all of this, you'll work with an 
existing document, the Call for Vendors; search for text within the document; and 
replace specific promotional terms approved by the marketing team. 
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Lesson 1: Getting started with 
Word 
Overview 
Welcome to Word! Are you ready for a fun and engaging course? You'll learn a lot by 
observing and interacting and then by solving real-world problems through applying 
the different concepts that the lessons in this course cover. Take note of information 
that might be of additional interest to you, such as the Did you know? callouts, videos, 
and articles that will help you connect your learning to real-world needs. These will 
further enrich your learning. 

At the end of this lesson, you'll be able to identify the location and purpose of the key 
interface elements of Word and begin to learn how to use these elements as you work 
in Word. In this lesson, you'll follow along with your teacher to explore the Word 
interface, learn how to manage the display options for the ribbon, and then explore the 
ribbon to better identify the commands and groups located on various tabs. Learning 
how to manage the ribbon display and the key interface elements will allow you to 
become efficient in Word as you begin working on documents. 

 

Did you know? 

Two programmers that Microsoft hired in 1981 developed the first 
version of Word, which was released in October 1983. In the 2007 
version, the Word UI changed from one of tools and menus to the 
ribbon interface. 
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Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. Which of the following items do people most commonly use the Word application to 
create? 

Select the correct option. 

a. Create spreadsheets to track items such as budgets, lists, and timesheets. 

b. Create slides to present content such as a meeting agenda. 

c. Create documents to distribute, such as letters, brochures, and social media 
posts. 

d. Create database objects to manage data between systems. 

2. Which of the following ribbon tabs are unique to Word, that is, these ribbon tabs are 
not found in other applications? 

Select the correct option. 

a. Design and Review 

b. References and View 

c. Insert and Mailings 

d. References and Mailings 

3. Which option hides the commands on the ribbon and displays only the names of the 
tabs? 

Select the correct option. 

a. Show Tabs and Commands 

b. Show Tabs 

c. Auto-hide Ribbon 

d. Minimize commands 
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4. Which of the following statements best describe the features of Word? 

Select all that apply. 

a. Use the Navigation pane to search by headings, pages, and results in a 
document. 

b. Use the Paragraph group on the Home and Layout tabs to manage paragraph 
settings. 

c. Use the Formulas tab to manage tables and formulas in a document. 

d. Use document formatting to manage the structure and layout of a document. 

5. The command you use to manage the display and layout of the ribbon and ribbon 
tabs is the ______________________________. 

Fill in the blank. 

Topic 1: Explore the Word interface 
In this topic, you'll learn how to identify the location and purpose of the key interface 
elements in Word, including the ribbon, title bar, Microsoft Office Backstage view, 
status bar, Tell Me feature, and document working area. You can think of the interface 
elements in Word like the dashboard of a vehicle that you're learning to drive for the 
first time. Knowing about the dashboard will make you a better driver. In Word, you’ll 
navigate all these interface elements while creating content in the working area. 

The following screenshot of the Word interface comes from the Office 365 version of 
Word. First, act like a tourist and just get familiar with each of the interface elements. 
Then go ahead and explore them yourself. Ready for the ride? 

 

Video 

Here’s a great video about how Word can help you be more creative 
and productive. To observe this video that's a quick overview of Word, 
refer to: What is Word? 

https://aka.ms/What_is_Microsoft_Word
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Figure 1: The application window of the Office 365 version of Word 

You should get familiar with the following key elements of the Word UI: 

• The working area. The Word document has space that represents the document 
page, referred to as the working area, that takes up most of the Word interface, as 
the following figure depicts. 

 
Figure 2: The working area 

• Window management. Like other applications, Word has the Minimize, Restore 
Down, and Close buttons to manage the application window. 
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• Title bar. A horizontal bar at the top of the Word window, the title bar displays the 
name of the current and active document with the title of the application, such as 
Sales Report - Word. If you haven't named the document yet, the title bar will 
indicate a temporary name that includes the word “Document” and a number, such 
as Document2. 

• The signed-in user. Office 365 might display the username and user image. 
• The Tell me what you want to do box. The box for the new Tell me feature always 

remains docked at the same location in Word 2019, in the Word Online application 
(for Office 365 users) and in other Office 2019 applications. In the Office 365 version 
of Word 2019, this box displays Search instead of Tell me what you want to do. 

• Rulers. Rulers assist in aligning objects that you add to a document and in managing 
the width of your document besides having other purposes covered later in this 
course. 

• Scroll bars. If the document has multiple pages, scroll bars (both horizontal and 
vertical) appear in the working area for ease of navigation. 

• The status bar. The status bar displays various types of information pertinent to the 
active document. Common displays include the number of the currently active page 
of the document, the word count, a spelling checker indicator, buttons for selecting 
different types of page displays, and a Zoom slider. 

• The ribbon. The ribbon organizes most of the common commands and tools that 
you'll use. Different ribbon tabs group these commands together. Each of the tabs 
organizes similar commands together and nestles those commands in a group on 
the tab. 

 

Did you know? 

The ribbons in most Office 2019 applications are similar in their 
layout and groupings of tools. If you're new to Word, take some time 
to explore and become familiar with the tabs, groups, and associated 
commands.  
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The following figure depicts the Insert tab and its Illustrations group. 

 
Figure 3: The Insert tab and its Illustrations group 

o Explore the ribbon. The first time you open the Word application, a series of 
ribbon tabs displays by default. Each of these tabs places specific commands and 
tools together as a collection, which is referred to as a group. In Figure 3, for 
example, the Insert tab (number 1) houses a group named Illustrations. This 
Illustrations group (number 2) contains a variety of commands (number 3), each 
of which represents different types of objects that you can insert into your 
document. Each group is separated from its neighboring groups by a vertical line 
on the tab. Other examples of groups on the Insert tab are Tables, Add-ins, 
Media, Comments, and Header & Footer. 

• Ribbon Display Options. The new versions of Word have a new way for you to 
manage your displays while you're working—the Ribbon Display Options button. 
You use this button to manage the ribbon displays via three options—namely, Auto-
hide Ribbon, Show Tabs, and Show Tabs and Commands. 

When reviewing a multiple-page document, you might feel the need to expand the 
reading space. You can apply a ribbon display to assist with this. After you finish 
reviewing and want to continue editing the document, you modify the ribbon display 
again to regain access to the commands on the ribbon tab. 

 

Did you know? 

Ribbon Display Options remains docked at the same location at all 
times to allow for ease and convenience as you work. 
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• The Backstage view. Otherwise known as the File tab on the ribbon, the Backstage 
view is where you manage files and data about the files. Functionality such as that 
provided by Save, Print, and Open can all be found here. You can also manage the 
metadata and options for the files from this location. 

Activity: Show me how 
In this activity, the teacher will give you a tour of the Word UI to help you locate key 
interface elements while describing their basic functionality. Follow along closely, and 
ask questions about anything you don’t understand. 

Resources required 
None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Observe the teacher demonstrate the key interface elements of Word, noting where 
the teacher navigates, for a solid understanding of each interface element. 

2. If you have prior experience with Word, or if you have experience using other Office 
programs, express yourself and help the teacher identify the various interface 
elements. You might be able to identify elements that this activity doesn't specifically 
call out. 

3. Interact and feel free to ask questions to get further clarification while the teacher is 
demonstrating. Here are a few questions to help you get started: 

o When will I need to reference the title bar? 
o How can I access the Backstage view? 
o What happens if I hover over different areas of the interface? 
o What happens if I right-click or activate the context menu for different areas of 

the interface? 

Try-it: Explore the Word interface 
 Work independently and explore the Word interface on your device. You'll need 

to locate a specific list of key elements within the time provided by the teacher. This will 
help you assess how well you understood the earlier demonstration by the teacher and 
if you need to additionally focus on any areas. 
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Resources 
You'll need the following resource for this activity: 

• L1_T1_try_locate_elements_starter.docx in this lesson’s Learning Activity 
Resources folder 

Instructions 
1. Work on this activity independently. 

2. Ensure that the Word application is already open on your device. If not, ask the 
teacher for help. 

3. Follow the instructions in L1_T1_try_locate_elements_starter.docx. 

4. Prepare to share the purpose of the elements that the sheet lists with the class. 

5. Note that the teacher will guide the class through a debriefing to discuss the 
answers. 

Topic 2: Manage the ribbon display 
options 
In this topic, you'll learn how to manage the ribbon display, the ribbon tabs, and the 
commands displayed. As you get more familiar with working with Word, you'll learn to 
work more efficiently, and you might want to modify which ribbon tabs and commands 
display. To understand the display options available to you, refer to Figures 4 and 5. 

 
Figure 4: The Ribbon Display Options button 

 
Figure 5 The expansion of Ribbon Display Options after you select it 
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Sometimes, you might choose to have a larger amount of screen space available to edit 
your document, and you might therefore want to collapse all the ribbons or just the 
commands. You manage how you observe your ribbon tabs and the commands located 
on them via Ribbon Display Options. Figure 6 depicts how the display changes when 
you select Auto-hide ribbon from the Ribbon Display Options box. 

 
Figure 6: A document displayed with the Auto-hide Ribbon option applied 

Manage the ribbon layout 
Although a few ways to manage the ribbon layout exist, the simplest way is through 
Ribbon Display Options. Select Ribbon Display Options to access three options to 
modify how the ribbon will display in your application: 

• Auto-hide Ribbon. This option hides all the ribbon tabs. To unhide the ribbon, 
select the ellipsis (…) on the title bar. To fully restore and display the ribbon and 
commands again, select the third option, Show Tabs and Commands. 

• Show Tabs. This option displays only the ribbon tabs. Select a ribbon tab to display 
the commands and once again to hide the commands. You can still access the 
commands by selecting the associated tab name. 

• Show Tabs and Commands. This option displays the all ribbon tabs and commands 
at the same time. This is the default display, where the entire ribbon is expanded, 
displaying all the tabs and their associated commands. 
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Did you know? 

A few more ways to manage the ribbon exist: 

• Double-click any ribbon tab to collapse the entire ribbon. Double-
click again to bring the ribbon back into the docked position.  

• Select Collapse the Ribbon, or select Ctrl+F1, to collapse the 
ribbon. 

 

Additional information 

Learn more from Microsoft Support. For more information, refer to: 
Show or hide the ribbon in Office 

Activity: Discuss and learn 
The teacher will demonstrate how to change the ribbon display options and lead a 
discussion about when you might want to use each of the different ribbon displays as 
you work with Word. 

Resources required 
None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Follow the teacher demonstrating where the Ribbon Display Option button is 
located and how to change the ribbon displays. 

2. Be prepared to have an interactive conversation as a class discussing why users 
might choose each of the options to modify the display of the ribbon and tabs. 

3. Try to understand when you might use the different available displays. 

  

https://aka.ms/Show_or_Hide_the_ribbon
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Try-it: Manage the ribbon display options 
 You'll work independently on a document and modify the ribbon display. This will 

give you direct experience with how each of the three ribbon display options works. You 
can then use these options when you begin working on more-complex functionality in 
Word. 

Resources 
You'll need the following resource for this try-it: 

• L1_T2_try_farm_starter.docx in this lesson’s Learning Activity Resources folder 

Instructions 
You'll perform the following general tasks during this try-it: 

1. Work independently on this learning activity resource file on your own device.  

2. One by one, select each of the three options from the Ribbon Display Options box, 
and take note of how the display differs for each option. 

Topic 3: Focus on the ribbon 
commands and groups 
In this topic, you'll learn in detail about the locations and purposes of the commands 
and groups on the ribbon. As you'll discover later, the ribbon tabs are the most 
commonly used elements for working with Word. What you learn here will help you for 
the rest of this course. 

Ribbon 
As you learned in the previous topics, the ribbon is a collective, organized group of tabs. 
When you install Word, you begin with ten ribbon tabs, including Help, by default. As 
you install other applications that integrate with Word, you might observe additional 
third-party tabs appear. 

Contextual tabs 
As you continue working in this course and learning about the different objects you can 
use in your Word documents, you'll notice additional tabs appear on the ribbon when 
you insert an object. For example, when you insert a SmartArt graphic, two contextual 
tabs appear that apply only to the SmartArt graphic you inserted, as Figure 7 depicts. 
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These contextual tabs display only when the SmartArt graphic is active and selected in 
your document. 

 
Figure 7: Contextual tabs for SmartArt graphics 

Groups of commands 
A group, when referring to the ribbon and commands you use in a document, provides 
an organized structure that places similarly focused commands together. The ribbon 
separates the groups of commands by light vertical lines and the name of each group. 
You can identify a group on a ribbon tab by the group name and the vertical lines that 
separate the commands for each group. Figure 8 depicts a great example of a frequently 
used group named Font. 

 
Figure 8: The Font group on the Home tab 
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The commands represent the tools you can apply while working in your document. 
These are a key ingredient to success when creating attractive and unique documents. 
The commands are the individual buttons located in the ribbon groups, such as Bold 
and Text Highlight Color. Figure 8 depicts the commands to format fonts, such as Bold 
and Font Color, within the Font Group. 

Activity: Discuss and learn 
The teacher will demonstrate the types of groups and commands housed within various 
ribbon tabs. Throughout this demonstration, the teacher will ask questions to check how 
well you understand the purpose of each ribbon tab and its associated groups and 
commands. 

Resources required 
None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Observe the teacher demonstrate the different ribbon tabs and the types of groups 
and commands found within each tab. 

2. Interact, engage, ask questions, and answer questions with the teacher. Some 
questions you can ask are: 

o What types of groups have similar names and functionality? 
o Which commands and groups are unique? 
o What are ScreenTips? 
o Which commands will help me perform specific actions in Word? 

Try-it: Focus on the ribbon commands and groups 
 It's time for a sticky note explosion! Work in teams of three through five or 

individually to share the location of a command in Word on your device. Write your 
answers on sticky notes. Speed and accuracy will win your team points. 

Resources 
None 
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Instructions 
You'll perform the following general tasks during this try-it: 

1. Pay attention to the instructions from your teacher.

2. Remember that you might be working in teams of three through five to locate
commands in the Word interface. Decide which student’s device you'll use for this.

3. Make sure you have at least 10 sticky notes with you, because you'll need to share
answers on these notes.

4. The teacher will ask all teams to locate a command and to then share on the sticky
note the tab and group that this command belongs to. You'll be given a maximum of
one minute to answer each question.

5. Work with your team as quickly and quietly as possible. Inform your teacher as soon
as your team has the answer on the sticky note. If you get it right and are the fastest
team, you'll win a point.

6. The team with the most points wins.

Wrap-up 
Use these questions to check what you learned in this lesson: 

1. What's the quickest way to collapse the ribbon commands and tabs?

Select the correct option.

a. Semi-hide Tabs

b. Show Tabs

c. Hide Commands

d. Auto-hide Ribbon

2. The title bar displays which of the following?

Select the correct option.

a. The name of the current, active file

b. The name of the active location in the document

c. Commands to manage work in documents

d. A quick way to find where commands are located in the application
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3. The ribbon tab that displays groups of commands to manage tracked changes and 
proofing tools is the ______________________. 

4. To manage the fonts, effects, and colors for your document, you use which tab? 

Select the correct option. 

a. Insert 

b. View 

c. Layout 

d. Design 
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Lesson 2: Customizing toolbars 
Overview 
In this lesson, you'll learn how to modify the commands on the Quick Access Toolbar, 
modify the commands displayed on the status bar, and find commands by using the 
Tell Me feature. 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. How can you add a command from a ribbon tab to the Quick Access Toolbar? 

Select the correct option. 

a. Use the Tell Me feature 

b. Update the title bar 

c. Right-click or access the context menu for the command and then select Modify 
Quick Access Toolbar 

d. Right-click or access the context menu for the command and then select Add to 
Quick Access Toolbar 

2.  Which of the following status bar items can you modify? 

Select all that apply. 

a. Word count 

b. Accessibility checker 

c. Page number 

d. Language 

3. The Tell Me feature is used for: 

Select all that apply. 

a. Finding things quickly in Word 

b. Entering words or phrases to find where commands are located 

c. Completing your sentences for you 

d. Checking the spelling and grammar of your work 
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4. The ______________________ box will dynamically update your options as you begin to 
enter content. 

Fill in the blank space. 

Topic 1: Modify the Quick Access 
Toolbar 
Discover the default state of the Quick Access 
Toolbar 
By default, the Quick Access Toolbar displays frequently used commands (refer to 
Figure 9). The default commands include: 

• Save (depicted by a floppy disc icon) 
• Undo Typing 
• Repeat Typing  
• Customize Quick Access Toolbar (refer to Figure 10) 
A few other commands also appear by default when you first use Word but might not 
be available (that is, you can't select them). However, after you open a document in the 
application, these commands might become available (that is, you can select them). You 
select a command shortcut on the Quick Access Toolbar just as you do on the ribbon. 

 
Figure 9: The Quick Access Toolbar 
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Figure 10: The Customize the Quick Access Toolbar box 

Modify the Quick Access Toolbar 
In this topic, you'll learn how to modify the Quick Access Toolbar. When you select the 
Customize Quick Access Toolbar command, a box appears that provides more options 
for managing the Quick Access Toolbar and promotes the most commonly used 
commands. 

In the Customize Quick Access Toolbar box, you simply select the command you want 
in your interface. The command will then be available on the Quick Access Toolbar. To 
verify that the command is available, hover over the command, and then select the 
command to use it in your document. 
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Video 

Learn more from Microsoft Support. To observe a video, refer to: 
Customize the Quick Access Toolbar 

 

 

Did you know? 

You can customize the Quick Access Toolbar for easy access to the 
commands you use most often. You can find further customizations 
in the Word Options dialog box. This content is partially covered in 
the next topic and in more detail in the Microsoft Word Expert 2019 
course. 

Customize the Quick Access Toolbar from the 
ribbon tabs 
You can do simple Quick Access Toolbar customizations directly from the ribbon tabs. 
You can add both individual commands and entire groups of commands that exist on 
tabs to the Quick Access Toolbar. 

Note: After you right-click or access the context menu of a command and then add the 
command to the Quick Access Toolbar, other options are available to collapse the 
ribbon, customize the ribbon, move the location of the command on the Quick Access 
Toolbar, and remove the command from the Quick Access Toolbar. 

Here are the steps to add an individual command or a group to the Quick Access 
Toolbar: 

1. Right-click or access the context menu of a command. 

2. Select Add to Quick Access Toolbar. The command appears on the Quick Access 
Toolbar. 

3. To add a group, right-click or access the context menu of the name of the group, 
and then select Add to Quick Access Toolbar. The entire group appears on the 
Quick Access Toolbar. 

4. On the Quick Access Toolbar, select the group's icon to display the various 
commands. 

https://aka.ms/Customize-the-Quick-Access-Toolbar
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Additional information 

For more information, refer to: Customize the ribbon in Office 

Activity: Think-pair-share 
The teacher will first pair you with a classmate and then demonstrate how to add 
specific commands to the Quick Access Toolbar both via the Customize Quick Access 
Toolbar command and directly from the ribbon tabs. Each pair will then explore the 
Quick Access Toolbar, add commands to that toolbar, and share their learning with the 
rest of the class. 

Resources required 
None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Note that each pair needs to be seated in front of a device and to observe the 
teacher’s demonstration of the location of the Quick Access Toolbar and the ways 
to add specific commands to it. 

2. Hover over each of the commands on the Quick Access Toolbar, taking notice of 
the command information. 

3. Work together to explore the Quick Access Toolbar and try to replicate the steps 
that the teacher demonstrated to add commands. 

4. Select the Customize Quick Access Toolbar command, and then add commands to 
the toolbar as the teacher directs. 

5. Share your learning with the rest of the class when the teacher prompts you to  
do so. 

Try-it: Modify the Quick Access Toolbar 
 This leveled try-it activity gives you an opportunity to practice what you learned in 

the activity by customizing the Quick Access Toolbar. If you complete the try-it activity 
quickly, feel free to use the remaining time to experiment and add more commands or 
groups to the Quick Access Toolbar. 

https://aka.ms/customize-the-ribbon-in-office
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Try-it 1 
In this try-it, you'll add specific commands to the Quick Access Toolbar. 

Resources 
None 

Instructions 
You'll perform the following general tasks during this try-it: 

1. Add each of the following commands to the Quick Access Toolbar: New, Open, and 
Save. 

2. Remove the Open command from Quick Access Toolbar. 

3. Add the Open command again by using Customize Quick Access Toolbar. 

4. Identify where the Open command is placed in the Quick Access Toolbar. 

Try-it 2 
You'll add specific commands to the Quick Access Toolbar from the commands and 
groups on the ribbon tabs. 

Resources 
None 

Instructions 
You'll perform the following general tasks during this try-it: 

1. Add the Clear All Formatting command to the Quick Access Toolbar without using 
Customize Quick Access Toolbar. 

2. Take note of where this command is now located on your Quick Access Toolbar. 

3. Add the Illustrations group to the Quick Access Toolbar from the Insert tab. 

4. Move the Quick Access Toolbar so it follows the ribbon. 

5. Select the Illustrations group now appearing on the Quick Access Toolbar. Move it 
to the top of the list of groups on the toolbar. 
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Topic 2: Modify the status bar 
The status bar is one of the useful but often underused interface elements of any Office 
application. Think about the word status itself from a project perspective. Your project 
manager will often ask you about the status of your project—that is, about the most up-
to-date information. This is true for the status bar in Word, as well, but the updates of 
what it displays might vary based on what you've turned on or off for display. 

The status bar sits at the base of the interface with a few items available by default (refer 
to Figure 11). In Word, the status bar is also helpful when you try to quickly navigate 
among pages or to reference the currently active page. Other common items on the 
status bar include Word Count, Character Count, Spelling and Grammar Check, Caps 
Lock, and Track Changes.  

 
Figure 11: The status bar 

The status bar is also dynamic, constantly updating information based on the 
commands and tools that you turn on. For example, as you begin adding text in a 
document, Word identifies any misspelled words, and the Spelling and Grammar 
Check icon no longer displays a check mark with a book icon but displays an X icon 
instead. This icon dynamically changes as you work in your document. When you hover 
over the icon on the status bar, Word notifies you that proofing changes to be made 
exist. 

To manage or check on a specific command on the status bar, simply select the 
command. Either a dialog box appears or Word automatically navigates to the specific 
area you can use to manage the command. 

Common commands on the status bar 
When you open Word for the first time or the hundredth time, you can always observe 
the status bar available at the bottom of the application window. However, you can 
modify the commands that the status bar displays for you. To turn a command on or off 
for display on the status bar, simply right-click or access the context menu of the status 
bar, and then select the command you want to manage. If the command displays a 
check mark on its left side, it's turned on and will display (if the content in your 
document relates to that command). To turn a command off, remove the check mark by 
selecting the command. 
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One of the most frequently used commands that you'll use on the status bar is Spelling 
and Grammar Check, as previously described. Simply select this command at any time 
to kick off Spelling and Grammar Check. You can also observe as you enter text, and 
you'll notice if Word detects either a spelling or a grammar error. Another helpful tool is 
the Caps Lock indicator. If you accidentally select the Caps lock key on your keyboard, 
and you've turned on the Caps Lock command on your status bar, the Caps Lock term 
will appear on your status bar as you enter text. This will save you time when you enter a 
lot of text into your document. 

Both Word Count and Character Count let you know how much text you've entered in 
your entire document. This can be helpful when you're working on papers that have a 
word or character requirement, such as when you need to write essays and are allowed 
only a specific number of words or characters. 

With the Page Number command, you can turn the Navigation pane on or off. When 
the Navigation pane is turned on, you can quickly move to different pages in your 
document. 

Zoom and display options 
Another common area that you'll use contains the zoom and display options (refer to 
Figure 12). You can modify the zoom level by dragging the Zoom slider, by selecting the 
Zoom Out and Zoom In buttons, or by selecting the Zoom command (which initially 
displays 100%). With the Zoom command, you can expand and magnify the display of 
the currently active page in the document to a specified percentage. This opens the 
Zoom dialog box, where you can enter a specific zoom percentage. Zooming your page 
to 200 percent might help you with finer editing tasks, such as aligning any objects you 
insert into your document. 

 
Figure 12: The right side of the status bar 

With the three commands on the left side of the Zoom slider, you can modify how your 
document displays. Your options are Read Mode, Print Layout, and Web Layout. 
Because these commands are turned on by default, you can select and change your 
display at any time. 

To modify which commands appear on the status bar, right-click or access the context 
menu of the status bar, and then select the command you want. 
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Figure 13: The Customize Status Bar box 

In the Customize Status Bar box, simply select the command you want to turn on or 
off. When the check mark appears on the left side of the command, that command is 
turned on. If no check mark exists, the command is turned off. 

Activity: Guess and tell 
The teacher will demonstrate the location of the status bar and share a scenario with the 
class. You need to guess and tell which commands are needed to solve specific 
problems related to the scenario. The teacher will share how the status bar has some of 
these commands and ask related questions. 

Resources required 
None 
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Activity instructions 
Participate in the activity by following these instructions: 

1. Understand the scenario that the teacher shares, and then observe the teacher 
demonstrate the location of the status bar. 

2. Explore on your own device, and as the teacher hovers over a command on the 
status bar, try to guess and share what you think the purpose of the command is. 

3. Try to answer the question related to the scenario: Does the document that the 
teacher shared meet Munson’s requirements? 

Try-it: Modify the status bar 
 Pair up with a classmate, and customize the status bar. Perform specific actions to 

understand how these customizations will help you when working with Word. 

Resources 
None 

Instructions 
You'll perform the following general tasks during this try-it: 

1. Pair up with a classmate, and then open a new blank Word document on one of your 
devices. 

2. Customize the status bar by turning on the following commands: 

o Page Number 
o Word Count 
o Spelling and Grammar Check 
o Zoom 
o Zoom Slider 
o Caps Locks 
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3. Note the following observations: 

o What does the page number display?  
o What happens when you select the page number? 
o What happens if you switch the Page Number command from on to off or vice 

versa on the status bar? 
o Turn on Caps Lock on the status bar. Enter text into your document, and observe 

the status bar to check whether the Caps Lock term appears. 
o Explore other commands on the status bar, and discuss what you find and how 

these commands might assist you as you work in your documents. 

Topic 3: Find commands by using the 
Tell Me feature 
If you're new to any of the Office 2019 applications, you'll find the Tell Me feature to be 
very helpful as you're learning your way navigating around Word. The Tell me what you 
want to do box (which is the interface element for the Tell Me feature) is housed at the 
top of the application window and consistently displays in this location across all the 
Office applications. 

 

Video 

To observe a video, refer to: Do things quickly with Tell Me 

  

 

Did you know? 

A quick way to turn on the Tell Me feature is to select the Alt+Q 
keyboard shortcut. This activates the Tell Me feature, and you can 
then begin entering what you want to search for. 

https://aka.ms/video-do-things-quickly-with-tell-me
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The main purpose of the Tell Me feature is to quickly find commands and other items in 
the application. This search feature is intended to work dynamically for the various 
commands you are searching for in Word. For the location of the Tell Me feature, refer 
to Figure 14. 

 
Figure 14: The Tell Me feature in Word 

To use the feature, enter a word or phrase in the Tell me what you want to do box. A 
list of options will appear that prompts you with options based on the text you entered. 
The list will dynamically change as you modify the content you enter directly into the 
box. For an example of how this works, refer to Figure 15. 

 
Figure 15: The Tell Me feature with insert picture entered in the box 
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Did you know? 

The Office 365 version of Word has replaced the Tell Me feature with 
the Microsoft Search feature. The Alt+Q keyboard shortcut also 
activates Search. You enter text in the Search box just as you do in 
the Tell me what you want to do box. 

Activity: Pose a challenge 
The teacher will ask the class to find specific commands by using the Tell Me feature. 

Resources required 
None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Observe the teacher guiding you to the location of the Tell Me feature. 

2. Open a new blank document in Word. 

3. Note that the teacher now poses a series of challenges to the class. You need to 
solve each challenge by using the Tell Me feature. 

4. As you find the solution to each challenge, share your results with the class. 

Hint: More than one way exists to find elements in the application. 

Try-it: Find commands by using the Tell Me feature 
 Explore the search capabilities of the Tell Me feature, and take note of how it can 

help you when you work with Word. 

Resources 
None 
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Instructions 
You'll perform the following general tasks during this try-it: 

1. Open a new blank Word document on your own device. 

2. Enter the following words and phrases in the Tell me what you want to do box, and 
note down your observations as directed. 

3. Enter Insert. Note the options that appear. Delete the word Insert, and then enter 
Add. What do you notice that is similar? 

4. Examine how the Tell Me feature reacts when you give more details to the search 
term. Enter add picture for prompts to add different types of pictures. Select Online 
Pictures, and then add a picture of your choice. 

5. Enter ruler, and then select Show Ruler. What do you observe? Enter ruler again, 
and then select Show Ruler. The ruler now disappears from your application. 

6. Use the Tell Me a bit differently. Enter agriculture to get the definition of 
agriculture and the pronunciation of the word. You'll also notice a Get help option. 

7. Select the definition of agriculture to open a Search dialog box with information 
regarding agriculture. 

Wrap-up 
Use these questions to check what you learned in this lesson:  

1. The Quick Access Toolbar does which of the following? 

Select all that apply. 

a. Has Save, Undo, and Redo as default commands 

b. Can be moved anywhere in the UI 

c. Allows you to add or remove commands from the ribbon 

d. Can't be modified in any way 

2. The ______________________ will help you find commands in your application or terms 
to assist you in your document. 

Fill in the blank space. 
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3. Which of the following is not a command on the Word status bar?  

Select the correct option. 

a. Language 

b. Sum 

c. Page Number 

d. Zoom Slider 

  



Managing documents and options  

 
38 

 

 

Lesson 3: Creating, opening, 
and saving documents 
Overview 
In this lesson, you'll learn how to create a new document from scratch or from a prebuilt 
template. You'll also learn how to open an existing document and how to save your files 
as different file formats. 

Warm-up 
Get ready to jog your memory of concepts learned in the previous lesson. Follow the 
instructions that the teacher gives and pay attention to the questions. 

Topic 1: Create a new document 
One of the most fundamental things that you'll do in Word is create a document. In this 
topic, you'll learn which types of documents you can choose from to get started. 
Deciding if you want to begin from a blank document or select a pre-built template 
created by Microsoft or another contributor will depend on the task you have. 

What's a template?  
A template is a document that contains preformatted content, styles, and structure. 
Word provides a wide assortment of prebuilt templates, including a Blank document 
template. 

Create a new document from a blank template 
When you're ready to create a new blank document, you begin directly from the Blank 
document template. Whether you select the New command on the Quick Access 
Toolbar or select Ctrl+N, all of these options use the Blank document template. To 
understand where you can access prebuilt templates from, refer to Figures 16, 17, 
and 18. 
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Figure 16: The New tab for creating a document 

 
Figure 17: The Blank document template  
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Create a new document from a prebuilt template 
On the New tab in the Backstage view, you can select a prebuilt template that the tab 
promotes with thumbnails, as the following figure depicts.

 
Figure 18: Prebuilt templates 

Search by category 
You can also select from categories listed following the Search box (refer to Figure 19). 

 
Figure 19: Searching for templates by using a category 
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Search by a word or phrase 
You can also enter a word or phrase to find an online template that meets your needs 
(refer to Figure 20). 

 
Figure 20: Searching for templates by using a word or phrase 

Add or edit content 
All it takes it to add content is to enter text into the document. Paragraphs in Word are 
identified by the use of the Enter key, otherwise known as the hard return. If you started 
with a prebuilt template, you can select text and modify the text you want in the 
document. You'll learn more about entering, selecting, and formatting text in this 
module.  

 

Additional information 

For more information, refer to: Download free, pre-built templates 

  

https://aka.ms/Create_pre-built_templates
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Activity: Discuss and learn 
In this activity, the teacher will demonstrate the process of creating a new document 
both from scratch and from an existing template and will then lead a discussion. 

Resources required 
None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Observe the different ways the teacher creates a new Word document during the 
demonstration. 

2. Pay special attention to the Backstage view. 

3. Interact with the teacher, and ask questions to clarify any step, because you'll need 
to apply this learning every time you want to create a new document in Word. 

Try-it: Create a new document 
 In this try-it, you'll first research new ways to create documents on your own. 

Next, you'll pair up with a classmate to exchange ideas and thoughts based on your 
research. 

Resources 
You'll need the following resource for this try-it: 

• The Welcome to Office Help & Training website 

Instructions 
You'll perform the following general tasks during this try-it: 

1. In the time given by the teacher, find as many options as you can for how to create 
new documents. Use the online resource and any elements within Word that you 
learned about. 

2. Identify the different types or categories of documents you can create. 

3. Keep track of all the solutions you identify. List as many different types of documents 
as you can. 

4. When directed by the teacher, pair up with a classmate, and exchange ideas and 
solutions based on each of your research results. 

https://aka.ms/Office_Help_and_Training
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Topic 2: Open and save a document 
 When you open Word 2019 for the first time, you have a few options for beginning 

your work. The Start screen directly presents you with these options. If you're not 
creating a new document, you might want to open an existing document. You'll also 
learn how to save a document locally on a device's hard drive. Saving a document is 
simple, but the difference between Save and Save As is an important distinction to 
understand. You'll also explore how to use the Save As command to save your 
documents as other file types. 

When you first open Word, you'll be presented with two options: 

• To open a recent document—that is, a document you’ve already been working on 
• To access pinned documents—that is, specific documents you chose for the 

application to hold in the Pinned area so that you can easily access them at any time 

 
Figure 21: The Home tab for accessing files from the Pinned or Recent areas 
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Figure 22: The Home tab in Word from the Start screen 

Open recent documents 
The Open tab displays the latest Word documents you opened and information 
regarding the last modified date and time.  

 
Figure 23: The Open tab from the Start screen in Word 
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When you select Open on the File tab, common file areas are listed in a pane. These 
include Recent, This PC, Add a Place, and Browse. If you have Office 365 (in various 
subscription models), you'll likely observe the cloud locations (in Microsoft OneDrive 
and Microsoft SharePoint) included also. Recent is the default selection, and the recent 
files and folders you've worked with display in a pane next to this list, as the following 
figure depicts. 

 
Figure 24: The Open tab with the Documents, Folders, and Pinned areas 

Locate documents and folders 
One of the most helpful improvements to the latest versions of Word is the promotion 
of searching among documents, grouped by dates, along with a Folders tab. As soon as 
you've worked in a folder, including opening a file from a folder, Word stores that folder 
location in the lesson folder. This reduces the amount of time it will take for you to find 
previously opened documents. The Open tab also contains a Search box, and you can 
locate the context of the content you’re trying to search for. Finally, the Open tab also 
contains the Pinned area, allowing you to easily open documents that you've deemed 
pin-worthy. 

Open multiple documents 
As you become more familiar with using Word, you’ll find yourself working with more 
than one document at a time. Here are a few suggestions for ways to work among all 
these documents. 

The Windows taskbar indicates that Word is running whenever a Word document is 
open. When you hover over the Word icon on the taskbar, you can preview or select 
any of the open Word documents. To switch to a different active document without 
closing the current document, simply select it from the preview. 

You'll always know which Word document is active by referencing the title bar in Word. 
It displays the name of the currently active document. 
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Video 

To observe a video about how to create a document in Word, refer to: 
Create a document in Word 

Save your documents 
After you create or modify a document, you need to save it. If you save it to a local 
device, you'll need to save it manually and frequently. Ask any experienced Office user if 
they ever created a large, multiple-page document and then had something unexpected 
happen, causing a large majority of their content to be lost. The answer is likely going to 
be a resounding yes! 

Working for extended periods of time is challenging enough. Spending the time, energy, 
and creativity in preparing your documents can produce an exciting feeling. To realize 
that all of that content, hard work, and inspired creativity has been lost because of a 
power failure, for example, can be devastating. 

 

Did you know? 

New versions of Word that integrate directly with cloud storage 
options, such as those in Office 365, have advantages. If you create or 
move a document to Office 365 cloud storage, such as OneDrive for 
Business, SharePoint Online, or Microsoft Teams, the document will 
automatically be saved as you make edits to it. 

 

Understand how the Save command works 
When you select Save, it really conducts a backup or update to the work you've done. 
For documents stored in cloud locations, Save also updates any new content changes 
that you've made since the last save (or sync) and keeps track of historical changes for 
document versions. 

Save is located on the File tab (in the Backstage view). When you select Save for the 
first time, a pane appears that prompts for a file location, file name, and file type. 
Selecting the More options button (following the file type box) opens the Save As 
dialog box. 

https://aka.ms/Create_a_document


Managing documents and options  

 
47 

 

 

 
Figure 25: The Save pane with the Save and More options buttons 

After you initially save the document, selecting this command again saves the document 
to the same file location with the same file name and file type. 

Save As 
When you save a document for the first time, even if you select the Save command, that 
will activate the Save As dialog box, allowing you to name the file and select the 
location where the file will be saved, as the following figure depicts. 

 
Figure 26: The Save As dialog box 

If you need to modify the file name, you can use the Save As command again. The Save 
As command will navigate to the Save As location from the Backstage view and 
prompt you to modify the file name. You can also select Browse to access the 
traditional Save As dialog box, where you'll also have an opportunity to change the file 
location and other metadata—for example, by adding tags or keywords to the file. 
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Figure 27: The Save As locations with the Browse button 

Understand file types 
When you create and save your document, especially for the first time, it's important to 
select the appropriate file type. By default, the Word sets the document file type to 
.docx. 

However, if you inherit documents from coworkers, you might notice that the file type 
isn't set to .docx. Typically, older Word documents have the .doc file extension. This file 
type is for Word documents created and saved by previous versions of Word (Word 97-
2003). 

You can also convert a Word document to another type of file, such as a Portable 
Document Format (PDF) or text file. To save a document as a PDF file, you can use either 
the Export or the Save As command. 

 

Additional information 

• For more information about opening Word files, refer to: Open files 
from the File menu 

• For more information about file formats in Word, refer to: 
Converting documents to a newer format 

• For more information about how to save a Word file according to 
your requirements, refer to: Use Save As on the File menu 

• For more information about opening a PDF file, refer to: Opening 
PDFs in Word 

  

https://aka.ms/OpenFiles
https://aka.ms/OpenFiles
https://aka.ms/Converting_documents_to_a_new_format
https://aka.ms/Use_Save_As_on_the_File_Menu
https://aka.ms/Opening_PDFs_with_Reflow
https://aka.ms/Opening_PDFs_with_Reflow
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Video 

To observe a video about converting or saving to PDF, refer to: 
Convert or save to PDF 

To observe a video about saving a document, refer to: Save a 
document 

Activity: Student show me how 
The teacher will demonstrate how to save a file in different ways and ask the class to 
offer solutions along the way. Volunteer if you think you can demonstrate the solution. 

Resources required 
You'll need the following resource for this activity: 

• L3_T2_act_whitepaper_with_cover_image.docx in this lesson’s Learning Activity 
Resources folder 

Activity instructions 
Participate in the activity by following these instructions: 

1. Observe the teacher demonstrating how to save the file. 

2. Pay attention to the challenge the teacher announces and ask clarifying questions if 
needed. 

3. Volunteer if you feel up to this challenge and think you know the solution. 

4. Note down how the file changes as the Word document is saved as a different file 
format. 

Try-it: Open and save a document 
 In this try-it, you'll work on an existing document and end with the document 

saved as a plain text file (.txt file). 

Resources 
You'll need the following resource for this try-it: 

• L3_T2_try_farm_starter.docx in this lesson’s Learning Activity Resources folder 

  

https://aka.ms/convert_or_save_to_PDF_video
https://aka.ms/Save_a_document
https://aka.ms/Save_a_document
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Instructions 
You'll perform the following general tasks during this try-it: 

1. Open L3_T2_try_farm_starter.docx. 

2. Save the file as a text file. 

3. Note down any changes to the document. 

 

 

Did you know? 

With the introduction of the new Office interface, such as the ribbon 
tabs and the Quick Access Toolbar, Microsoft made other 
enhancements to the Office applications, as well, such as an increase 
in the capabilities of the upgraded file types and a reduction in the 
storage size of each file as a whole. 

 

Wrap-up 
Use these questions to check what you learned in this lesson: 

1. To upgrade a document with a .doc extension and have only one version of the file, 
you select which of the following? 

Select the correct option. 

a. File > Save As 

b. File > Export 

c. File > Publish 

d. File > Convert 

2. Which keyboard shortcut can you use to save a document? 

Select the correct option. 

a. Windows logo key+S 

b. Ctrl+O 

c. Ctrl+S 

d. Windows logo key+O 
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3. Which methods can you use to open a document? 

Select all that apply. 

a. Selecting Windows logo key+S 

b. Selecting Ctrl+O 

c. Selecting Ctrl+S 

d. Selecting File > Open 

4. When you select the File, tab and then select Open, the default list of documents 
displayed is labeled ______________________. 

Fill in the blank space. 

5. A Word 2019 file is saved by default as which type? 

Select the correct option. 

a. .doc 

b. .dox 

c. .docs 

d. .docx 

6. To create a new Word document, you start with which of the following options? 

Select all that apply. 

a. Opening Word 

b. With Word open, selecting New and then selecting Blank document 

c. With Word open, selecting a template from the available thumbnails 

d. With Word open, selecting Insert and then selecting New 

7. When you save a Word document, the other file type options include which of the 
following? 

Select all that apply. 

a. .doc (Word 97-2003 document) 

b. .pdf 

c. .rtf (Rich Text Format) 

d. .dot 
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8. To open a document, you can do which of the following? 

Select all that apply. 

a. With Word open, select File > Open, and then navigate to your file. 

b. On the Quick Access Toolbar, select the Open command, and then navigate to 
your file. 

c. With Word open, on the Windows taskbar, right-click or access the context menu 
of Word, and then select your recent document from the list. 

d. In the Options dialog box, select Open document. 
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Lesson 4: Formatting text 
Overview 
In this lesson, you'll learn how to both add content to your document and format that 
content, including how to select text, apply font formatting and styles, and clear 
formatting from your content. 

The purposes of formatting your text and your content overall is to make your 
document more readable, to improve communication, and to make it more aesthetically 
pleasing on the whole for the reader. Imagine that you're a teacher reading 30 different 
reports by high school or college students. Do you think you'll have a better 
understanding of the content and its main points if the font types, colors, and sizes are 
easy to peruse and if the content is laid out in sections that use headings to help clarify 
how the content is grouped? 

To help your documents meet these criteria, you need to understand and know how to 
implement good text formatting and layout. In this lesson, you'll learn how to dazzle 
your readers with text effects, as well. 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. To select a word in a document, you can do which of the following? 

Select all that apply. 

a. Select each character of the word 

b. Double-click the word 

c. On the keyboard, press Shift+Left arrow key or Shift+Right arrow key to select 
the word 

2. To change the font size of a character, you can do which of the following? 

Select all that apply. 

a. Select the Font Size command 

b. Select the Font Size command from the Mini Toolbar 

c. Press the Ctrl+Shift+P keyboard shortcut 
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3. This is where you find the prebuilt headings to apply to your content. 

Select the correct option. 

a. The Styles group on the Insert tab 

b. The Styles group on the Home tab 

c. The Styles group on the Layout tab 

d. The Styles group on the Design tab 

4. The ______________________ command removes font styles, highlighting, borders, bold 
formatting, and other formatting from selected content. 

Fill in the blank space. 

5. Which of the following is not an option when you apply text effects? 

Select the correct option. 

a. Outline 

b. Shadow 

c. Border 

d. Glow 

Topic 1: Select and apply font 
formatting 

Have you ever found a document difficult to read? Did you read similar content 
elsewhere but found that fun to read? What was the difference? 

Here are some possibilities: The difficult-to-read document content probably consisted 
of one big paragraph, or the font size was too small, and no colors or font styles were 
applied. In contrast, the fun-to-read document most likely had a good flow and 
attractive design elements. In this topic, you'll learn some ways to make document 
content more interesting. 
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Add content 
All it takes it to add content is to enter text into the document. You can enter, select, 
and format text one character at a time. Paragraphs in Word are identified by the use of 
the Enter key, otherwise known as the hard return. 

Efficiently select text 
Working with the text in a document requires you to select the text to be more efficient 
while editing it. The following table describe a few keys and keyboard shortcuts you can 
use when selecting text. Remember, the scroll bars assist in navigating the document, as 
well. 

Key or keyboard shortcut Takes this action 

Ctrl+Left arrow key or Ctrl+Right 
arrow key 

Moves one word to the left or the right 

Ctrl+Up arrow key or Ctrl+Down 
arrow key 

Moves one paragraph up or down 

Up arrow key or Down arrow key Moves one line up or down 

Left arrow key or Right arrow key Moves one character to the left or the right 

Page up or Page down Moves one screen up or down 

Ctrl+Page up or Ctrl+Page down Moves to the beginning of the previous or 
the next page 

Home or End Moves to the beginning or end of the 
current line 

Ctrl+Home or Ctrl+End Moves to the beginning or end of the 
document 

Ctrl+A Selects all content 

Table 2: Keys and keyboard shortcuts for selecting text 

Continuing with efficiency, the following table describes a few "mouse shortcuts" you 
can use when selecting text. Keep in mind that Word allows you to select text at the 
level of the character or the character space, such as entering a single space on your 
keyboard. 
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Mouse shortcut Selects this text 

Click a character A single character 

Double-click a word A word 

Click the selection bar on the left 
side of a line 

A line of text 

Click the selection bar and then drag 
over text in lines 

Contiguous lines of text 

Select a first area of content, select 
Ctrl, and then select a second area of 
content 

Noncontiguous lines of text 

Triple-click text A paragraph 

Select the Ctrl key, and then select 
text in a sentence 

A sentence 

Triple-click the selection bar All content 

Table 3: Mouse shortcuts for selecting text 

Format content 
One way to quickly format text you've selected is to use the Mini Toolbar. When you 
select text with the mouse, as you begin to move your mouse up and slightly to the 
right, the Mini Toolbar will appear (refer to Figure 28). With the text already selected, 
you simply select the formatting you want to apply. This saves you time compared to 
accessing the ribbon to apply formatting that you regularly use. 

 
Figure 28: The Mini Toolbar 
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Format text 
You can find simple formatting on the Home tab, in the Font group (refer to Figure 29). 

 
Figure 29: The Font group 

Although the Font group has several commands for formatting your content, the ones 
that this topic focuses on are: 

• Font and Font Size. These are two of the most commonly used formatting features 
across most Office applications. 

 

Did you know? 

The word font comes from the 1680s and refers to a complete set of 
characters of a particular typeface and size of type. European type 
foundries used typefaces for printing on wood and metal. 

The term font come from the Old French word fondre, which means 
melt. 

• Word and other applications that use fonts refer to a family of fonts as a typeface. A 
typeface contains multiple fonts that share common design features but have 
different weights, styles, widths, slants, italicization, and other subtle differences. For 
different kinds of typefaces, refer to Figure 30. The fonts in a font family subtly differ 
from each other but follow a shared design. 
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Figure 30: The Franklin Gothic typeface 

• Change Case. With the Change Case command, you can modify text to have a 
different case, such as uppercase or sentence case. 

 
Figure 31: The Change Case command in the Font group 

• Bold, Italic, and Underline. This rich text formatting is very useful for making your 
content stand out. 
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• Font Color and Text Highlight Color. These commands, which the following figure 
depicts, help you to add color to your text. 

 
Figure 32: The Bold, Italic, Underline, Font Color, and Text Highlight Color 
commands 

Apply built-in styles 
One of the quickest ways to apply specified formatting to your content is to use the 
prebuilt styles. Depending on the document you're working on, you might notice that 
styles vary from document to document and from template to template. On the Home 
tab, select the Styles gallery to observe the styles in a document, as the following figure 
depicts. 
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Figure 33: The Styles gallery 

Select your content, and then hover the different styles available in the Styles gallery. 
The preview in Word indicates how each new style would apply to the content. You can 
then select the style of your choice. Styles provides a quick way to add some pizzazz to 
your document and to ensure that you're using the fonts, sizes, colors, and other 
formatting that you intend. 

Some of the styles you apply will not only provide aesthetics to your document but will 
also begin to apply structure to the document by the use of headings. These headings 
will help you navigate via the Navigation pane, which you'll learn about later in this 
module. 

Activity: Discuss and learn 
The teacher will share a scenario that requires making a document more interesting 
according to certain requirements. Be prepared to discuss with the teacher how this 
document might be improved, and then learn how you can make these changes in 
Word. 
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Resources required 
None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Understand the scenario, and take note of the problems in the document that the 
teacher shares. 

2. Share your thoughts with the class about how the document might be improved. 

3. Observe the teacher demonstrate to learn how to make these improvements by 
using Word. 

Try-it: Select and apply font formatting 
 In this levelled try-it, you'll use the most common formatting features in Word that 

exist on the Home tab or the Mini Toolbar. 

Try-it 1 
In this try-it, you'll change the font style, font color, and font size for specific text within 
a document. 

Resources 
You'll need the following resource for this try-it: 

• L4_T1_try1_concord_grapes_simple_starter.docx in this lesson’s Learning Activity 
Resources folder 

Instructions 
You'll perform the following general tasks during this try-it: 

1. Apply the Segoe font with a font size of 12 to all the content in the document. 

2. Format the Concord Grapes title text with a font size of 20, a font color of Blue, 
Accent 1, and a font style of Bold. 

3. Format the following text with a font size of 16: 

o A cultivar of the genus Vitis labrusca 
o Growing grapes in your yard 

4. Save your file as My_concord_grapes_simple_formatting.docx. 



Managing documents and options  

 
62 

 

 

Try-it 2 
In this try-it, you'll change the font style, font color, and font size for specific text in a 
document. You'll also apply prebuilt styles. 

Resources 
You'll need the following resource for this try-it: 

• L4_T1_try2_concord_grapes_simple_starter.docx in this lesson’s Learning Activity 
Resources folder 

Instructions 
You'll perform the following general tasks during this try-it: 

1. Apply the Segoe font with a font size of 12 to all the content in the document. 

2. Format the Concord Grapes title text with the prebuilt Title style. With this title text 
selected, apply a font color of Blue-gray, Text 2. 

3. Apply Heading 1 to each selection of the following text: 

o A cultivar of the genus Vitis labrusca 
o Growing Grapes in your yard 

4. After the word Considerations in the document, select Enter to begin a new 
paragraph. 

5. Select the word Considerations in the document, and then apply the Heading 2 
style. 

6. Save your file as My_concord_grapes_simple_formatting.docx. 

Topic 2: Copy and clear formatting and 
apply text effects 

 In the previous topic, you learned the different ways to apply formatting to 
content. Now, consider that you might sometimes inherit work that others have done. In 
these situations, you might find the need to clear the formatting that they previously 
applied to the content while leaving the text in place. You might also need to replicate 
the formatting applied to one part of your document to several other parts. In this topic, 
you'll learn how Word helps you manage this need, and you'll apply some interesting 
text effects. 
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Clear All Formatting command 
The Clear All Formatting command strips off all formatting from the selected text, 
returning it to the normal state. This makes it easier to clean up a selection of text or 
even the entire document and then reapply formatting as needed. 

For example, assume that your document has the text “Pickled Beets” formatted in a 
specific font color. To clear all formatting, you need to select this text and then select 
the Clear All Formatting command. The selected text will revert to the default font style 
(the font, font size, and color) set for the document (refer to Figures 34 and 35). 

 
Figure 34: Selected text before the Clear All Formatting command is applied 
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Figure 35: Selected text after the Clear All Formatting command is applied 

 

Additional information 

For more information about how to change the default font in Word, 
refer to: Change the default font in Word 

Format Painter 
One of the most efficient ways to apply formatting to content is to use currently 
formatted content and the Format Painter command. To apply formatting from one 
selection of content to another, select the content that has the formatting you want to 
copy, and then do either of the following: 

• Select Format Painter to copy formatting to selected text. When you hover over the 
new text, a paintbrush icon appears. Select the text, and the copied format applies as 
a single use on the new content. 

• Double-click the Format Painter command to copy formatting to selected text. 
When you hover over the new text, a paintbrush icon appears. You can now apply 
the copied format to multiple selections of text. After you've formatted all the 
content you want, select the Esc key to end the Format Painter functionality. 

https://aka.ms/change-the-default-font-in-word
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Figure 36: The Format Painter command about to be selected 

 
Figure 37: Applying the Format Painter on text with the paintbrush icon displayed 

Text effects 
Another command you can use to dress up the formatting of your content is the Text 
Effects and Typography command. With this command, you can apply predesigned 
effects to text that you've selected. Text effects are a kind of typography, or the visual 
component of the written text. 
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You can apply several types of font altering with the text effects by selecting Text 
Effects and Typography. With the preview functionality in place, you can preview the 
font before you apply the change to your content. 

To apply a text effect, select the content, select Text Effects and Typography, and then 
hover one of the predesigned text effects. You can also explore the settings of other text 
effects to customize and apply the settings of your choosing. 

You can use each of the following options from the text effects to customize your 
content: 

• Outline. Adds a colored outline to the selected text. 
• Shadow. Adds a shadow to a specific location outside the text. 
• Reflection. Adds a reflection of the characters in the text. 
• Glow. Adds a glow color to the perimeter of the text. 
Three more options exist for setting specific parameters to the selected text and 
applying different typography settings—Number Styles, Ligatures, and Stylistic Sets. 
These are more advanced options that won’t be covered in this course. 

 
Figure 38: A preview of a prebuilt text effect on selected text in a document 
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Activity: Show and tell 
The teacher will demonstrate how to select text, clear its formatting, and then copy its 
formatting to other text. Next, you should get ready to learn the snazzy text effects that 
Word has available! 

Resources required 
None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Observe the teacher demonstrate the steps, and make sure you understand how 
each aspect works. 

2. Interact and ask questions, such as: 

o What's the quickest way to select all the content in a document? 
o When might you need to use text effects? 
o What's the sequence of steps for copying formatting by using the Format 

Painter? 
o Do any keyboard shortcuts exist that you can use for the Format Painter? 

Try-it: Copy and clear formatting and apply text 
effects 

 In this levelled try-it, you'll clear all formatting and then copy specific formatting to 
content within a document. 

Try-it 1 
In this try-it you clear all formatting from text in an existing document and then reapply 
formatting to text. 

Resources 
You'll need the following resource for this try-it: 

• L4_T2_try1_concord_grapes_clear_formatting_starter.docx in this lesson’s 
Learning Activity Resources folder 
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Instructions 
You'll perform the following general tasks during this try-it: 

1. Select all the content on the page, and then select Clear All Formatting. 

2. Apply the Segoe font with a font size of 14 to all the content. 

3. Use the Mini Toolbar to change the font size of the Concord Grapes title text to 20 
and to change the formatting to be bold and italic. Next, apply the Blue, Accent 1 
font color. 

4. Apply a font size of 16 and underline the following text: 

o A cultivar of the genus Vitis labrusca 
o Growing Grapes in your yard 

5. Save your file as My_concord_grapes_clear_formatting.docx. 

Try-it 2 
In this try-it, you set and apply the default formatting to specific text and then apply text 
effects. 

Resources 
You'll need the following resource for this try-it: 

• L4_T2_try2_concord_grapes_set_default_format_starter.docx in this lesson’s 
Learning Activity Resources folder 

Instructions 
You'll perform the following general tasks during this try-it: 

1. Set the default font specifically for this document as: 

o Font: Segoe UI 
o Font size: 12 pt. 
o Font color: Black, Text 1 

2. Apply the Title style to the Munson’s Pickles and Preserves Farm text. 

3. Apply the following text effects to the Concord Grapes title text: 

o Fill: Black, Text Color 1 
o Outline color: White, Background 1 
o Hard shadow: Blue, Accent Color 5 

4. Save your file as My_concord_grapes_clear_formatting.docx. 
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Wrap-up 
Use these questions to check what you learned in this lesson: 

1. You use the ______________________ command to remove formats applied to text. 

Fill in the blank space. 

2. Which of these is not an option for applying text effects? 

Select the correct option. 

a. Shadow 

b. Underline 

c. Glow 

d. Reflection 

3. This is where you navigate to when you want to change the default font settings for 
a document.  

Select the correct option. 

a. The Paragraph dialog box 

b. The Font dialog box 

c. The Layout dialog box 

d. The Default dialog box 

4. Which of the following is not included in the Font group? 

Select the correct option. 

a. Text Highlight Color 

b. Change Case 

c. Shading 

d. Font Color 
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5. Which of the following are ways you can modify the font for text in your document? 

Select all that apply. 

a. Select text, and then move the mouse up and to the right to access the Mini 
Toolbar. 

b. Select text, and then apply font changes from the Font group on the Home tab. 

c. Select text, and then apply font changes from the Colors, Fonts, and Effects 
commands on the Design tab. 

d. Select text, right-click or access the context menu of the selected text, and then 
modify the font settings on the Mini Toolbar. 
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Lesson 5: Formatting 
paragraphs 
Overview 
In this lesson, you'll learn how to apply different formatting techniques to your 
paragraphs. Specifically, you'll learn how to set line and paragraph spacing and to apply 
various indentation and alignment features to your content. You'll learn how to build in 
better readability by applying spacing for your paragraphs and lines. 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics. 

1. Which of the following are options to modify the line spacing in a document? 

Select all that apply. 

a. Single 

b. Double 

c. Triple 

d. Multiple 

2. Which ribbon tabs can you use to modify paragraph indents and spacing? 

Select the correct option. 

a. Layout and Home 

b. Layout and Design 

c. Home and Design 

d. Home and Layout 

3. The term justified refers to a type of paragraph ______________________. 

Fill in the blank space. 
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Topic 1: Set line and paragraph spacing 
 The majority of people's documents are intended for other audiences, and one of 

the key ways to ensure readability is by structuring a document with paragraphs. When 
you have more separation via line spacing, the text is much more readable. If your 
objective instead is to fit more text on a page or within a specified area, tighter line 
spacing will assist you. 

Line spacing is the amount of white space between two lines of text, compared to 
paragraph spacing, which is the amount of white space between two paragraphs. 
Managing the white space, and therefore the readability and design of the document, is 
an important concept to understand for managing your document formatting overall. 

Line and paragraph spacing 
While working with content, you can apply spacing to increase or decrease the amount 
of space between lines and paragraphs. 

To apply line spacing, you can apply Single, 1.5, Double, At least, Exactly, or Multiple. 
To apply one of these settings, select your content, and then from the Line and 
Paragraph Spacing command, select the spacing size you want. You can also access 
these settings by opening the Paragraph Settings dialog box of the Paragraph group 
(refer to Figure 39). 

 
Figure 39: Accessing the Paragraph Settings dialog box 
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Figure 40: The Paragraph dialog box with a focus on the Spacing options 

To apply spacing to a paragraph, you can customize the intended amount in the Before 
or After spacing option available from the Paragraph Setting dialog box. The Before 
option allows you to customize the spacing before the active paragraph, whereas After 
applies to the spacing after the active paragraph. You can also manage these spacings 
in the Paragraph group on the Layout tab. 

 

Additional information 

For more information, refer to: Change the line spacing in Word 

https://aka.ms/Changing_Line_Spacing_in_Word
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Shading and borders 
Other common paragraph formatting features include shading and borders. These are 
two features to use when you want to dress up your paragraphs. With a single character 
selected in a paragraph, you can apply either or both—shading and borders—to create 
more depth to your document. To fully customize either the borders or the shading, 
select the Borders command in the Paragraph group, and then select Borders and 
Shading: 

• Borders. A border provides a way to bring attention to your paragraph by applying a 
black line by default around the background of your paragraph. You can modify 
where the line appears for your paragraph by using the Borders command. 

• Shading. This provides a way to apply color around the background of your 
paragraph. 

Show/Hide (Reveal Formatting) 
Another helpful tool available in the Paragraph group is the Reveal Formatting 
command. When you select this command, you can observe all the hidden formatting 
applied in the document, including in tables. It might be difficult to observe what's 
happening underneath if you don’t use this command. You'll make a closer examination 
of this command in other modules, when you learn how to insert and delete page, 
column, and section breaks. 

Activity: Show and tell 
The teacher will demonstrate how to adjust and manage the spacing between lines and 
how to apply spacing before and after paragraphs. 

Resources required 
None 
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Activity instructions 
Participate in the activity by following these instructions: 

• Observe and ask questions as the teacher demonstrates how to apply a few different 
line and paragraph spacing options to content in a document. Here are some 
questions you might ask your teacher: 
o How do you determine what you want the line spacing to be in a document? 
o How do you determine the amount paragraph spacing to apply in a document? 
o Does optimum spacing for readability exist? 

Try-it: Set line and paragraph spacing 
 In this levelled try-it, you'll modify the line spacing and the paragraph spacing 

within a document to improve its readability. 

Try-it 1 
In this try-it, you'll work with an existing document and adjust the line spacing of the 
paragraphs in the document. 

Resources 
You'll need the following resource for this try-it: 

• L5_T1_try1_concord_grapes_lines_starter.docx in this lesson’s Learning Activity 
Resources folder 

Instructions 
You'll perform the following general tasks during this try-it: 

1. Select all the content in the document. 

2. Apply double line spacing to all the paragraphs in the document. 

3. Note that the Concord Grapes title text needs to stand out a bit more. Apply 3.0 
line spacing to this title. 

4. Take note of the readability of the document. 

5. Save your document as My_concord_grapes_lines.docx. 
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Try-it 2 
In this try-it, you'll work with an existing document and adjust the paragraph spacing in 
the document. 

Resources 
You'll need the following resource for this try-it: 

• L5_T1_try2_concord_grapes_paragraphs_starter.docx in this lesson’s Learning 
Activity Resources folder 

Instructions 
You'll perform the following general tasks during this try-it: 

1. Apply 12-point spacing before all paragraphs and 24-point spacing after all 
paragraphs. 

2. The Concord Grapes title text needs to stand out a bit more. Apply 30-point 
spacing before the paragraph and 42-point spacing after the paragraph. 

3. Apply a new font color and bold and italic formatting to the Concord Grapes title. 

4. Take note of the readability of the document. 

5. Save your document as My_concord_grapes_paragraphs.docx. 

Topic 2: Set paragraph and line 
indentation 

 When you create a document, it's important that you build it with your audience 
and the purpose of the document in mind. Besides the line and paragraph spacing, the 
arrangement and placement of the content—that is, the alignment—also impacts the 
document’s readability. For example, have you noticed that in some books, the first 
word in the first paragraph is placed differently? 
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Format the alignment 
You can format the alignment of a single character, word, sentence, or paragraph to 
place content on the page at specific locations. One approach is to select Increase 
Indent or Decrease Indent in the Paragraph group (refer to Figure 41). You can find 
this group on both the Home tab and the Layout tab, with the easier way being via the 
Home tab. You can also use select the Tab key on your keyboard to apply a default 
indent. 

 
Figure 41: The Decrease Indent and Increase Indent commands 

Another way to modify the alignment of paragraphs is by using the text alignment 
commands—that is, Left, Center, Right, and Justify. These four commands are located 
in the Paragraph dialog box (refer to Figure 42), and you can apply them by placing 
your cursor inside the specified paragraph. 
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Figure 42: Alignment commands in the Paragraph dialog box 

This is how the text alignment commands are used: 

• Left and Right. When you apply each of these alignment options, the content aligns 
to the corresponding edge of the page margin. 

• Centered. This alignment option centers the content with respect to the left and 
right page margins. 

• Justified. This option also aligns your paragraph equally between the left and right 
margins but spaces out the words on each line so that both the left and right edges 
of the paragraph are in a straight line. 

 

Additional information 

For more information, refer to: Adjust indents and spacing in Word 

Using the Paragraph dialog box allows you to apply the majority of the commands 
available in the Paragraph group but provides you with a few hidden gems, as well. The 
following section reveals a few of these gems. 

  

https://aka.ms/Adjusting_Indents_and_Spacing_in_Word


Managing documents and options  

 
79 

 

 

Add indent markers 
If you’ve taken a writing class in school, you’re likely familiar with the concept of 
indenting for paragraphs, quotations, and specific letter guidelines. To apply a few of 
these specific indents, you’ll want to investigate the Paragraph dialog box and learn 
how to apply the first line indent and the hanging indent (refer to Figure 43). These 
options allow you to manage the indent level for one or both sides of your document. 

 
Figure 43: Special indents and the preview 

The Preview box demonstrates how a paragraph will be affected by the selections of 
the indent options. A Special box also exists and contains the First line and Hanging 
indent options: 

• First line. Manages the indent level from the left side of your document for the first 
line of a paragraph. 

• Hanging. Applies the indent to all lines of the paragraph except the first line. When 
you apply the hanging indent, you’ll notice all of the paragraph content indenting 
while the first line remains aligned to the left margin. 
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The Paragraph group has many other features to explore that will assist you in 
managing your content on your pages. Take some time to explore the other commands 
to discover how they can assist you. 

 

Additional information 

For more information, refer to: Indent the first line of a paragraph 

Activity: Show me how 
The teacher will demonstrate how to format the alignment of content by modifying the 
indentation of paragraphs, including special, left, and right indents. 

Resources required 
None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Observe as the teacher guides the class through the location and use of paragraph 
alignment options. 

2. Take special notice of where to access the paragraph indent options by activating 
the Paragraph dialog box. Ask questions, and engage with the teacher during the 
demonstration. For example, you can ask questions such as: 

o What is the difference between the Centered and Justified options? 
o How do I specify the amount of indentation for a paragraph? 
o Can I change the unit of measurement—for example, from inches to centimeters? 
o What's the difference between first line and hanging indentation? 

Try-it: Set paragraph and line indentation 
 In this levelled try-it, you'll apply specific line and paragraph indentation to 

content. 

  

https://aka.ms/Indenting_First_Line_of_a_Paragraph
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Try-it 1 
In this try-it, you'll open an existing document and apply both a first-line indent and a 
hanging indent to specific content to make it stand out. 

Resources 
You'll need the following resource for this try-it: 

• L5_T2_try1_vendor_letter_starter.docx in this lesson’s Learning Activity 
Resources folder 

Instructions 
You'll perform the following general tasks during this try-it: 

1. Use your keyboard to apply the default indent to the first line after the salutation—
that is, to the line, We are so excited to learn of your recent booth rental 
purchases…. 

2. Apply a hanging indent of 0.5 just before the word There in the paragraph that 
begins with There is nothing I anticipate…. 

3. Save your document as L5_T2_try1_vendor_letter_final.docx. 

Try-it 2 
In this try-it, you'll apply both a left and a right line indent to specific content to make it 
stand out. 

Resources 
You'll need the following resource for this try-it: 

• L5_T2_try2_vendor_letter_quote_starter.docx in this lesson’s Learning Activity 
Resources folder 

Instructions 
You'll perform the following general tasks during this try-it: 

1. Use your keyboard to apply the default indent to the first line after the salutation—
that is, to the line, We are so excited to learn of your recent booth rental 
purchases…. 

2. Apply both a left and a right indent of 0.5 by placing your cursor just before the 
word There in the paragraph that begins with There is nothing I anticipate…. 

3. Save your document as L5_T2_try2_vendor_letter_quote_final.docx. 
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Wrap-up 
Use these questions to check what you learned in this lesson: 

1. You use the ______________________ dialog box to manage special indents for your 
paragraphs in a document. 

Fill in the blank space. 

2. What is the default indent spacing? 

Select the correct option. 

a. 0.2 inches 

b. 0.3 inches 

c. 0.1 points 

d. 0.5 inches 

3. Which of the following are considered special indents? 

Select all that apply. 

a. Line indent 

b. First line 

c. Last line 

d. Hanging 

4. Which key on the keyboard works like an indent? 

Select the correct option. 

a. Shift 

b. Tab 

c. Backspace 

d. Int 
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Lesson 6: Navigating within 
documents 
Overview 
In this lesson, you'll learn how to efficiently navigate your document by using the 
Navigation pane, by using headers applied from styles in your documents and 
thumbnails, and by building in links and bookmarks. You'll learn how to search for text, 
replace text, and use the Go To command to navigate directly to links or other specific 
areas of a document.  

Warm-up 
Use these questions to find out what you already know about this lesson’s topics. 

1. Which of the following options are available in the Navigation pane? 

Select all that apply. 

a. Search 

b. Replace 

c. Go 

d. Tell Me 

2. What options are available on the Replace tab in the Find and Replace dialog box? 

Select the correct option. 

a. Replace Once, Next, and Go To 

b. Replace Once, Find Next, and Go To 

c. Replace, Replace All, and Find Next 

d. Replace, Replace All, and Go To 

3. You can open the ______________________ by selecting Find on the Home tab or by 
using the Ctrl+F keyboard shortcut. 

Fill in the blank space. 
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4. Which type of formatting builds headings you can find in the Navigation pane? 

Select the correct option. 

a. Font formatting 

b. Paragraph formatting 

c. Styles formatting 

d. Design formatting 

Topic 1: Search for and replace text 
 Have you ever had a reading assignment that required you to learn a specific 

concept from a large document? Or, have you sifted through a lot of information when 
writing a paper? If you can relate to this experience, you'll have a good understanding of 
why being able to search for text in your documents is a welcome relief. Sometimes, you 
need to replace text in a large document, as well. This topic presents the features of 
Word that meet these needs. 

Search for text 
A quick way to activate the Search box in Word is to use the Ctrl+F keyboard shortcut. 
This activates the Navigation pane. 

 
Figure 44: The Navigation pane and its options 
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Three additional ways to activate the search Navigation pane exist: 

• On the status bar, select the Page Number command. This is one of the most 
efficient ways, because it's always available (if the Page Number command is turned 
on). You can turn the Navigation pane on and off from this location. When you 
hover over the Page Number command, a ScreenTip displays. The ScreenTip is The 
current page number in the document. Click or tap to open the Navigation 
Pane. 

 
Figure 45: Hovering over the Page Number command on the status bar 

• On the Home tab, in the Editing group, select the Find command. This 
automatically opens the Navigation pane (refer Figure 46). 

 
Figure 46: The Find command 
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• On the View tab, select the Navigation Pane check box. 

 
Figure 47: Turning on the Navigation pane from the Show group on the View tab 

Observe results in the Navigation pane 
Now that you understand how to activate the Navigation pane, this section will review 
its three main areas for observing your content. When you specifically conduct a search, 
the Search box in the Navigation pane displays the search term, and the Results tab 
displays all the locations in the document where the search results exist. What makes 
the Navigation pane even better is that it provides a few ways for you to quickly 
observe the content that your search has found and where that content exists in your 
document.  

That is, in the Navigation pane, the search content is highlighted, and a list of all of the 
found results displays (refer to Figure 48). 
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Figure 48: Search results in the Navigation pane 

Replace text 
When you search for text in documents, you often need to replace that text, as well. The 
reason might be a misspelling of a word or a change in a reference work that you also 
need to change in the document. When you search for text, you have few ways to 
activate the replace functionality: 

• On the Home tab, in the Editing group, select Replace. 
• In the Navigation pane, select Search for more things (the magnifying glass icon), 

and then select Replace. 
• Press Ctrl+H on your keyboard. 

When you select the Replace command, the Find and Replace dialog box appears with 
the Replace tab displayed. You can choose to replace one or all of the words that meet 
the Find what box criteria with the text in the Replace with box (refer to Figure 49). 
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Figure 49: Replacing text 

Another module of this course will cover the replace functionality and more-advanced 
options. 

Search by pages 
The Navigation pane provides three tabs for searching and navigating the document: 

• Results. Highlights the text entered in the Search box. 
• Pages. Displays thumbnails of the pages in the document, allowing you to quickly 

navigate by selecting those thumbnails (refer to Figure 50). 

 
Figure 50: The Pages tab in the Navigation pane 
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• Headings. Displays an overview of the document headings in a hierarchical outline. 
By using these headings, you can collapse and expand entire areas of content 
throughout the document based on the heading level applied. The Heading 1 style 
appears higher in the hierarchy than the Heading 2 style, for example. 

 
Figure 51: The Headings tab in the Navigation pane  

 

Additional information 

For more information, refer to: Use the Navigation pane in Word 

 

 

Video 

To observe a video about moving text by using headers in the 
Navigation pane, refer to: Move text 

Activity: Guess and tell 
This activity will challenge you to guess the answers to questions that the teacher asks, 
such as the number of times a specific word or phrase appears in a document and the 
quickest way to navigate to specific content in the document. 

Resources required 
None 

  

https://aka.ms/Using_the_Navigation_Pane
https://aka.ms/Move_text_using_the_Navigation_Pane
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Activity instructions 
Participate in the activity by following these instructions: 

1. Observe the teacher demonstrate how to access and use the Navigation pane. 

2. Be prepared to guess the answers to questions that the teacher asks, and volunteer 
to come forward and demonstrate a step on the teacher’s device. 

Try-it: Search for and replace text 
 In this levelled try-it, you'll use the Navigation pane and the Find and Replace 

options to locate and modify content in a document. 

Try-it 1 
You'll open a document and find words in it by using the Navigation pane. You'll also 
change some of the words by using Replace. 

Resources 
You'll need the following resource for this activity: 

• L6_T1_try1_farm_report_visitors_starter.docx in this lesson’s Learning Activity 
Resources folder 

Instructions 
Participate in the activity by following these instructions: 

1. Replace all instances of the word Visitors with the word Guests by using the 
Replace tab. 

2. Ensure that no instances of the word Visitors exist by using the Navigation pane. 

3. Save the file as L6_T1_try1_farm_report_visitors_final.docx. 

Try-it 2 
You'll open a document and find words in it by using the Heading tab in the 
Navigation pane. 

Resources 
You'll need the following resource for this activity: 

• L6_T1_try2_farm_report_guests_starter.docx in this lesson’s Learning Activity 
Resources folder 
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Instructions 
Participate in the activity by following these instructions: 

1. Determine the number of instances of the word grapes in the document. 

2. Edit the flow of the content and make Special Produce the first heading in the 
document by using the Navigation pane. 

3. Save the file as L6_T1_try2_farm_report_guests_final.docx. 

Topic 2: Link and navigate to locations 
 Using links in your documents is a useful and common practice. As a student, 

you're likely familiar with hyperlinks and navigating to another location on your device, 
such as a website or email application. 

As you prepare documents, such as research papers, you might want to provide links to 
other documents or to websites, to send an email with a question, or to link to a specific 
location in the same document. Links to a location within the same document allow you 
to provide more information to a topic you've covered in another location in your 
document. 

To create, edit, and manage hyperlinks in your Word document is quite simple. 

Insert hyperlinks 
You can insert a hyperlink in a few ways. The most common way is to insert a URL so the 
reader can navigate to a site on the internet. 

To apply a hyperlink, right-click or access the context menu of the location, word, or 
object that you want to apply the link to, and then select Link. Next, select Insert Link 
to open the Insert Hyperlink dialog box. You can also apply a hyperlink in the Links 
group on the Insert tab. 
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Figure 52: The Insert Hyperlink dialog box 

Your hyperlink options include:  

• Existing File or Web Page 
• Place in This Document 
• Create New Document 
• E-mail Address 

The dialog box also has button to create and insert a bookmark, which this lesson will 
discuss later. The most common way to create a hyperlink is to either provide a URL or 
link within the same document. All the options provided will create a hyperlink. When 
you hover over the word, location, or object, a finger icon appears. When you select the 
link, it navigates to the specified location. It's important to add text the Text to display 
box that explains what the link is for. The document displays this text, which is what the 
reader will hover over and select to access the link. 
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Go to different areas of the document 
On the third tab in the Find and Replace dialog box, the Go To tab, you can navigate to 
different areas of the document based on the criteria you choose. Some of the more 
common options are to navigate by pages, headings, tables, or other objects. On the Go 
To tab, you can choose how you want to navigate. You'll typically use pages to navigate 
to a specific page in the document. When the Go To tab is displayed, enter the page 
number in the document that you want to navigate to. This will save you time compared 
to selecting Page down or Page up numerous times. 

 
Figure 53: The Go To tab in the Find and Replace dialog box 

Scroll through the Go to what options for the many ways available to navigate the 
document. Heading is a common option and works similarly to the headings in the 
Navigation pane, allowing you to navigate based on the heading style, such as 
Heading 1. 
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Link to locations in the document 
Another common way to advance in the document is to select Bookmark on the Go To 
tab. You can create a bookmark on text, a picture, or a place in your document that you 
want to name and note for later reference. You can use bookmarks simply for 
navigation, as well. 

 
Figure 54: Using Bookmark on the Go To tab 

To insert a bookmark into the document, select the content you want to apply the 
bookmark to. On the Insert tab, in the Links group, select Bookmark. The Bookmark 
dialog box appears. Enter the name of your bookmark. Select whether you want the 
bookmark to be searched by name or by location in the document, and then select Add. 
Now, when using the Go To tab in Word, you and others can select Bookmark to 
navigate throughout the document by using just the bookmarks. 

 

Did you know? 

When you create bookmarks in Word and then save the document as 
a PDF file, you can include the bookmarks in the PDF file for your 
audience to reference and navigate with—even outside of Word—
improving the user-friendliness of your file. 

Remember that when creating a bookmark, you can't use spaces 
between words. 
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Activity: Popcorn 
The teacher will demonstrate how to add links in a document and ask questions along 
the way. You’ll have under a minute to locate the answer in Word on your device. 

Resources required 
None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Pay attention to the demonstration, and stay alert for a question from the teacher. 

2. When the teacher announces “Popcorn,” “pop up” if you have the answer and 
announce it to the class. 

3. Sit down, allowing other students to “pop up” with an answer. 

Try-it: Link and navigate to locations 
 In this levelled try-it, you'll create different hyperlinks to improve the navigation in 

a document, and you'll navigate to different areas of the document. 

Try-it 1 
In this try-it, you'll create a hyperlink to navigate to a different location in the document. 
You'll also create a hyperlink to navigate to a website's URL. 

Resources 
You'll need the following resource for this try-it: 

• L6_T2_try1_farm_produce_report_links_starter.docx in this lesson’s Learning 
Activity Resources folder 

Instructions 
You'll perform the following general tasks during this try-it: 

1. Search for the text Concord grapes at the beginning of page 1. 

2. Link these two words to the location where the Uses for Produce heading appears. 

3. Set the ScreenTip to Read Recipe Ideas for this link. 
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4. Link the Pumpkins heading on Page 4 and the Romaine Lettuce heading on Page 5 
to where the Uses for Produce heading appears. 

5. Save the file as L6_T2_try1_farm_produce_report_links_final.docx. 

Try-it 2 
In this try-it, you'll create bookmarks for the three main areas of the special products. 
You'll then use the Go To tab to navigate to different locations in the document. 

Resources 
You'll need the following resource for this try-it: 

• L6_T2_try2_farm_produce_report_bookmarks_starter.docx in this lesson’s 
Learning Activity Resources folder 

Instructions 
You'll perform the following general tasks during this try-it: 

1. Add a bookmark on Page 3, under Special Produce to the Concord Grapes text. 

2. Add bookmarks for the Pumpkins and Romaine Lettuce headings on Pages 4 and 
5, respectively. 

3. Save the file as L6_T2_try2_farm_produce_report_bookmarks_final.docx. 

Wrap-up 
Use these questions to check what you learned in this lesson: 

1. Which of the following is an option in the Navigation pane that you can use to 
navigate to different links named in the document? 

Select the correct option. 

a. Objects 

b. Bookmarks 

c. Pages 

d. Find and Replace 
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2. What are the three main areas in the Navigation pane?

Select the correct option.

a. Headings, Paragraphs, and Results

b. Bookmarks, Headings, and Results

c. Pages, Results, and Bookmarks

d. Results, Pages, and Headings

3. When you use the ______________________ feature, the document will highlight the text
in yellow and display the text around the word.

Fill in the blank space.

4. What's a quick way to navigate to pages in your document?

Select all that apply.

a. Use Pages in the Navigation pane

b. Use the Page command on the status bar

c. Use Page on the Go To tab

d. Use the Page Down command on the Home tab
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Glossary 
Ribbon A set of commands and command groups at the top of the 

document window, which you can minimize or hide. 

Title bar The bar at the top of the document that displays the document 
name. 

Status bar The bar at the bottom of the document that displays information 
you choose to display, including the page number, word count, 
display settings, and zoom options. 

Zoom slider A slider on the status bar that you can use to zoom in and out of a 
document, from a minimum of 10 percent to a maximum of 500 
percent. 

Indent The space between the document margin and the starting text on a 
line. 

Margin  The blank space around the boundaries of the document content. 

Navigation pane A pane that you can use to quickly go to a search result, section, 
page, or heading in a Word document. 

Tell me what you 
want to do 

A box that provides you with commands or directions based on the 
information you provide about a task you want to perform. 

Table 4: Glossary terms and definitions 
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Cornerstone 
Overview 
This Cornerstone project requires you to update documents for the upcoming 
Blueberries and Balloons Festival at Munson’s Pickles and Preserves Farm. You'll use the 
skills learned in this module to format, edit, navigate to, and arrange content in various 
documents. 

Objectives 
The following table outlines the Cornerstone objectives and their corresponding 
Microsoft Office Specialist (MOS) exam objectives. 

Manage the interface elements to work 
efficiently in Word  

• Not mapped

Create a new document and save an 
existing file as another file type  

• Objective Domain (OD) 1.3.1: Save
documents in alternative file formats

Manage the text formatting and text 
effects 

• OD 2.2.2: Apply formatting by using
Format Painter

• OD 2.2.1: Apply text effects
• OD 2.2.4: Apply built-in styles to text
• OD 2.2.5: Clear formatting

Manage paragraphs by using line and 
paragraph spacing and indentation  

• OD 2.2.3: Set line and paragraph
spacing and indention

Search for text and link the text to 
locations in documents 

• OD 1.1.1: Search for text
• OD 1.1.2: Link to locations within

documents
• OD 1.1.3: Move to specific locations

and objects in documents

Table 5: Cornerstone objectives 
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Duration 
95 minutes 

Instructions 
1. Complete the tasks for each file. 

2. When saving your file, add your name to the end of the file name—for example, 
You_pick_day_Dwayne_Espino. Follow your teacher’s directions for where to save 
your files. 

3. When you’re done with the Cornerstone, assess your completion, and then enter the 
points you think you earned within the task lists in the following sections. You can 
get help from your teacher, if necessary. 

Tasks 
You'll work with three files in this Cornerstone: 

• Cornerstone_booth_event_list_starter.docx 
• Cornerstone_call_for_vendors_letter_starter.docx 
• Cornerstone_food_catalog_starter.docx 

The following sections describe the tasks you need to do within each file. 

File 1: Cornerstone_booth_event_list_starter.docx 
Task: Manage your toolbars (12 points) 
1. Open Cornerstone_booth_event_list_starter.docx. (1 point) 

2. Modify the display to Auto-hide Ribbon, and then navigate through the document. 
Modify the display to Show Tabs. (1 point) (Not mapped) 

3. Manage the Quick Access Toolbar to display the Open command and the Save 
command, and then add both paragraph groups. (4 points) (Not mapped) 

4. Modify the status bar to include Word Count, Character Count, Page Number, and 
Spelling and Grammar Check. Turn off Macro Recording and Signatures. (6 
points) (Not mapped) 

Points scored: ______ / 12 
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Task: Format the Booth Event List document (31 points)  
1. Apply the Title style to the Booth Event List title at the beginning of the document. 

(1 point) (Exam objective 2.2.4) 

2. Apply the Heading 1 style to the Vendor Coverage Areas text. (1 point) (Exam 
objective 2.2.4) 

3. Apply the Heading 2 style to the Apples text. (1 point) (Exam objective 2.2.4) 

4. Using the Format Painter, apply the format of the Apples text to the following 
event titles: blueberries, balloons, carrots, and all other events. (7 points) (Exam 
Objective 2.2.2) 

5. Apply the Heading 3 style to Events (in the Apples section). (1 point) (Exam 
objective 2.2.4) 

6. Using the Format Painter, apply the format of the Events text to each event 
location where the Event paragraph is present. (4 points) (Exam Objective 2.2.2) 

7. Apply the Emphasis style to each event listed, starting with Bobbing for Apples. 
The document lists a total of 11 events, including “Bobbing for Apples”. (11 points) 
(Exam Objective 2.2.2) 

8. Select the Community Focused text and apply Orange, Accent 2, shading, and text 
effects that meet the following specifications: Black, Text 1 outline; Shadow, Offset 
Left; and Tight Reflection, Touching. (5 points) (Exam Objective 2.2.1) 

Points scored: ______ / 31 

Task: Create bookmarks in the Booth Event List document (15 
points) 
1. Bookmark the following areas of the document: Bobbing for Apples, U-Pick Apple 

Harvest, Cider Festival, Apple Wreaths, Blueberry Parade, Blueberry Pie-Off!, 
Hot Air Balloon Extravaganza, Balloon Hunt, Carrotfest!, Community Garden, 
and Learning About Smart Agriculture. (11 points) (Exam objective 1.1.2) 

2. Verify that all 11 bookmarks were made by accessing the Bookmark dialog box and 
then changing the sorting option to Location. (2 points) (Exam objective 1.1.2) 

3. Use the Go To tab to navigate to all 11 bookmarks. (2 points) (Exam objective 1.1.2) 

Points scored: ______ / 15 

File 1 total points: ______ / 58 
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File 2: Cornerstone_food_catalog_starter.docx 
Task: Reformat the Food Catalog document (23 points)  
1. Open the Cornerstone_food_catalog_starter.docx document. (1 point) (Not 

mapped) 

2. Add the Styles group and the Clear All Formatting command to the Quick Access 
Toolbar. (2 points) (Exam objective 2.2.5) 

3. Select all the content, and then clear the formatting. (2 points) (Exam objective 2.2.5) 

4. Select the document title, and then apply the Title style. Modify the entire set of title 
text to capitalize each word. (2 points) (Exam objective 2.2.4) 

5. Apply Heading 1 to the From our farm to your table and The farm to table 
process text. Apply the Gold, Accent 4, Darker 50% font color. (4 points) (Exam 
objective 2.2.4) 

6. Apply Heading 2 to Apples!, Pears, Carrots, and Beets, and then apply Heading 3 
to Apples for eating raw and Apples for cooking. (4 points) (Exam objective 2.2.4) 

7. Using the Format Painter, apply the Bold font style and the Gold, Accent 4, Darker 
50% font color to each named apple and not its entire paragraph. (8 points) (Exam 
objective 2.2.2) 

Points scored: ______ / 23 

Task: Link to Booth Event List document (8 points) 
1. Select the Apples! text, and then insert a hyperlink to your solution file for 

Cornerstone_booth_event_list_starter.docx. (2 points) (Exam objective 1.1.2) 

2. Add a ScreenTip to the hyperlink stating, Learn more about our apple events here. 
(2 points) (Exam objective 1.1.2) 

3. Create a bookmark for the four main fruits and vegetables listed in the document. (4 
points) (Exam objective 1.1.2) 

Points scored: ______ / 8 
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Task: Save a document as different file types (15 points)  
1. Save your file as Cornerstone_food_catalog_final.docx. (2 points)  

2. Resave the file with the same name but the Save as type selected as .pdf. (2 points) 
(Exam objective 1.3.1) 

3. Let the teacher know when you're on this step. When the PDF file opens, select the 
Apples! link. (2 points) (Exam objective 1.1.2) After your teacher has observed this 
step, close the PDF file. 

4. From your Cornerstone_food_catalog_final.docx file, save your food catalog 
solution file as a plain text file. Accept all the default settings. Close this file. In File 
Explorer, open this .txt file, and then identify to your teacher what has changed. (4 
points) (Exam objective 1.3.1) 

5. With your Cornerstone_food_catalog_final.docx file open, save the file with the 
same name but the Save as type selected as .doc. Point out your application 
window with this file saved to your teacher. Identify to your teacher what has 
changed with this file type. (5 points) (Exam objective 1.3.1) 

Points scored: ______ / 15 

File 2 total points: ______ / 46 

File 3: 
Cornerstone_call_for_vendors_letter_starter.docx 
Task: Search for text (16 points) 
1. Open Cornerstone_call_for_vendors_letter_starter.docx. (1 point) (Not mapped) 

2. Using the Format Painter, select the Blueberries and Balloons Festival! text, and 
then apply to the Blueberries text that precedes the paragraph and image 
explaining blueberries. (1 point) (Exam objective 2.2.2) 

3. Search for the word community in the document. Take note of the number of 
instances of this word. Let your teacher know when you reach this result, and then 
provide the answer. (2 points) (Exam objective 1.1.1) 

4. Identify which headings contain the word “volunteer” in the document. Let your 
teacher know when you reach this result, and then provide the answer. (2 points) 
(Exam objective 1.1.1) 
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5. From the Navigation pane, move the Hot Air Balloons heading and content (with a 
single movement) so it follows the Blueberries and Balloons Festival! heading. 
Present this your teacher when you've completed this activity. (4 points) (Exam 
objective 1.1.1) 

6. Select all content in the document, and then apply the Verdana font. (2 points) 

7. Select the body text, and then verify that it's set to the Verdana font. If some text 
isn't set to Verdana, select body text with the Verdana font, and then use the Format 
Painter to apply Verdana to those body text areas missing this font. (2 points) (Exam 
objective 2.2.2) 

8. Select the signature text, beginning with With the warmest regards, and then move 
this text so it follows the blueberry image. (1 point) (Exam objective 2.2.4) 

9. Save this file as My_call_for_vendors_letter.docx. (1 point) 

Points scored: ______ / 16 

Task: Better manage the letter (12 points)  
1. On the status bar, select Page 2 of 2. If this closes the Navigation pane, determine 

the quickest way to reopen the Navigation pane. (3 points) (Exam objective 2.2.4) 

2. With the last Cornerstone_call_for_vendors_letter_final.docx document open, 
make sure the Bringing the two together paragraph begins on a new page: enter 
two new empty paragraphs to place this text on the next page. (1 point) (Exam 
objective 2.2.4) 

3. With the text on the next page, too much space now exists at the beginning of the 
page. With the Navigation pane open and the Headings tab displayed, select the 
empty headings. Modify these headings to the Normal style. (4 points) (Exam 
objective 2.2.4) 

4. From the Headings tab in the Navigation pane, move Blueberries just before 
Bringing the two together. (1 points) (Exam objective 2.2.4) 

5. Select the signature text that begins with With the warmest regards, and move this 
text to the end of the document. (1 point) (Exam objective 2.2.4) 

6. Explore the page flow by using the Navigation pane, and ensure that your 
document contains no more than two pages in total. Delete empty paragraph spaces 
to keep a professional flow to your document. Make sure that the salutation is the 
last piece of content on Page 2. (2 points) (Exam objective 2.2.4) 

Points scored: ______ / 12 
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Task: Link the letter to your Booth Event List document (12 
points)  
1. With your Cornerstone_call_for_vendors_letter_final.docx file open, apply a 

hyperlink to your Blueberries and Balloons Festival solution document. Add a 
ScreenTip stating Select for more information. (6 points) (Exam objective 1.1.2) 

2. The Blueberries and Balloons Festival! text now appears differently but still 
displays the hyperlink you entered. Using the Format Painter, copy the formatting 
from Blueberries and apply it to the Blueberries and Balloons Festival! text. (2 
points) (Exam objective 2.2.2) 

3. When you hover over the Blueberries and Balloons Festival! text, the hyperlink and 
the ScreenTip should still be present. Share your results with the teacher at this 
point. Select the Ctrl key and select the link to observe the hyperlink in action. (4 
points) (Exam objective 1.1.2) 

Points scored: ______ / 12 

Task: Manage the line and paragraph spacing (36 points)  
1. With your Cornerstone_call_for_vendors_letter_final.docx file open, place your 

cursor at the beginning of Blueberries and Balloons Festival!, and then change the 
spacing before the paragraph to 12 points. (2 points) (Exam objective 2.2.3) 

2. Modify the spacing before Blueberries and Bringing the two together to 12 
points. (2 points) (Exam objective 2.2.3) 

3. Select the text under the Blueberries and Balloons Festival! heading, and set the 
paragraph indent to Justified. (2 points) (Exam objective 2.2.3) 

4. Select the date, and set it to have right alignment. (2 points) (Exam objective 2.2.3) 

5. Select the salutation at the end of the page, beginning with With the warmest 
regards and continuing through the COO, and set it to have right alignment. (2 
points) (Exam objective 2.2.3) 

6. With the salutation content selected, increase the right indent to 0.5. (2 points) 
(Exam objective 2.2.3) 

7. When scanning the document from the Navigation pane, notice the extra spacing 
after the balloon image and before the Blueberries heading. Delete the extra 
paragraph spacing so the Blueberries heading is directly following the image. (1 
point) 

8. Select the body text under the Blueberries and Balloons Festival! heading, change 
the line spacing of the text to 1.5, and then ensure that it's set to Justified. (2 points) 
(Exam objective 2.2.3) 
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9. Apply the same line spacing and alignment to the text under Hot Air Balloons and 
Blueberries. (4 points) (Exam objective 2.2.3) 

10. At the end of each block of text, minimize the spacing after the paragraph to 6 
points. (10 points) (Exam objective 2.2.3) 

11. At the beginning of the With the warmest regards salutation, ensure that 18 
points is set for both the before and the after paragraph spacing. (2 points) (Exam 
objective 2.2.3) 

12. Save and close your files. (1 point) 

Points scored: ______ / 36 

File 3 total points: ______ / 76 
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Module overview 
Description 
Editing documents, whether they are short or lengthy, can be a manual and time-
consuming process. Imagine the frustration of a journalist who must correct a word 
they’ve used many, many times in a 2000-word article or an intern who must update an 
urgent, annual finance report with feedback from multiple stakeholders. By learning how 
to use Word features that enable the automation of updating text, simplify changes to 
page layout, and track edits, you can save time and be more productive with your 
school, personal, and job-related work. 

This module builds on the previous module, and you will start with learning how to 
quickly find and replace text based on keywords and formatting. It won’t matter if 
multiple stakeholders review and edit a document because you will learn how to track 
changes in the document, add comments to explain your changes, and observe changes 
made by others in the same document. Next, you will learn how to reveal hidden 
characters in your document, to determine how to improve its layout. Format text in 
columns and insert section and page breaks to change the document layout. And finally, 
every document could use a little extra style! Learn how to apply a style set and theme 
to your documents. 

The following table outlines the lessons in this module and their corresponding learning 
objectives. 

Lesson Learning objective Exam objective(s) 

Finding and 
reusing content 

Find and replace or reuse content in a 
document.  

• 1.1.1 
• 2.1.1 

Collaborating 
within a 
document  

Use comments and track changes to 
communicate, edit, and collaborate in a 
document. 

• 6.1.1 
• 6.1.2 
• 6.1.3 
• 6.1.4 
• 6.2.1 
• 6.2.2 
• 6.2.3 
• 6.2.4 
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Lesson Learning objective Exam objective(s) 

Managing 
layouts 

Manage the layout of a document using the 
Show/Hide feature, format text in columns, 
and change the page orientation. 

• 1.1.4 
• 2.3.1 
• 2.3.2 
• 2.3.3 

Applying styles 
and themes 

Apply document style sets and different 
themes to a document. 

• 1.2.2 

Cornerstone: 
Making 
Munson’s 
summer camp 
updates  

Apply the skills learned throughout this 
module in a task-based project. Update the 
summer camp application form while 
collaborating with the rest of the team. 

• 1.1.4 
• 1.2.2 
• 2.1.1 
• 2.3.1 
• 2.3.2 
• 2.3.3 
• 6.1.1 
• 6.1.2 
• 6.1.3 
• 6.1.4 
• 6.2.1 
• 6.2.2 
• 6.2.3 
• 6.2.4 

Table 1: Objectives by lesson 

Scenario 
Munson's Pickles and Preserves Farm (Munson’s) is a destination for school trips, family 
agricultural tourism, and youth summer camps. 

You are helping the events team update existing documents for the fifth annual summer 
camp program, field trip activities, and family days while keeping the team informed of 
your changes, questions, and feedback in the documents. 
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This presents an opportunity for you to apply what you will learn in this module and 
build on your skills required for certification. It will require you to find and replace 
content, manage the document layouts, collaborate in these documents using 
comments and track changes, and apply style sets and themes. This, in turn, will help 
you be more productive working with documents either for personal work or at the 
workplace. 

Cornerstone 
This module concludes with a cornerstone, in which you’ll update the application form 
for the upcoming summer camp at Munson’s. In the cornerstone, you’ll: 

• Move and reuse text and graphics in the document. 
• Make edits to the document while collaborating with your classmates. 
• Change the document’s format and layout. 
• Insert breaks between pages and sections of content. 
• Apply style sets and themes. 
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Lesson 1: Finding and reusing 
content 
Overview 
In this lesson, you will learn how to find specific text in a document and replace it with 
new text. You will also learn how to reuse document content. You’ll participate in 
discussions and step-by-step demonstrations, and you’ll have opportunities to practice 
what you learn along the way. 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. Where can you find the Find and Replace commands? 

Select the correct option. 

a. Review tab, Proofing group 

b. Home tab, Editing group  

c. Design tab, Document Formatting group 

d. References tab, Research group 

2. What is the keyboard shortcut for Find and Replace? 

Select the correct option. 

a. Ctrl+I 

b. Ctrl+F 

c. Ctrl+G 

d. Ctrl+H 

3. The Clipboard retains up to_________________ items that you copy from an Office app. 

Fill in the blank space. 
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Topic 1: Find and replace text 
 Imagine you’ve just completed your book’s manuscript and the publisher has 

asked you to change the name of your main character to make it more globally relevant. 
Do you feel overwhelmed? Don’t worry! If you need to find specific words or phrases to 
update the format or replace the current word or phrase with a new one, the Find and 
Replace commands can help.  

Start the process by navigating to the Home tab, locating the Editing group, and 
selecting Replace. 

 

Did you know? 

Access the Find and Replace command with the Find and Replace 
keyboard shortcut, Ctrl+H. 

Features within the Find and Replace window 

Once you select Replace, a window will open with the Replace tab selected and 
displayed, as depicted in the following screenshot: 

 
Figure 1: Find and Replace dialog box 

There are two boxes within this tab: Find what: and Replace with:. 
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Perform a simple find and replace 
To find and replace text in a document, perform the following steps: 
1. In the Find what: box, enter the word or phrase you want to search. 

2. In the Replace with: box, enter your new text. 

3. Select Find Next until you come to the word you want to update. 

4. Select Replace. To update all instances at once, choose Replace All. 

Apply Search options 
You can specify search terms in a document with multiple options. For example, to 
specify only upper or lowercase in your search, select More > Match case in the Find 
and Replace dialog box. 

Search options 
The following table outlines the search options available in the Find and Replace dialog 
box. 

Search Specify the whole document, or from 
before or after your cursor position. 

Match case Find and replace words that only match 
specific capitalization. 

Find whole words only Avoid partial matches. For example, 
using this option will help you ensure 
that changing the word “one” to “two” 
doesn’t inadvertently change the partial 
word “one” in “someone” to “two” and 
create the nonsense word “sometwo.” 

Use wildcards Get partial matches. For example, “the*” 
finds “theater,” “thespian,” and 
“thermin.” 

Sounds like (English) Find and replace words that sound like 
others, for example, “they're,” “there,” 
and “their.” 

Find all word forms (English) Find and replace all verb tenses. For 
example, enter “find,” and Word will 
return “finds,” “finding,” and “found.” 
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Match prefix Works with other settings to find and 
replace words with common prefixes or 
beginnings, such as the prefix “super.” 
Includes words such as “superfood,” 
“superstar,” and “superimpose.” A search 
for this prefix returns words that start 
with super. For example, if you want to 
remove “super,” then find “super,” select 
the result, “superstar,” and replace with 
“star.” 

Match suffix Works with other settings to find and 
replace words with common suffixes or 
endings like the suffix -ing: applying, 
modifying, and investigating. A search 
for this suffix would return words ending 
with “ing.” Replace as needed. 

Ignore punctuation characters Ignore differences in hyphenation. 
Ignore white-space characters Ignore spacing between characters. 
Format button Find and replace page formatting 

options like font types or colors, 
paragraph formatting (left, right, center), 
or highlighted words. 

Special button Find and replace page and character 
elements such as em dashes (), tabs, 
or section breaks (a break in the 
formatting from one section to the 
next). 
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No Formatting If you add formatting to the Find and 
Replace dialog box, the Word 
application keeps this selection until you 
close the application. If you want to 
clear formatting from the Find and 
Replace dialog box, select the text box, 
Find what: or Replace with: and then 
select No Formatting to turn off 
formatting selections. 

Table 2: Search options 

Activity: Discuss and learn 
In this activity, you’ll participate in a teacher-led group discussion on the differences 
between the Find and Replace options. 

Resources required 
None 

 

Additional information 

For more information on finding and replacing text, go to: Find and 
replace text 

Activity instructions 
Participate in the activity by following these instructions: 

1. Read the article. 

2. Open a new blank document, add four sentences of text about your future career 
plans. 

3. Explore two different options to use the Find command and two different examples 
of the Replace command. 

4. Add a sentence after the original text to explain how you used each example. 

5. Reach out to your teacher if you need help finding these commands. 

6. Share your findings when prompted by the teacher. 

  

https://aka.ms/Find_and_replace_text
https://aka.ms/Find_and_replace_text
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Try-It: Find and replace text 
 In this leveled try-it activity, you will apply your learning and discover how the Find 

and Replace feature helps you save time. You need to find specific text and replace it 
with new text. 

Try-it 1  
In this try-it, you’ll find specific content in a document and replace all instances of it with 
the correct content. 

Resources 
You will need the following resources for this try-it: 

• Open L1_T1_try1_September_field_trips_starter.docx in this lesson’s Learning 
Activity Resources. 

Instructions 
The following are the general tasks to perform during this try-it: 

1. Search for Munsons in the document. 

2. Replace all instances of the word Munsons with Munson’s throughout the 
document. 

3. Save and close the document. 

Try-it 2 
In this try-it, you’ll narrow your search down to style-specific instances. You’ll then 
replace all instances of this content with the correct content and casing. 

Resources 
You will need the following resources for this try-it: 

• Open L1_T1_try2_pickle_camp_starter.docx in this lesson’s Learning Activity 
Resources. 

  



Managing edits and document layouts 

 

 

 
14 

Instructions 
The following are the general tasks to perform during this try-it: 

1. Go to the end of the document. 

2. Use the Find and Replace command and search upwards through the document to 
find the text MUNSON’S PICKLES AND PRESERVES and replace it with Munson’s 
Pickles and Preserves. 

3. Save and close the document. 

Topic 2: Reuse content with the 
Clipboard 

 Do you remember your craft classes, where you might have used scissors to cut 
paper and glue to paste it onto another piece of paper? 

Word allows you to “cut” or “copy” content from your documents, and “paste” it to 
another document using the Cut, Copy, and Paste commands. The Help feature of the 
Microsoft Office Clipboard temporarily stores the content you cut or copy, before you 
paste it into a new location. 

You can perform simple cut, copy, and paste actions either by using the buttons on the 
ribbon or the keyboard shortcuts Ctrl+X (Cut), Ctrl+C (Copy), or Ctrl+V (Paste). The 
following screenshot depicts the Cut, Copy, and Paste options available in the Home 
tab Clipboard group. 

 
Figure 2: Home ribbon Clipboard group 
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Change options when pasting content 
When you copy content from a formatted source, such as a webpage or another Word 
document, you can select one of several actions when pasting the content back into 
your document. Perform the following steps: 

1. Select where you want to paste the content. 

2. Use the keyboard shortcut Ctrl+V, and then select the Paste Options. 

3. Hover over the icons for a live preview. 

Select a paste option to use 
The Paste Options button lets you select formatting options and is on by default. If the 
button isn't visible or you can't locate it, that feature might not be available. To turn it 
on, perform the following steps: 

1. Select File > Options > Advanced. 

2. In the Cut, Copy, and Paste section, select the Show Paste Options button for 
pasted content. 

3. Select OK. If the setting is on but the button does not display when you paste, make 
sure you paste formatted content, not plain text (no formatting applied), as in the 
Notepad application. 

Get the appearance you want 
When you copy text from a Word document, webpage, or another application 
document and paste it into a Word document, you can choose how to format the text. 
You can keep the original formatting, merge the current formatting of the copied 
content (called source formatting) with the formatting of the content in the destination 
document (called destination formatting), or paste plain text, as depicted in the 
following screenshot:  
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Figure 3: Paste Options menu 

Keep Source Formatting (K): This option keeps the formatting of the copied text. Any 
style definition that is associated with the copied text copies to the destination 
document. 

Merge Formatting (M): This option discards most formatting that was applied directly to 
the copied text, but it retains formatting that is considered to emphasize, such as bold 
and italic, when it is applied to only a portion of the selection. The pasted text takes on 
the current style characteristics of the paragraph. The text also takes on any direct 
formatting or character style properties of text that immediately precedes the cursor. 

Picture (U): This option is only available with an Office 365 Subscription and converts 
text into an image and pastes the image. As a result, you can't change the text, but you 
can treat the pasted image like any other picture and apply effects, borders, or rotation. 
Select the pasted image and choose options from the Picture Format tab. 

Keep Text Only (T): This option discards all formatting and non-text elements such as 
pictures or tables. The text takes on the style characteristics of the paragraph where it is 
pasted and takes on any direct formatting or character style properties of text that 
immediately precedes the cursor. This option discards graphical elements, and converts 
tables into a series of paragraphs. Did you know that the Clipboard allows you to copy 
up to 24 items from Office documents or other programs, and paste them into another 
Office document? 

For example, you can copy text from an email message, data from a workbook or 
datasheet, and a graphic from a presentation, and then paste them all into a Word 
document. By using the Clipboard, you can arrange the copied items the way that you 
want in the document. 

You’re not limited to only pasting the last item you copied or cut when you use the 
Clipboard task pane. The Clipboard task pane holds many of the last images and text 
you copied or cut. 
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Open the Office Clipboard task pane 
To open the Clipboard task pane, perform the following steps: 

1. Select Home, and then select the Clipboard dialog box launcher. The following 
screenshot depicts the Clipboard dialog box launcher: 

 
Figure 4: Clipboard dialog box launcher 

2. Double-click to select the image or text you want to paste. 

Copy and paste multiple items using the Office 
Clipboard 
To copy and paste multiple items in the Clipboard, perform the following steps: 

1. Open the file that has images or text you want to copy. 

2. Select the first item that you want to copy, and select Ctrl+C. 

3. Continue copying items from the same or other files until you have collected all the 
items that you want. 

The Clipboard can hold up to 24 items. If you copy a 25th item, the Clipboard deletes 
the first item copied. It’s like a pipe with limited capacity. When the pipe is full, the other 
items push out the item at the bottom of the pipe. As you add items to the Clipboard, 
the task pane displays an entry. The Clipboard always adds the newest entry to the top 
of the pipe. Each entry includes an icon that represents the source Office program and a 
portion of copied text or a thumbnail of a copied graphic, as depicted in the following 
screenshot: 
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Figure 5: Clipboard panel 

1. Point to the location where you want to paste the items. You can paste collected 
items into any Office program. 

2. Do one of the following:  

o To paste items one at a time, in the Clipboard task pane, double-click or access 
the context menu on each item that you want to paste. 

o To paste all the items that you copied, in the Clipboard task pane, select Paste 
All. 
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Delete items from the Clipboard 
You can delete items from the Clipboard individually or all at the same time. 

To delete items from the Clipboard task pane, perform the following steps: 

1. Select the arrow next to the item that you want to delete, and then select Delete. 

2. To clear all items, select Clear All. 

Control how to display the Office Clipboard 
To control how to display the Clipboard, select the Options button. The following table 
outlines the display preferences available in the Clipboard.  

Show Office Clipboard 
Automatically  

Automatically displays the Clipboard when 
copying items. 

Show Office Clipboard 
When Ctrl+C Pressed 
Twice  

Automatically displays the Clipboard when you 
select Ctrl+C twice. 

Collect Without 
Showing Office 
Clipboard  

Automatically copies items to the Clipboard 
without displaying the Clipboard task pane. 

Show Office Clipboard 
Icon on Taskbar  

Displays the Clipboard icon in the status area of 
the system taskbar when the Clipboard is active. 
This option is turned on by default. 

Show Status Near 
Taskbar When Copying  

Displays the collected item message when 
copying items to the Clipboard. This option is 
turned on by default. 

Table 3: Display preferences 

 

Additional information 

For more information on copying and pasting in Word, go to: Copy 
and paste in Office for the web 

https://aka.ms/Copy_and_paste_in_Office_for_the_web
https://aka.ms/Copy_and_paste_in_Office_for_the_web
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Activity: Show and tell 
In this activity, you will participate in a teacher-led demonstration on how to work with 
the Clipboard to cut, copy, and paste content from one area of a document to another 
area of the same document and from one document to another. 

Resources required 
None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Observe how the teacher uses the Clipboard to cut, copy, and paste text in a 
document and between two documents. 

2. Ask the teacher clarifying questions such as: 

o What types of items can the Clipboard reuse? 
o In which applications can you use the Clipboard? 
o Is the Clipboard always hidden? 

3. Participate in the discussion. 

Try-it: Reuse content with the Clipboard 
 In this leveled try-it activity, you will edit a document with the cut, copy, and paste 

commands and Clipboard panel. 

Try-it 1 
In this try-it, you’ll cut and copy pieces of text in a document. You’ll then paste the text 
elsewhere in the document. 

Resources 
You will need the following resources for this try-it: 

• Open L1_T2_try1_Munsons_featured_staff_profiles_starter.docx in this lesson’s 
Learning Activity Resources. 
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Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Locate the title: Munson’s Pickles and Preserves featured staff in the document. 

2. Cut and paste the text so that it becomes the page title. 

3. Locate the illustration and profile text of Hilary Brennan. 

4. Select the illustration and the following two paragraphs and cut the selection. 

5. Locate the illustration of Eugenia Austin. 

6. Paste into the paragraph immediately preceding the illustration of Eugenia. 

7. Locate the New Intern title and paragraph placeholder text. Copy and paste it 
following the existing intern placeholder text paragraph. 

8. Save and close the document. 

Try-it 2 
In this try-it, you’ll reuse the employee’s profile information already existing in one 
document in the Munson’s newsletter. 

Resources 
You will need the following resources for this try-it: 

• Open L1_T2_try2_Munsons_featured_staff_profiles_starter.docx, 
L1_T2_try2_pickle_camp_starter.docx, and 
L1_T2_try2_Munsons_monthly_newsletter_starter.docx in this lesson’s Learning 
Activity Resources. 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Locate and cut Fernando Vasquez’ profile, which includes an illustration and two 
paragraphs of text from L1_T2_try2_Munsons_featured_staff_profiles_starter 
document. 

2. Navigate to the L1_T2_try2_Munsons_monthly_newsletter_starter document 
Featured Farm Partner section. 

3. Select the paragraph of lorem ipsum placeholder text and paste the Clipboard text. 

4. Navigate to the L1_T2_try2_pickle_camp_starter supporting document and copy 
the entire document to the Clipboard. 
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5. Navigate to the L1_T2_try2_Munsons_monthly_newsletter_starter document 
Pickle Camp section, delete the lorem ipsum placeholder text, and paste the 
content from the Clipboard into this section. 

6. Save and close the documents. 

Wrap-up 
Use these questions to check what you learned in this lesson:  

1. Depending on the configuration of the Clipboard option, which of the following 
methods displays the Clipboard panel?  

Select all that apply. 

a. Select Ctrl+C once 

b. Clipboard dialog box launcher 

c. Font dialog box launcher 

d. Select Ctrl+C twice 

2. Which of the following directions can you move in a document to find and replace 
content?  

Select all that apply. 

a. Up 

b. Down 

c. Left 

d. Right 

3. To replace all instances of a keyword found, you need to select the ________________ 
command. 

Fill in the blank space. 
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4. Which of the following search options can you use for the Replace command? 

Select all that apply. 

a. Match case 

b. Match prefix 

c. Use wildcards 

d. Find whole words only 

 

Additional information 

For more information on finding and replacing text, go to: Find and 
replace text 

For more information on using the Clipboard, go to: Copy and paste 
using the Office Clipboard 

For more information on the Paste Special feature, go to: Paste Special 

  

https://aka.ms/Find_and_replace_text
https://aka.ms/Find_and_replace_text
https://aka.ms/Copy-and_paste_using_the_Office_clipboard
https://aka.ms/Copy-and_paste_using_the_Office_clipboard
https://aka.ms/Paste_Special
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Lesson 2: Collaborating within a 
document 
Overview 
In the previous lesson, you learned how to find and replace specific text and how to 
reuse document content. This was a great start to editing and managing document 
layouts. 

In this lesson, you will learn how to communicate in a document with comments. You 
will also learn how to keep track of the changes as you and others make edits in a 
document. The activities, discussions, and demonstrations in this lesson will give you an 
opportunity to practice the concepts you learn. 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. In which ribbon tab, would you find the Track Changes command? 

Select the correct option. 

a. View 

b. References 

c. Review 

d. Insert 

2. Which command adds a note about specific content within a document? 

Select the correct option. 

a. Text Box 

b. Bookmark 

c. Cross-reference 

d. Comment 
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3. Which command displays all the changes to your document in a list? 

Select all that apply. 

a. Track Changes, Formatting 

b. Track Changes, Insertions, and Deletions 

c. Comments 

d. Ink Comments 

4. Which command includes Reply and Resolve as ways to respond? 

Select all that apply. 

a. Track Changes 

b. Comment 

c. Ink 

d. Insert Caption 

Topic 1: Communicate with comments 
within a document 

 Imagine you are reviewing a document that you and a fellow student are writing 
for a class. If you have a question for the other students about information they wrote, 
you need a way to call this out so that it is not part of the document content but a note 
about the content. 

This is where comments are useful. You can ask a question for clarification, suggest a 
change to the content, make a note to yourself to fact check something, or tell that 
other student what an awesome job they did (provide kudos). 

Attaching your comments to specific parts of a document helps clarify your feedback. If 
someone else is providing feedback by adding comments to the document, you can 
reply to specific comments as well. This enables you to collaborate and have a 
discussion, even when you're not all reviewing the document at the same time, as 
depicted in the following screenshot: 
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Figure 6: Comments 

Add comments 
To add comments, you need to perform the following steps: 

1. Select the content for which you want to provide feedback. 

2. Navigate to the Comments group from the Review ribbon tab, and then select New 
Comment. 

A comment balloon, which is similar to a rectangle, displays a space to enter your 
feedback or comment. If you want to make changes to any of your comments, just 
select the comment balloon, place your cursor inside, and enter the comment. 
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Did you know? 

You can also select Alt+R,C to insert a new comment. 

Move from comment to comment within a 
document 
To observe comments in the order they appear throughout a document, perform the 
following step: 

• Navigate to the Home tab, Comments group, and select Previous or Next. The 
document display will update to show the document contents and the associated 
comment. The following screenshot depicts the Comments group: 

 
Figure 7: Comments group 

Reply to a comment 
To reply to a comment, perform the following step: 

• Go to the comment and select Reply. 

Note: Keep in mind that it's possible for others to edit your comments. The Office 
document stores your comments, so anyone with edit access to your file can edit your 
comment. 

Resolve a comment 
When you no longer need a comment, for example, after you have read and acted on 
the feedback or inquiry, you can resolve it (mark as complete or closed). This doesn’t 
remove the comment, but makes it less visible within the document. 
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To resolve a comment, you need to perform the following step: 

• Go to the comment and select Resolve. 

Note: Resolve only works with the newer document format, .docx. If you are working 
with an older document format, .doc, in compatibility mode, you will need to convert 
the document to the newer format to work with the Resolve command. 

Delete a comment 
To delete a comment, perform the following steps: 

• Right-click the comment (or access the context menu for the comment) and select 
Delete Comment. 

To delete all the comments in the document, perform the following steps: 

• Go to the Review tab, and then from the Delete drop-down list, select Delete 
Comment, and select Delete All Comments in Document. 

 

Did you know? 

Navigate to the File tab and from the Backstage display, select 
Options. From the Navigation panel select General. Enter your 
name as you want it to appear in the Username box. Then check the 
box labeled Always use these values regardless of sign in to 
Office. 

This only changes the name for new comments added, not for 
previously added comments. 

 

 

Additional information 

For more information about collaborating with comments in  
Office 365, go to: Collaborate_with_Comments_in_Office_365 

https://aka.ms/Collaborate_with_comments_in_Office_365
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Did you know? 

Select the text for which you want to comment. Navigate to the 
Review tab and from the Comments section select Ink Comment. 
Use a digital pen (stylus) or other device to write in the ruled line area 
of the comment. Two commands are available in the Comments 
group: Pen to write and Eraser to erase mistakes. The following 
screenshot depicts the ruled area of a comment: 

 

 
Figure 8: Ruled area of a comment 

Activity: Show me how - rewrite 
In this activity, the teacher will demonstrate how to get the feedback, notes, and 
questions from a document, discuss possible solutions, and then list them as comments. 

Resources required 
None 
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Activity instructions 
Participate in the activity by following these instructions: 

1. Examine the document shared by the teacher. 

2. Ask clarifying questions. Here are a few examples: 

o Can I include screenshots and graphics in a comment? 
o Can I copy a comment to the Clipboard so I can reuse it? 
o Can I delete the corresponding content and keep the comment? 

3. Answer questions provided by the teacher. 

4. Offer suggestions to fix the document. 

5. Observe as the teacher demonstrates how to fix the document. 

Try-It: Communicate with comments within a 
document 

 In this leveled try-it, you will add new comments, read comments, reply to 
comments, and delete comments. 

Try-it 1 
In this try-it, you’ll create new comments, observe comments, reply to comments, 
resolve and delete comments.  

Resources 
You will need the following resources for this try-it: 

• Open L2_T1_try1_Munsons_featured_staff_profiles_starter.docx in this lesson’s 
Learning Activity Resources. 

Instructions 
The following are the general tasks to perform during this try-it: 

1. Read each comment from Marcos in the document. 

2. Locate the comment related to the title, Fen Long: Irrigation Engineer. Reply to this 
comment with the following: Yes, she is excited about this college student 
competition and would love to help! Her article is scheduled for a newsletter. 

3. Locate the comment related to Iceland. Marcos mentioned that he inserted this 
comment by mistake. 
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4. Remove the comment. 

5. Locate the comment related to the title, Fernando Vasquez: Beekeeper. Reply to 
this comment with the following: Scheduled for the next newsletter. Then mark the 
comment as resolved. 

6. Go back to the comment you inserted for Fen Long and edit the last sentence to say: 
Her article is tentatively scheduled for a newsletter. 

7. Save and close the document. 

Try-it 2 
In this try-it, you’ll insert a comment, update your display name, and reply to a 
comment. 

Resources 
You will need the following resources for this try-it: 

• Open L2_T1_try2_Munsons_featured_staff_profiles_starter.docx in this lesson’s 
Learning Activity Resources. 

Instructions 
The following are the general tasks to perform during this try-it: 

1. Locate the illustration and profile text for Fen Long's profile. Insert a comment to 
check on the new crop irrigation drone project: Could be a great article for our 
farm friends. 

2. Observe how your name appears in the comment. Update your name as it appears 
for comments to an abbreviated name, such as first name and last name initials or a 
nickname. 

3. Reply to the comment inserted by Marcos for the New Intern Placeholder title. Reply 
with: A request has been made to our graphics team. 

4. Observe how your updated name appears in the comment. 

5. Resolve this comment. 

6. Save and close the document. 
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Topic 2: Track changes 
 Turning on the Track Changes feature gives you and others a way to make 

revisions while editing a document. It's like making suggestions that you can review, 
then remove later, or make them permanent. 

Imagine you are planning a school career fair and you have drafted a “call for sponsors” 
document. Other members of the career fair planning team will access this document 
and make changes to it. With Track Changes turned on, each change will be tracked 
and displayed differently. For example, the tool will track changes to the font size for a 
title, a picture insertion, and a word deletion. These changes will display differently than 
the original content to indicate that these are changes to the original content. 

 

Video 

To review the video about turning on track changes, go to: Track 
changes in Word 

Turn Track Changes on and off 
Turn Track Changes on and off by navigating to the Track Changes command under 
the Review tab. 

When Track Changes is turned on, by default, a strikethrough indicates deletions and 
an underline marks additions. Authors' names and different text colors indicate changes 
made by different authors. 

When it's turned off, Word stops marking changes, but the colored underlines and 
strikethroughs are still in the document. 

 

Did you know? 

You can add Track Changes to the Status Bar, by right-clicking or 
accessing the context menu on it. Locate and select Track Changes. 
The Track Changes icon is displayed on the Status Bar to indicate if it 
is on or off. Select this icon to turn it on or off. The following screenshot 
depicts the Status Bar with Track Changes set on:  

 
Figure 9: Status Bar with Track Changes on 

https://aka.ms/Track_changes_in_Word
https://aka.ms/Track_changes_in_Word
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Keep Track Changes turned on with Lock Tracking 
To prevent someone else from turning off Track Changes, turn on Lock Tracking and 
add a password. With Lock Tracking, anyone opening your document can observe the 
changes but they can't turn off the feature, and they can’t accept or reject changes. 

Turn on Lock Tracking by navigating to the Home tab, Tracking group, selecting the 
Track Changes command, and selecting Lock Tracking. The keyboard shortcut 
Alt+R,G,L also turns on Lock Tracking. Once you select Lock Tracking, choose and enter 
a password. Then select the tab key to move to the confirm password field, enter your 
password again and then select Enter. 

Turn off Lock Tracking 
Turn off Lock Tracking by navigating to the Home tab, Tracking group, selecting the 
Track Changes command, and selecting Lock Tracking. The same keyboard shortcut 
used to lock tracking, Alt+R,G,L, also turns it off. When you turn off Lock Tracking, the 
Unlock tracking dialog box displays where you must enter the password, and then 
select OK. 

Observe suggested changes 
To review the changes in your document, on the Review tab, select Tracking, and then 
select an option from the Display for Review drop-down list. The default setting is All 
Markup. The following table outlines the markup options available in the Display for 
Review drop-down list:  

Simple Markup Indicated by a red line in the margin 
 

All Markup A detailed display of the changes 
 

No Markup A preview of how the document will look if you make all the 
suggested changes permanent 
 

Original A display of the original document without the suggested 
changes 
 

Table 4: Tracking section 



Managing edits and document layouts 

 

 

 
34 

 

Did you know? 

For more information on how to change the track changes color, go 
to: Change the track changes color 

Accept tracked changes 
Even if you turn off Track Changes, there's a possibility that your document has colored 
underlines and strikethroughs, indicating insertions and deletions that were made while 
Track Changes was turned on. 

The markings are available to anyone who chooses All Markup or Simple Markup in 
the Tracking section of the Review tab. 

Remove the markings by accepting or rejecting the changes. Use the buttons in the 
Changes section of the Review tab. The following table outlines the options available in 
the Changes section of the Review tab. 

Previous Takes you from the current change to the previous one in a document. 

Next Takes you from the current change to the next change in the 
document.  

Accept Makes a change permanent. 

Reject Dismisses a change. 

Table 5: Changes section 

Tip: To accept or reject changes all at once, select the arrow on the Accept or Reject 
button, and then select Accept All Changes or Reject All Changes. 

https://aka.ms/Change_the_track_changes_color
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Did you know? 

You can right-click or access the context menu over a tracked change 
and select either the Accept or Reject option from the Changes 
section in the Review tab. If multiple tracked changes are in the same 
content area, select the entire area, right-click or access the context 
menu, and then select Accept or Reject. All the changes are updated 
accordingly. 

 

Additional information 

For more information on sharing a document, co-authoring, and 
tracking changes in Word, go to: Collaborate in Word 

 

Video 

To review the video on accepting tracked changes, go to: Accept 
tracked changes 

Activity: Discuss and learn 
In this activity, your teacher will present a document to the classroom and ask students 
a series of questions about changes to the document. 

Resources required 
None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Observe the document the teacher is presenting. 

2. Think critically about the questions posed by the teacher. 

  

https://aka.ms/Collaborate_in_Word
https://aka.ms/Accept_tracked_changes
https://aka.ms/Accept_tracked_changes
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3. Ask the teacher any clarifying questions you might have. Here are a couple of 
examples: 

o If I email the document as an attachment with Track Changes turned on, will it 
track changes other people make? 

o Can I accept or reject multiple changes at the same time? 
4. Participate in the discussion. 

Try-It: Switch 
  In this standalone try-it activity, you’ll open a document and perform a series of 
track changes tasks for a specific amount of time. When the teacher calls out, “Switch,” 
move to your neighbor’s seat, quickly perform the next set of tasks, continuing from 
what your neighbor had done. Repeat until the teacher calls, “Switch back home.” You 
will then observe the changes made by peers with the help of track changes. 

Resources 
You will need the following resources for this try-it: 

• Open L2_T2_try_September_field_trips_starter.docx in this lesson’s Learning 
Activity Resources. 

Instructions 
The following are the general tasks to perform during this try-it: 

1. Turn Track Changes on for your computer. 

2. Switch to your neighbor’s computer. In the second paragraph of the document, 
change Maple Elementary to the name of your school. Then, in the same sentence, 
change Shelbyville to the name of your town. 

3. Switch to your neighbor’s computer. Change the username for tracked changes to 
your name or nickname. In the second paragraph, change the date to a date your 
school will visit Munson’s. 

4. Switch to your neighbor’s computer. Change the username for tracked changes to 
your name or nickname. Add the following text to the beginning of the document: 
Munson’s Pickles and Preserves Farm Field trips in September. 

5. Switch back home. Change the username for tracked changes back to your name or 
nickname. 

6. Lock tracking with a password of your choice. 
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7. Observe which tracked changes commands are available. 

8. Unlock tracking with the password. 

9. Observe each of the changes made. 

10. Change the Display for Review setting and then review the changes. 

11. Choose to accept or reject each one. 

12. Turn Track Changes off. 

13. Save and close the document. 

Wrap-up 
Use these questions to check what you learned in this lesson: 

1. In which position can you display the Reviewing Pane? 

Select all that apply. 

a. Vertical 

b. Top 

c. Bottom 

d. Horizontal 

2. In which two locations can you change a username that appears in the Track 
Changes listing? 

Select the correct option. 

a. Tracking dialog box 

b. Options, Display 

c. Options, Personalize your copy of Microsoft Office 

d. Page Setup dialog box 
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3. Which choices are available to delete comments? 

Select all that apply. 

a. Delete Previous Comment 

b. Delete Next Comment 

c. Delete All Comments Shown 

d. Delete All Comments in Document 

4. What keyboard shortcut inserts a comment? 

Select the correct option. 

a. Alt+Shift+C 

b. Alt+R+C 

c. Alt+R+S 

d. Ctrl+Shift+E 
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Lesson 3: Managing layouts 
Overview 
In the previous lesson, you learned how to track changes and comment on specific areas 
of a document. These were great additions to learning more about editing and 
managing document layouts. 

In this lesson, you will learn how to display hidden characters, format text in multiple 
columns, and control sections and pages with breaks. The activities, discussions, and 
demonstrations in this lesson will give you an opportunity to practice the concepts you 
learn. 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. Which command displays hidden paragraph marks and other hidden formatting 
symbols? 

Select the correct option. 

a. Outline 

b. Web Layout 

c. Show/Hide  

d. Draft 

2. Which hidden formatting symbol represents a tab character? 

Select the correct option. 

a. Arrow 

b. Paragraph 

c. Dot 

d. Anchor 
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3. Which of following is the correct process to insert a column break? 

Select all that apply. 

a. Select the Layout ribbon, Columns, Two 

b. Select the Ctrl+Shift+Enter keyboard shortcut 

c. Select the Layout ribbon, Breaks, Column 

d. Select the Ctrl+Shift keyboard shortcut 

4. The Insert Page Break keyboard shortcut is ______________________. 

Fill in the blank space. 

5. To which areas can you apply columns, relative to the cursor position within a 
document? 

Select all that apply. 

a. This point forward 

b. Whole document 

c. This section 

d. This paragraph only 

6. The _______________________ indicates that the text following will begin in the next 
column. 

Fill in the blank space. 
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Topic 1: Show/Hide hidden characters 
 When you create or edit a document, you might notice some symbols displayed 

within your text. These are formatting marks, such as dots (for spaces), or arrows (for tab 
characters) in Word. Formatting marks help with the text layout. They do not appear on 
a printed document. The following screenshot depicts the hidden formatting symbols: 

 
Figure 10: Hidden formatting symbols 

A document does not display these characters by default. To show these hidden 
characters, navigate to the Show/Hide command from the Paragraph group, Home 
tab. 

 

Did you know? 

You can display hidden paragraph marks and other formatting 
symbols with the Show/Hide Ctrl+* keyboard shortcut. 

Turn on formatting marks  
To turn on formatting marks to display them on the screen all the time, perform the 
following steps: 

1. Select File.  

2. Select Options from the Backstage display. 
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3. Select Display from the navigation panel. 

4. Under Always show these formatting marks on the screen, select the check box 
for each formatting mark that you always want to display, regardless if you turn on 
or off the Show/Hide Paragraph command in Word. Clear the check boxes for the 
hidden characters that you don't want displayed. 

Activity: Show me how 
This is a teacher-led demonstration about how you can display hidden characters and 
text in a document. 

Resources required 
None 

Activity instructions 
Participate in the activity by following these instructions: 

1. The teacher will demonstrate how to work with the Show/Hide feature to turn on or 
off the hidden symbols and text in a document. 

2. Examine the document projected from the teacher’s computer. 

3. Ask clarifying questions. Here are a couple of examples: 

o Can you delete hidden characters? 
o Can you edit and format a document while displaying the hidden symbols? 

Try-It: Show/Hide hidden characters 
 In this standalone try-it activity, you will work with an existing document and 

display hidden characters and text. 

Resources 
You will need the following resources for this try-it: 

• Open L3_T1_try_Munsons_Pickle_and_Preserves_Cookbook_recipes_starter.docx 
in this lesson’s Learning Activity Resources. 
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Instructions 
The following are the general tasks to perform during this try-it: 

1. Show the hidden paragraph marks. 

2. Answer the hidden text question at the beginning of the document, following the 
title, Munson’s Pickles and Preserves Cookbook. 

3. Locate the extra paragraph marks between the two recipes and remove them. 

4. Hide the paragraph marks and hidden text. 

5. Save and close the document. 

Topic 2: Format text in multiple 
columns 

 So far, you might have noticed that the text in a document stretches across a page. 
But have you noticed how to arrange content in a newspaper? Do you know why you 
arrange text that way? A newspaper uses a multiple-column layout to display more 
short articles on one page. It’s an easier format to read shorter spans of sentences 
versus other types of documents, like lengthy business or school reports. 

The default setting for the text layout in a document is one column that stretches to fit 
the width of the page. This layout works well for documents like letters, resumes, and 
contracts. However, for a newsletter, you will want to set up multiple columns. 

Change the number of columns throughout a 
document 
To change the number of columns in your document, perform the following steps: 

1. Select the Layout tab, Page Setup group, and then select Columns. 

2. Select the option you want or select the More Columns option to set your own 
column format. 
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Change part of document into columns 
To change a part of your document into columns, perform the following steps: 

1. Select the paragraphs you want to change. 

2. Select the Layout tab, Page Setup group, Columns, and then select the option you 
want. 

Adjust columns 
When you add the newsletter style columns to a document, Word automatically sets the 
width of each column to fit your page. If the default formatting doesn’t work for your 
layout, open the Columns dialog box to adjust. The following screenshot depicts the 
Columns dialog box: 

 
Figure 11: Columns dialog box 

Adjust column settings 
To adjust column settings, perform the following steps: 

1. Select the Layout tab, and then select Columns. 

2. Select More Columns. 
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3. In the Columns dialog box, adjust the settings under the Width and spacing section 
to your liking. 

4. If you want columns of varying widths, uncheck the Equal column width check box. 

Control the flow of content with a column break 
By design, text flows automatically from one column to the other in newspaper and 
other layouts. If you need more control with a document, then insert a column break in 
the document. 

Insert a column break 
To insert a column break in your document, perform the following steps: 

1. Place your cursor where you want the column to break. 

2. Select the Layout tab, Page Setup group, and then select the Breaks command. 

3. Select Column from the drop-down list. 

4. Observe the column break. 

5. Select the Home tab, Paragraph group, and then select Show/Hide to review the 
inserted column break. 

 

Did you know? 

You can select Ctrl+Shift+Enter to insert a column break in your 
document. 

Activity: Show me how 
In this activity, your teacher will demonstrate how to modify a single-column document 
into a multiple-columns document. A teacher-driven discussion follows this activity. 

Resources required 
None 
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Activity instructions 
Participate in the activity by following these instructions: 

1. The teacher will demonstrate how to work with columns in a document. 

2. Ask clarifying questions. Here a couple of examples: 

o Does the entire document need the same number of columns and columns 
formatting? 

o Can you apply column formatting to a landscape-oriented document? 

3. Participate in the discussion. 

4. Apply critical thinking when the teacher asks a question. 

5. Respond with an answer to the teacher’s question. 

Try-it: Format text in multiple columns 
 In this leveled try-it activity, you’ll change the one-column paragraphs into two-

column paragraphs with a dividing line and customized spacing in a document. 

Try-it 1 
In this try-it, you’ll open an existing document, and format the first article placeholder to 
change it from one to two columns. 

Resources 
You will need the following resources for this try-it: 

• Open L3_T2_try1_Munsons_monthly_newsletter_starter.docx in this lesson’s 
Learning Activity Resources. 

Instructions 
The following are the general tasks to perform during this try-it: 

1. Observe the one-column text format on both pages of the document. 

2. Show the hidden marks in the document and observe the hidden marks on both 
pages. 

3. Select the title, Seasonal Produce, and the two lorem ipsum text placeholder 
paragraphs that follow the title paragraph. 

4. Make this selection two columns. 

5. Observe the section break after the two-column formatting. 
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6. Turn off the display of hidden marks. 

7. Save and close the document. 

Try-it 2 
In this try-it, you’ll open an existing document and format an article placeholder 
paragraph to separate two columns by a vertical line. 

Resources 
You will need the following resources for this try-it: 

• Open L3_T2_try2_Munsons_monthly_newsletter_starter.docx in this lesson’s 
Learning Activity Resources. 

Instructions 
The following are the general tasks to perform during this try-it: 

1. On page two of the document, select the title CSA and the three paragraphs in the 
section. 

2. Modify the column settings to be two columns wide, with a dividing line and a 
spacing of 0.75”. 

Topic 3: Insert and manage breaks 
 Section breaks divide and format documents of all sizes. For example, you can 

break down sections into chapters and add formatting such as columns, headers and 
footers, page borders, and page numbering to each. You can even choose to number 
the pages later in your document. 

Imagine you have a monthly magazine issue you are putting together and each page 
has a different layout and formatting. By inserting section breaks, you can control the 
formatting for specific areas of each page. Start by inserting a section break before the 
area you intend to change. Set up the formatting change just after the new section 
break. If you want to change formatting again, insert another section break. If your 
changes are on the same page, choose the Continuous section break. Otherwise, 
choose Next Page, Odd Page, or Even Page section breaks. 

If the formatting change occurs in the previous section, select Ctrl+Z and move your 
cursor to after the section break and try it again. 
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Add a section break 
To add a section break in your document, you need to perform the following steps: 

1. Select where you want a new section to begin in your document. 

2. Select the Layout tab, Page Setup group, and select Breaks. 

3. Choose the type of section break you want to insert: 

o The Next Page command inserts a section break and starts a new section on the 
next page. This type of section break is useful to start new chapters in a 
document. 

o The Continuous command inserts a section break and starts a new section on 
the same page. A continuous section break is useful to create format changes 
such as a different number of columns on a page. 

o The Even Page or Odd Page command inserts a section break and starts a new 
section on the next even- or odd-numbered page. To start chapters on an odd or 
even page, use the Odd Page or Even Page section break option. 

Display section breaks 
Section breaks are hidden formatting marks in a document. The easiest way to observe 
where a section break begins and ends in a document is to display all the formatting 
marks in that document. 

To display section breaks in a document, perform the following step: 

• Select the Home tab, Paragraph group, and then select Show/Hide. The following 
screenshot depicts how to display section break in a document: 

 
Figure 12: Section break 
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Change a section break 
To change a section break in a document, perform the following steps: 

1. Select an area with the section you want to change. 

2. Select the Layout tab, and then select the Page Setup dialog box launcher. 

3. Select the Layout tab.  

4. Select a new section type from the Section Start drop down list. 

5. Select OK. 

 

Additional information 

For more information about how to use section breaks to apply 
formatting to parts of a document, go to: 

• Change page orientation to landscape or portrait 
• Insert a header or footer 
• Insert page numbers 
• Create newsletter-style columns 
• Start page numbering later in your document 

Delete a section break 
Before you delete a section break, display it in the document. 

To display a section break in your document, perform the following steps: 

• On the Home tab, in the Paragraph group, select Show/Hide. 

To delete a section break in a document, perform the following steps: 

• Place the cursor before the section break you want to remove, and then select the 
Delete key. 

It’s worth noting that when you delete a section break, Word combines the text before 
and after the break into one section. The new, combined section will use the formatting 
from the section that followed the section break. 

If you want the section to use the formatting, headers, or footers from before the 
section break, use the Link to previous option instead of removing the section break. 

  

https://aka.ms/Change_page_orientation_to_landscape_or_portrait
https://aka.ms/Insert_a_header_or_footer
https://aka.ms/Insert_page_numbers
https://aka.ms/Create_newsletter-style_columns
https://aka.ms/Start_page_number_later_in_your_document
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Insert a page break 
When you insert a page break at a defined page position, that page ends there, and a 
next page begins. 

To insert a page break in a document, perform the following steps: 

1. Place the cursor where you want one page to end and the next to begin. 

2. Select the Insert tab, Pages group, and then select Page Break. 

 

Did you know? 

To insert a line break, use the keyboard shortcut Shift+Enter. To insert 
a page break, use the keyboard shortcut Ctrl+Enter. 

Display a page break 
Page breaks are hidden formatting marks in a document. The easiest way to display 
page breaks in a document is to turn on all the formatting marks. To display page 
breaks in a document, perform the following steps: 

• Select the Home tab, Paragraph group and, then select Show/Hide. The following 
screenshot depicts how to display a page break in a document: 

 
Figure 13: Page break 

Delete a page break 
To delete a page break in a document, perform the following steps: 

1. Select the Home tab, Paragraph group, and then select Show/Hide. 

2. Locate the page break you want to delete, double-click to select the page break, and 
then select the Delete key. 
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Video 

To review the video on page breaks, go to: Insert or remove a page 
break 

Activity: Show me how 
In this activity, your teacher will demonstrate how to insert and manage section breaks 
and page breaks in a document. 

Resources required 
None 

Activity instructions 
Participate in the activity by following these instructions: 

1. The teacher will demonstrate how to insert and manage page breaks and section 
breaks within a document. 

2. Ask clarifying questions. 

3. Apply critical thinking when the teacher asks a question. 

4. Respond with an answer to the teacher’s questions. 

Try-it: Insert and manage breaks 
 In this leveled try-it activity, you’ll open an existing document and insert page and 

section breaks. 

Try-it 1 
In this try-it, you’ll insert a page break. 

Resources 
You will need the following resources for this try-it: 

• Open L3_T3_try1_blueberries_and_balloons_festival_volunteers_starter.docx in 
this lesson’s Learning Activity Resources. 

  

https://aka.ms/Insert_a_page_break
https://aka.ms/Insert_a_page_break


Managing edits and document layouts 

 

 

 
52 

Instructions 
The following are the general tasks to perform during this try-it: 

1. Show the paragraph marks and other hidden symbols. 

2. Observe the document for any section or page breaks. 

3. Insert a page break after the sentence, Let’s work together to make this year’s 
Blueberry and Balloons Festival the best yet. 

4. Observe the page break on page one. Observe the content that was on page one 
that has now moved to page two. 

5. Remove the paragraph mark at the top of page two (preceding the blueberry basket 
image). 

6. Hide the paragraph marks and other hidden symbols. 

7. Save and close the document. 

Try-it 2 
Resources 
You will need the following resources for this try-it: 

• Open L3_T3_try2_blueberries_and_balloons_festival_volunteers_starter.docx in 
this lesson’s Learning Activity Resources. 

Instructions 
The following are the general tasks to perform during this try-it: 

1. Show the paragraph marks and other hidden symbols. 

2. Observe the document for any section or page breaks. 

3. Place the cursor before the blueberry basket image on page two. Insert a section 
break that keeps the information on the same page. 

4. Observe where you added the section break to the document. 

5. Place the cursor before the hot air balloon image on page two. Insert a section break 
that moves the content to the next page. 

6. Observe where you added the section break to the document. 

7. For the blueberry basket section, change the page orientation to Landscape. The 
dialog box prompts: “Some margins are outside the printable area of the page. Try 
moving those margins inside the printable area.” Choose the Fix command. 
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8. Observe the page orientation for all three pages of the document. 

9. Hide the paragraph marks and other hidden symbols. 

10. Save and close the document. 

Wrap-up 
Use these questions to check what you learned in this lesson:  

1. Where can you modify the display settings for formatting marks?  

Select the correct option. 

a. Ease of access, Application display options 

b. File tab, Advanced, Show document content 

c. File tab, Proofing, Exceptions for 

d. File tab, Options, Display 

2. Which hidden formatting symbol represents the space character? 

Select the correct option. 

a. Dot 

b. Paragraph 

c. Arrow 

d. Anchor 

3. The ___________________ command adds a vertical line between columns. 

Select the correct option. 

a. Start new column 

b. Line between 

c. Right 

d. Left 
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4. The _______________________ check box formats columns with an equal width. 

Fill in the blank space. 

5. Which keyboard shortcut inserts a page break? 

Select the correct option. 

a. Ctrl+P 

b. Shift+Enter 

c. Ctrl+B 

d. Ctrl+Enter 

6. _____________________ breaks divide and format documents. 

Fill in the blank space. 
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Lesson 4: Applying styles and 
themes 
Overview 
In this lesson, you will learn how to change the style of headings, titles, and body text by 
applying document style sets. You’ll participate in discussions and step-by-step 
demonstrations, and you’ll have opportunities to put into practice what you learn along 
the way. 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. Which command changes the font and paragraph formatting of an entire document? 

Select the correct option. 

a. Themes 

b. Style set  

c. Paste Special 

d. Style 

2. Where is the Quick Style sets gallery located? 

Select the correct option. 

a. Home tab, Styles group 

b. Design tab, Document Formatting group 

c. Layout tab, Page Setup group 

d. Insert tab, Pages group 

  



Managing edits and document layouts 

 

 

 
56 

3. What is the name of the default theme for a document? 

Select the correct option. 

a. Ion 

b. Organic 

c. Office 

d. Wisp 

4. Which command uses a unique set of colors, fonts, and effects to create a consistent 
look? 

Select the correct option. 

a. Styles 

b. Style sets 

c. Format Painter 

d. Themes 

Topic 1: Apply a style set 
 Think about all the diverse types of content you read every day: books, articles, 

social media posts, emails, text messages, and more. Each of these has its own way of 
conveying information based on text and paragraph formatting and other elements like 
emojis. For example, a book has a cover page with a specific heading format, chapter 
headings format, and paragraphs with a specific format. You can consider each of these 
components to be individual styles. Collectively, it’s known as a style set. An outer space, 
science fiction book might have futuristic artwork. The text and paragraph styles need to 
complement this. The proper style set can do this by updating all existing title, heading, 
normal, list, and other styles at the same time. An historical, non-fiction book might use 
a different style set to help convey the old-world information. 

Word provides a set of styles that work together. Each Quick Style set might include 
styles for several heading levels, body text, quotes, and titles that work together in a 
single document. 
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To apply a Quick Style set, perform the following steps: 

1. Select the Design tab, Document Formatting group, and then in the Style gallery 
area select the More arrow. 

2. Then choose a Quick Style set such as Basic (Elegant) or Modern. 

After making a Quick Style selection, select the Home tab, and then the Styles group, 
the gallery contextually changes based on the Quick Style set selected. You can use all 
the styles in the gallery to build your document. 

 

Did you know? 

You can observe how a Quick Style set will display in a document by 
pointing the mouse cursor to a Quick Style set without selecting it. 
This is known as a live preview. Once you find a Quick Style that you 
like, select the style to apply it to the document. The following 
screenshot depicts the Quick Style set Gallery: 

 
Figure 14: Quick Style set Gallery 
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Figure 15: Quick Style Gallery 

It’s worth noting that a Quick Style set reflects styles that you applied in a document. 
For example, if all the headings in a document have Heading 2 styles applied, the Quick 
Style set will apply a Heading 2 style. The Quick Style set does not fix formatting errors. 

 

Did you know? 

You can save a document style for use in another document. Select 
the Design tab, Quick Style set Gallery, and right-click or access the 
context menu on the Quick Style set you want to save. The Save 
dialog box opens. Enter a name for the style set and select Save. 

Activity: Discuss and learn 
In this activity, you’ll participate in a teacher-led group discussion on how to change the 
document style by applying a different style set. 

Resources required 
None 
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Activity instructions 
Participate in the activity by following these instructions: 

1. Ask the teacher clarifying questions. 

2. Participate in the discussion. 

3. Apply critical thinking and answer the teacher’s questions. 

Try-it: Apply a style set 
 In this standalone try-it, you’ll open an existing document and apply a style  

set to it. 

Resources 
You will need the following resources for this try-it: 

• Open L4_T1_try_Munsons_featured_staff_profiles_starter.docx in this lesson’s 
Learning Activity Resources. 

Instructions 
The following are the general tasks to perform during this try-it: 

1. Navigate to the Document Style gallery. 

2. Hover over each style and observe the changes made to the document’s style. 

3. Select the Minimalist style set. 

4. Save and close the document. 

Topic 2: Apply themes 
 A theme uses a unique set of colors, fonts, and effects that complement each other 

to create a consistent design. 

Imagine you are playing your favorite video game, moving through an amusement park, 
or visiting a clothing store. Each of these typically has a theme, or a design, that sets the 
stage for how you might perceive the space you are in. Think of a document as a stage 
where you get to choose which theme you want to apply to an entire document. A 
school report might have a very different theme than a book launch party poster. Word 
includes a gallery of pre-built themes that you can apply to a document. The following 
screenshot depicts the pre-built themes gallery available in Word: 
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Figure 16: Pre-built themes gallery 

To apply a theme in a document, perform the following steps: 

1. Select the Design tab and select the Themes command. 

2. The gallery of pre-built themes displays. Office is the default theme. Note the names 
of the other themes. 

3. Point to a theme to preview it and select the theme of your choice. 
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Note: Once you apply a theme, specific components like colors, fonts, paragraph 
spacing, and effects can be customized. The following screenshot depicts the individual 
theme commands: 

 
Figure 17: Individual theme commands 

To modify a theme component, perform the following steps: 

1. Select the Design tab and select the appropriate component: Colors, Fonts, 
Paragraph Spacing, or Effects. 

2. Select a choice from the dropdown list. 

To return to the original theme of a document template, perform the following steps: 

1. Select the Design tab and select the Themes command. 

2. Select Reset to Theme from template. 

 

Did you know? 

You can change a theme and make it the default in Word or Excel. 

For more information on changing a theme and making it the default 
for new documents, go to: Change a theme and make it the default in 
Word or Excel 

Activity: Show me how 
In this activity, the teacher will discuss and demonstrate how to apply a new document 
theme to a document. 

Resources required 
None 

  

https://aka.ms/Change_a_theme_and_make_it_the_default_in_Word_or_Excel
https://aka.ms/Change_a_theme_and_make_it_the_default_in_Word_or_Excel
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Activity instructions 
Participate in the activity by following these instructions: 

1. Observe how the teacher applies a new theme to a document. 

2. Ask clarifying questions. 

3. Apply critical thinking when teacher asks a question. 

4. Respond with an answer to the teacher’s questions. 

Try-it: Apply themes 
 In this standalone try-it activity, you’ll open an existing document and apply a 

different theme to the document. 

Resources 
You will need the following resources for this try-it: 

• Open L4_T2_try_Munsons_featured_staff_profiles_starter.docx in this lesson’s 
Learning Activity Resources. 

Instructions 
The following are the general tasks to perform during this try-it: 

1. Observe the style set and theme applied to the document. 

2. Observe the current paragraph spacing applied to the document. 

3. Change the paragraph spacing to relaxed. 

4. Observe the updated paragraph spacing applied to the document. 

5. Save and close the document. 
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Wrap-up 
Use these questions to check what you learned in this lesson: 

1. Which method saves the current style set for use in another document? 

Select the correct option. 

a. Right-click or access the context menu, and then select Save 

b. Select Ctrl+S 

c. Save as a new style set 

d. Select F12 

2. Which of these document components changes when you apply a theme? 

Select the all that apply. 

a. Effects 

b. Fonts 

c. Pictures 

d. Colors 

3. Which command should you use if you need to change a style set back to the 
original style set? 

Select the correct option. 

a. Replace 

b. Reset to 

c. Clear All Formatting 

d. Undo 

4. Themes and style sets are on the _________________________tab. 

Fill in the blank space. 
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Glossary 
The following table defines the key terms used in the module. 

Clipboard A list of all items copied to the Clipboard. Also, the name of a group 
on the Home tab which consists of the Cut, Copy, Paste, Paste 
Special, and Format Painter commands 

Column Edge-to-edge spacing for text and other content to appear on a 
document page. The default setting is one column. You can apply 
multiple columns.  

Column break A mark to indicate where text ends in one column and begins in the 
next column 

Comment A note about specific content within a document 

Copy Places a copy of a selection of content on the Clipboard for pasting 
somewhere else later 

Cut Removes a selection of content and places it on the Clipboard for 
pasting later 

Formatting Symbol A hidden character that indicates formatting within a document such 
as an indentation, space, or carriage return 

Lorem ipsum Placeholder text used to demonstrate the form of the document 
without real content. Enter =lorem() to insert five paragraphs of text 
with varying sentence lengths. 

Page break Marks the point at which a page ends and another begins 

Page Setup Margins, paper, and layout settings 

Password A secret word or phrase to unlock and lock access to a computer 
system, file, or service 

Paste Adds the most recently placed content on the Clipboard to your 
document 
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Paste Special Adds the most recently copied content with specific paste 
parameters to your document 

Replace Search for text and replace it with something else 

Section break Marks the point at which a new section of content begins 

Style set A set of font and paragraph properties of an entire document 

Styles Specific text formatting that you can apply to individual paragraphs, 
titles, headings, lists, and other text 

Themes A unique set of colors, fonts, and effects that you can apply to a 
document 

Track Changes Keeps track of changes made to a document 

Table 6: Glossary terms and definitions 
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Cornerstone 
Overview 
In this cornerstone, you will edit the summer camp application form by finding, 
replacing, and reusing text and images. You will keep track of others’ edits, collaborate 
with them, and update the document’s layout and style. 

Objectives 
The following table outlines the Cornerstone objectives and their corresponding 
Microsoft Office Specialist (MOS) exam objectives. 

Find, replace, and 
reuse text and 
images. 

• 1.1.1: Search for text 
• 2.1.1: Find and replace text 

Communicate by 
using comments 
and tracked 
changes. 

• 6.1.1: Add comments 
• 6.1.2: Review and reply to comments 
• 6.1.3: Resolve comments 
• 6.1.4: Delete comments 
• 6.2.1: Track changes 
• 6.2.2: Review tracked changes 
• 6.2.3: Accept and reject tracked changes 
• 6.2.4: Lock and unlock change tracking 

Change page 
layouts and insert 
section breaks. 

• 1.1.4: Show and hide formatting symbols and hidden text 
• 2.3.1: Format text in multiple columns 
• 2.3.2: Insert page, section, and column breaks 
• 2.3.3: Change page setup options for a section 

Change the style 
set and theme. 

• 1.2.2: Apply style sets 

Table 7: Cornerstone objectives 



Managing edits and document layouts 

 

 

 
67 

Duration 
50 minutes 

Instructions 
1. Complete the following tasks for each file. 

2. When saving your file, add your name to the end of the filename, like this: 
“Cornerstone_Application_Form_Dwayne_Espino.” Follow your teacher’s directions for 
where to save your documents. 

3. When you’re done with the Cornerstone, assess your work and enter the points you 
think you earned within the following task lists. Ask for help as needed. 

Tasks 
You will work with two files in this Cornerstone. The following are the tasks within each 
file. 

File 1: Cornerstone_hackathon_rules_starter.docx 
Task: Unlock and observe track changes (2 points) 
1. Open Cornerstone_hackathon_rules_starter.docx and unlock the change tracking 

with this password: Hackathonsarefun!:). (1 point) (Exam objective 6.2.4) 

2. Observe all tracked changes throughout the document. (1 point) (Exam objective 
6.2.2) 

Points scored: ______ / 2 

Task: Accept and turn off track changes (2 points) 
1. Reject the inserted word change, Agriculture added to the Hackathon Rules title. 

Accept the changes to the words, all and code. (1 point) (Exam objective 6.2.3)  

2. Turn track changes off. (1 point) (Exam objective 6.2.1) 

Points scored: ______ / 2 
  



Managing edits and document layouts 

 

 

 
68 

Task: Insert and review comments (2 points) 
1. Select the title, Submissions will be judged on, and insert the following comment: 

Should we add this to the list - only the categories defined when submitted? (1 
point) (Exam objective 6.1.1) 

2. Review all comments in the document. (1 point) (Exam objective 6.1.1)  

Points scored: ______ / 2 

Task: Reply, resolve, and delete comments (3 points) 
1. Navigate to the comment from Marcos Serna that says: Please confirm time and 

update as needed. Reply with a comment that says: Confirmed with Fen L. (1 
point) (Exam objective 6.1.2) 

2. Resolve the comment made in the previous step: Confirmed with Fen L. (1 point) 
(Exam objective 6.1.3) 

3. Delete the comment from Marcos Serna: Age requirement confirmed. Once you 
have read this feel free to delete. (1 point) (Exam objective 6.1.4)  

Points scored: ______ / 3 

Task: Find and replace text (2 points) 
1. Find the text programmers and replace it with developers. (1 point) (Exam objective 

2.1.1) 

2. Find the text ads and replace it with advertisements. (1 point) (Exam objective 2.1.1) 

Points scored: ______ / 2 

FILE 1 TOTAL POINTS: ______ /11 

File 2: 
Cornerstone_hackathon_promotion_starter.docx 
Task: Apply a style set (3 points) 
1. Apply the Basic (Simple) style set to the document. (1 point) (Exam objective 1.2.2) 

2. Apply the Arial font to the style set. (1 point) (Exam objective 1.2.2) 

3. Apply the Relaxed Paragraph Spacing to the style set. (1 point) (Exam objective 
1.2.2) 

Points scored: ______ / 3 
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Task: Show hidden characters and insert breaks (3 points) 
1. Display the hidden characters in the document. (1 point) (Exam objective 1.1.4)

2. Insert a text-wrapping break before the first paragraph that begins with the phrase:
Munson’s Pickles and Preserves Farm. Insert a text-wrapping break. (1 point)
(Exam objective 2.3.2)

3. Insert a continuous section break before the section title, Prize Money. (1 point)
(Exam objective 2.3.2)

Points scored: ______ / 3 

Task: Format text in multiple columns (3 points) 
1. Format the paragraphs after the section break into two columns. (1 point) (Exam 
objective 2.3.1)

2. Change column spacing to 0.8”. (1 point) (Exam objective 2.3.1)

3. Hide hidden characters. (1 point) Exam objective 1.1.4)

Points scored: ______ / 3

FILE 2 TOTAL POINTS: ______ /9
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Module overview 
Description 
An old axiom states that a picture is worth a thousand words. Microsoft Word has 
powerful tools you can use to create interesting and effective documents. When you 
add elements such as pictures, shapes, and SmartArt graphics to a document, your 
message becomes easier to communicate to your audience. In this module, you’ll learn 
how to insert and format these elements to make your document more interesting and 
to emphasize specific information. 

On the Insert tab, the Illustration group includes the six commands you’ll learn about 
in this module. You’ll start by inserting and modifying shapes, including inserting text 
into these shapes. Then, you’ll insert and format pictures, create SmartArt diagrams to 
depict processes and flowcharts, insert icons such as smiley faces, and use screenshots 
to display parts of a page from another document. 

The following table outlines the lessons in this module that will help you learn these 
skills through discussions, demonstration-based activities, and try-it exercises, including 
a task-based Cornerstone project that will give you the opportunity to apply what you 
have learned. 

Lesson Learning objective Exam objectives 

Inserting and 
formatting shapes 

• Insert and format two-dimensional 
(2D) shapes and three-dimensional 
(3D) models 

• 5.1.1 
• 5.1.3 
• 5.2.4 
• 5.2.6 
• 5.3.2 

Inserting and 
formatting 
pictures 

• Insert and format pictures • 5.1.2 
• 5.2.1 
• 5.2.2 
• 5.2.3 
• 5.4.1 

Creating diagrams 
via the SmartArt 
feature 

• Insert and format SmartArt graphics • 5.1.4 
• 5.2.5 
• 5.3.3 
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Depicting 
information by 
using icons and 
screenshots 

• Insert icons, screenshots, screen 
clippings, symbols, and special 
characters, and format the icons 

• 5.1.5 
• 2.1.2 

Adding text boxes 
and alternative 
text 

• Place and modify text boxes and 
objects that have text, add alternative 
text for objects, and resolve 
accessibility errors and warnings 

• 5.1.6 
• 5.3.1 
• 5.4.1 
• 5.4.2 
• 5.4.3 

Cornerstone: 
Cookbook Launch 
Party 
Announcement 

• Insert and modify text boxes 
• Insert alternative text for objects 
• Resolve accessibility errors and 

warnings 
• Insert and format SmartArt graphics 
• Format pictures 
• Insert 3D models 

• 5.1.3 
• 5.1.4 
• 5.1.6 
• 5.2.1 
• 5.2.2 
• 5.2.3 
• 5.2.5 
• 5.2.6 
• 5.3.1 
• 5.3.3 
• 5.4.1 
• 5.4.2 
• 5.4.3 

Table 1: Objectives by lesson 

Scenario 
Munson’s Pickles and Preserves Farm supports a local Community Supported 
Agriculture (CSA) project. This CSA project allows community members to become farm 
members and purchase shares of the produce to feed their families. 

As part of this project, Munson’s is writing a farm-to-table cookbook to support the 
summer camp scholarship fund. A fellow colleague has collected the favorite fall recipes 
of farm members. Munson’s needs your help with adding graphics for these recipes in 
the cookbook and with creating flyers promoting the Cookbook Launch Party. Here’s a 
great chance for you to use your artistic ideas with the fun design tools in Word! 
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Cornerstone 
Munson’s farm-to-table cookbook, which will support the summer camp scholarship 
fund, is finally ready to be published. It’s now time to plan the Cookbook Launch Party. 

You’ve been asked to create flyers to promote the party. You’ll need to insert shapes, 
pictures, text boxes, SmartArt graphics, and 3D models and apply formatting to each 
object. You’ll also remove the background from a picture, display specific views of a 3D 
model, manage the text flow around objects by using Wrap Text, and apply alternative 
text to all objects in the flyer. 

The lessons and topics in this module will facilitate your success in this Cornerstone. 
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Lesson 1: Inserting and 
formatting shapes 
Overview 
In this lesson, you’ll learn to insert and format shapes to represent information in your 
documents in an alternative way. You’ll add text to these shapes and then modify this 
text. You’ll also add amazing 3D models to a document and learn to use the 3D control 
both to rotate models up to 360 degrees and to tilt them up and down to display a 
specific feature. 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. Which tab would you select on the ribbon to insert a shape? 

Select the correct option. 

a. Home 

b. Draw 

c. Insert  

d. Design 

2. Which of the following is an incorrect method for adding text to a shape? 

Select the correct option. 

a. Select the shape, and then enter the text. 

b. Right-click or access the context menu of the shape, select Edit Text, and then 
enter the text. 

c. Right-click or access the context menu of the shape, select Add Caption, and 
then enter the text. 

d. Select text in a document, select Ctrl+X to cut the text or Ctrl+C to copy to the 
Clipboard, select the shape, and then select Ctrl+V to paste the text into the 
shape. 
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3. When you select a shape, small circles called sizing handles become available on 
each side and each corner of the shape border. List three things you can do with 
these sizing handles. 

Fill in the blank spaces. 

 

 

 

4. After you insert a 3D model, which of the following can’t you apply to the model? 

Select the correct option. 

a. Model color saturation and tone 

b. Model size 

c. Model rotation 

d. Model background fill 

Topic 1: Insert and modify shapes 
 Word supplies many shapes for you to choose from, such as lines, rectangles, 

arrows, equation shapes, callouts, stars, and banners. You add these shapes from the 
Insert tab on the ribbon, in the Illustrations group. Inserting a shape in a document 
automatically opens the Drawing Tools Format contextual tab. You can use this tab to 
apply styles, a shadow, or a 3D effect or to arrange the shape on the page and resize it. 
Begin by navigating to the Insert tab, finding the Illustrations group, and then 
selecting Shapes, as the following figure depicts. 
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Figure 1: Shapes on the Insert tab 

Understand the Shapes menu 
After you select Shapes, a menu displays with all the available shape categories. These 
categories include Lines, Rectangles, Basic Shapes, Block Arrows, Equation Shapes, 
Flowchart, Stars and Banners, and Callouts. The menu also includes Recently Used 
Shapes if applicable.  

Here are the steps to insert a basic shape from the Shapes menu: 

1. Place your cursor where you want to insert the shape in the document. 

2. On the Shapes menu, select the shape of your choice. 

3. Drag the mouse or other input pointer to draw the shape to the size you want. 

 

Did you know? 

To create a perfect square or circle (or to constrain the dimensions of 
other shapes), use the sizing handles that become available when you 
select the shape. Select these sizing handles, select and hold the Shift 
key, and then drag the circles or handles. Try this out at home. 
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Understand the Drawing Tools Format tab 
You can resize and format a shape at any time by using the contextual Drawing Tools 
Format tab, as the following screenshot depicts. 

 
Figure 2: The Drawing Tools Format tab 

The Drawing Tools Format tab has the following groups: 

• Insert Shapes. Insert another shape or change the currently inserted shape to a 
different shape. 

• Shape Styles. Quickly apply a style to the selected shape by selecting a built-in style; 
change the shape’s fill and outline; and apply shape effects, such as a shadow or 
reflection. 

• WordArt Styles. Apply text effects to selected text included in the shape. 
• Accessibility. Display the Alt Text pane, where you can add a description of the 

object and its context for screen reader users. 
• Arrange. Use options for positioning shapes, wrapping text, layering shapes (to 

bring shapes forward or send them backward), displaying the Selection pane (where 
you can quickly select objects), and aligning objects. 

• Size. Adjust the height and width of the shape. 

 

Additional information 

For more information, refer to: Add shapes 

Activity: Demonstrate the feature 
In this activity, the teacher will demonstrate how to insert a shape and then modify it by 
using the Drawing Tools Format contextual tab. 

Resources required 
None 

  

https://aka.ms/Add_shapes
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Activity instructions 
Participate in the activity by following these instructions: 

1. Observe the demonstration to understand how to insert and modify shapes in Word. 

2. Interact with the teacher and ask clarifying questions, such as: 

a. What types of shapes can I add in Word? 

b. What’s the most efficient way to insert a shape with all sides equally sized? 

c. What’s the Quick Style gallery? 

d. How do I format a shape, such as change the colors and the size? 

Try-it: Insert and modify shapes 
 In this leveled try-it, you’ll work with shapes and have fun with them. 

Try-it 1 
In this try-it, you’ll insert multiple shapes of your choice into a blank document in a 
creative way. Test yourself by trying to resize the shapes by using your mouse or other 
input device and by applying effects. Share your creativity with your neighbor. 

Resources 
None 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Insert three different shapes of your choice into a new Word document. Share your 
work with the teacher before continuing to the next step. 

2. Resize and change the position of any two shapes by using your mouse. 

3. Apply a style and a 3D effect to any one shape. 

4. Apply different shadow effects to the other shapes. 

5. Save the file as My_shapes.docx, and then close the document. 
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Try-it 2 
In this try-it, you’ll build a flowchart for a straightforward process of your choice by 
using shapes in the Flowchart and Lines categories. 

Resources 
None 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Insert any five shapes of your choice from the Flowchart category. 

2. Insert lines to connect all the shapes to each other. 

3. Resize any two of the shapes. 

4. Move any two of the shapes to a new location in the document. 

5. Apply a 3D Rotation shape effect to one of the shapes. 

6. Apply different Shadow effects to the other shapes. 

7. Save the document as My_process.docx, and then close the document. 

Try-it 3 
In this try-it, you’ll use the available shapes and follow the instructions to complete the 
process flow from crop management to crop assembly, and then to the movement of 
crops to the cleaning plant, and finally to the truck for transportation. 

Resources 
You’ll need the following resource for this try-it: 

• L1_T1_try3_flowchart_starter.docx in this lesson’s Learning Activity Resources 
folder 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Make a copy of the final stage of the workflow, Transport with Trucks. 

2. Change the text in this copy to Farmer’s Market and Grocery Store. Ask for your 
teacher’s help with this step if needed. 

3. Change the shape color of the Farmer’s Market and Grocery Store shape to 
Intense Effect - Green, Accent 6. 
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4. Insert lines with arrows between the shapes to indicate the flow of the process. 

5. Change the Crop Management shape to a Cloud shape. 

6. Change the Crops to Cleaning Plant shape to a Diamond shape. 

7. Apply the Perspective Upper Right shadow effect to all shapes. 

8. Save and close the document. 

 

Did you know? 

To apply the same formatting to multiple objects, select the 
formatted shape, double-click the Format Painter, and then select 
each shape to apply the formatting. 

Topic 2: Add and modify text in shapes 
 Word makes it easy to insert text into shapes which, as you might know, is helpful 

when you’re creating flowcharts and diagrams: 

• To add text to a shape in a document, do one of the following: 
o Select the shape, and then enter the text. 
o Right-click or access the context menu of the shape, select Edit Text, and then 

enter the text. 
• You can format the text you entered by using the Font and Paragraph groups on 

the Home tab or by using the Text Effects and WordArt Styles options on the 
contextual Drawing Tools Format tab, as the following screenshot depicts. 

 
Figure 3: The Shape Styles and WordArt Styles groups 

• Note that the Drawing Tools Format contextual tab corresponds to the shape, so 
it’s available only when the shape is selected. Therefore, to make any changes to the 
shape, you need to first select it to display the tab. 
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Understand the Arrange group on the Drawing 
Tools Format tab 
The Drawing Tools Format tab also has an Arrange group with several options to help 
you format the text: 

• Position. Decide where to display the object on the page. 
• Wrap Text. Decide how text will wrap, or flow, around the selected object. 
• Bring Forward. Bring the selected object forward one level. This is just like 

rearranging a sheaf of paper. 
• Send Backward. Send the selected object backward one level. 
• Selection Pane. Get a list of all the objects in the document. 
• Align. Decide where to display the selected object on the page. This is like aligning a 

paragraph. 
• Group Objects. Join objects together so you can then move and format them as one 

object. 
• Rotate Objects. Rotate the object to the right or the left by 90 degrees or flip the 

selected object vertically or horizontally. 

 

Did you know? 

To move multiple shapes in a document at the same time, select the 
first shape, select the Ctrl key, and then select the other shapes. 
Doing so temporarily groups the shapes together. You can then 
select the group and simultaneously move all the shapes. 

Activity: Demonstrate the feature 
In this activity, the teacher will share a picture, ask you questions, and then demonstrate 
how to add and modify text in shapes. 

Resources required 
You need the following resource for this activity: 

• L1_T2_act_whats_the_story_starter.docx in this lesson’s Learning Activity 
Resources folder 
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Activity instructions 
Participate in the activity by following these instructions: 

1. Examine the picture in the document. 

2. Try to answer the teacher’s questions about this picture. 

3. Observe the demonstration by the teacher. 

4. Interact, engage, and ask questions such as: 

a. How do I add text to a shape and a picture? 

b. How can I arrange multiple shapes and pictures in a document? 

c. What’s the shortcut key to send a picture backward? 

Try-it: Add and modify text in shapes  
 In this leveled try-it, you’ll select a shape, modify the shape, and add text inside the 

shape. 

Try-it 1 
In this try-it, you’ll create a new welcome sign by using the Rectangle shape and adding 
text to it. 

Resources 
None 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Open a new Word document. 

2. Insert a Rectangle shape. 

3. Resize the rectangle to 4 inches (or 10.16 centimeters) high by 8 inches (or 20.32 
centimeters) wide. 

4. Center the rectangle on the page. 

5. Enter the text Welcome to Our Farm in the shape. 

6. Format this text with a font color of Black, a font size of 36, and a font style of Bold. 
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7. Save the file as Welcome_sign_draft_1_your name.docx in your student folder. 

8. Share your work with the teacher, and if advised, keep your file open to work on the 
next try-it. 

Try-it 2 
In this try-it, you’ll modify an existing welcome sign according to specifications, 
formatting it to match the branding of Munson’s Pickle and Preserves Farm. 

Resources 
You’ll need the following resource for this try-it: 

• L1_T2_try2_welcome_sign_starter.docx in this lesson’s Learning Activity 
Resources folder 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Select the rectangle, and then make the following changes to this shape: 

a. Outline: Dark blue, 6 pt 

b. Shape color: Light blue 

2. Insert a vertical, 5-inch (or 12.7-centimeter) line on top of the rectangle. 

3. Center this line in the rectangle, and then extend it so it goes beyond both sides of 
the rectangle. 

4. Change the line color to Orange. 

5. Change the width of the shape outline to 6 pt. 

6. Position the line so it displays as if it’s a stand for your sign. 

7. Use Send Backward to send the line behind the rectangle. 

8. Save the file as Welcome_sign_final.docx in your student folder. 

Topic 3: Insert and format 3D models 
 Use 3D models to add pizzazz to your documents. After you add a 3D model, you 

can use the 3D Model Tools Format contextual ribbon tab to format the model in 
different ways: you can rotate (or tilt) the model up or down to get different angles of 
the picture, apply alternative text to the model, and resize and position the model on 
the page. 
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Insert a 3D model 
To insert a 3D model, perform the following steps: 

1. Place your cursor where you want Word to insert the 3D model into the document. 

2. On the Insert tab, select 3D Models, and then select the 3D model you want. 

Search for 3D models 
Use the Search box, as the following screenshot depicts, to quickly find what you want. 

Figure 4: The Search box for 3D models 

Understand the 3D Model Tools Format tab 
The 3D Model Tools Format tab has the following commands for formatting the 3D 
model: 

• Adjust. Lists commands for inserting another 3D model and for resetting a 
formatted 3D model to its original state. 

• 3D Model Views. Opens the Format 3D Model pane with commands to change the 
background fill color and the outline of the model, apply effects such as reflections 
and 3D formatting to the model, and rotate the model. 

• Alt Text Accessibility. Opens the Alt Text pane so you can add text descriptions of 
objects for screen readers. 

• Arrange Group. Supplies commands to position the model on the document page, 
control how text wraps around the model, bring the model forward one level, send 
the model backward one level, open the Selection pane for observing a list of 
objects, align objects, and group objects. 

• Size Group. Supplies commands to pan and zoom in on the selected model to focus 
on a specific area of the model and to adjust the height and width of the model. 
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Did you know? 

You can use the 3D model images available in Microsoft Office to 
print 3D objects on a 3D printer. If you’re interested in learning how 
to create or edit 3D files, use 3D Builder, which is a free Windows 
application available from the Microsoft Store. 

 

Additional information 

For more information about working with 3D models, refer to 3D 
Models in Office. 

Activity: Show and tell 
In this activity, the teacher will demonstrate how to insert and format a 3D model image 
in a document and then ask you to pair up with a classmate for specific tasks. 

Resources required 
None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Observe the teacher demonstrate how to insert and format a 3D model image. 

2. Interact, engage, and ask questions during the demonstration. 

3. Pair up with a classmate as directed by the teacher, and then follow the instructions 
given. 

4. Reach out to your teacher for help for the paired-up part of this activity. 

Try-it: Insert and format 3D models 
 In this leveled try-it, you’ll insert and modify 3D model images in a document to 

wow your audience! 

  

https://aka.ms/3D_Models_in_Office
https://aka.ms/3D_Models_in_Office
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Try-it 1 
In this try-it, you’ll insert a 3D image of your choice that’s related to farming and 
agriculture and then format the image as specified. 

Resources 
You’ll need the following resource for this try-it: 

• L1_T3_try1_Farm-to-Table_Cookbook_starter.docx in this lesson’s Learning 
Activity Resources folder 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Insert a 3D tractor image from the Online 3D Models window into the document 
where indicated. 

2. Rotate the image so the view is from the top. 

3. Rotate and tilt the 3D model by 180 degrees. 

4. Save and close the document. 

5. Reach out to the teacher if you have time to spare. You can try the next try-it by 
using your current document. 

Try-it 2 
In this try-it, you’ll insert a 3D model image into a document and then paste the same 
image to another location with a different view. 

Resources 
You’ll need the following resource for this try-it: 

• L1_T3_try2_Farm-to-Table_Cookbook_starter.docx in this lesson’s Learning 
Activity Resources folder 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Copy the 3D image on page 1, and then replace the placeholder text, which is 
[Insert copy of 3D Tractor image], with the copy. 

2. Change the 3D model views of the images so two views exist: a top view and a 
bottom view. 

3. Save and close the document. 
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Wrap-up 
Use these questions to check what you learned in this lesson: 

1. When you’re working with two shapes, and one is layered in front of the other, what 
should you do to move the shape in front toward the back? 

Select the correct option. 

a. On the Align menu, select Backward 

b. On the Position menu, select Behind 

c. On the Wrap Text menu, select Behind shape 

d. Select Send Backward 

2. How can you insert a perfect circle by using the keyboard? 

Select the correct option. 

a. Select and hold the Ctrl key, and then drag the shape 

b. Select and hold the Alt key, and then drag the shape 

c. Select and hold the Shift key, and then drag the shape 

d. Use the mouse to drag the shape 

3. On the Design tab, which of the following can you use to format shapes and text 
with specific colors and fonts? 

Select the correct option. 

a. Document Formatting 

b. Themes 

c. Colors 

d. Fonts 
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Lesson 2: Inserting and 
formatting pictures 
Overview 
In this lesson, you’ll learn to insert and format pictures to better communicate the 
message of your document. The activities and discussions in this lesson will give you an 
opportunity to practice what you learn about inserting and formatting pictures. 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. Where on the Picture Tools Format tab would you find the command to change the
contrast and brightness of a picture?

Select the correct option.

a. Picture Effects

b. Artistic Effects

c. Corrections

d. Color

2. Which of the following is a reason to remove the background from a picture?

Select all that apply.

a. To accent the subject matter

b. To remove unwanted elements

c. To remove distracting details

d. To make the picture background transparent
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3. You’re working with pictures in your document, but the Picture Tools Format tab 
doesn’t display. Why isn’t the tab available? 

Select all that apply. 

a. The picture exists in the document header. 

b. The picture resides behind another object. 

c. You forgot to save the document. 

d. The picture isn’t selected. 

Topic 1: Insert and format pictures 
 In this topic, you’ll learn how to insert pictures and then format them by changing 

the contrast and brightness of the pictures; changing the color tone and saturation; and 
applying artistic effects, such as Chalk Sketch. You can also apply Quick Styles to add a 
border or 3D effect. 

To insert a picture, perform the following steps: 

1. Place your cursor in the document where you want to insert the picture. 

2. On the Insert tab, select Pictures. 

3. Navigate to the folder that has the picture you want, and then select the picture. 

4. Note that after you insert a picture into the document, you can use the Picture 
Tools Format tab, as the following screenshot depicts, to format and modify the 
picture. 

 
Figure 5: The Picture Tools Format tab 

Understand the Picture Tools Format tab 
The Picture Tools Format tab has the following groups and commands: 

• Remove Background. Removes unwanted or unnecessary portions of the picture. 
Use these options to remove the background of a picture, mark areas of the picture 
to remove, or mark areas of the picture to keep. 

• Adjust. Sharpens or softens the picture and adjusts the picture’s brightness and 
contrast. 
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• Color. Adjusts the saturation and tone of the picture and recolors the picture. 
• Artistic Effects. Applies effects such as Chalk Sketch or a line drawing. 
• Change Picture. Changes or removes the current picture. 
• Reset. Resets the picture to its original format and size. 
• Picture Styles. Applies Quick Styles to a picture that add a frame, add a picture 

border, add picture effects, and convert the picture to a SmartArt graphic. 
• Accessibility. Opens the Alt Text pane so you can add alternative text to the 

picture. 
• Arrange. Includes commands to position the picture on the page, control how text 

wraps around the selected picture, and move the picture a level up by using Bring 
Forward or a level down by using Send Backward. This group also contains an 
option to open the Selection pane, which lists all the pictures that the document 
includes, and Align options to align the picture to either the margin or the edge of 
the page. 

• Size. Houses options to crop the picture—that is, to remove areas you don’t need—
and to both horizontally and vertically resize the picture. 

 

Video 

For a video about the steps you take to add pictures to a document, 
refer to Insert pictures. 

Activity: Tell a story 
In this activity, the teacher will invite you to share your experiences with distinct types of 
documents—both with and without pictures—followed by demonstrating how to insert 
and format pictures in Word. 

Resources required 
You’ll need the following resource for this activity: 

• L2_T1_act_add_to_their_stories_starter.docx in this lesson’s Learning Activity 
Resources folder 

  

https://aka.ms/Insert_Pictures
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Activity instructions 
Participate in the activity by following these instructions: 

1. Interact with the class and share your experiences based on the prompts the teacher 
gives you. 

2. Observe the teacher demonstrate how to both insert a picture and modify the 
picture by using tools on the Picture Tools Format tab. 

3. Interact and ask and answer questions. 

4. Go through the L2_T1_act_add_to_their_stories_starter.docx document, and think 
of ways you might add to the stories of the Munson’s staff by inserting and 
formatting pictures in Word. 

Try-it: Insert and format pictures  
 In this leveled try-it, you’ll use the skills you just learned to insert pictures of 

scrumptious food into the fall harvest catalog. 

Try-it 1 
In this try-it, you’ll insert food images into the document where indicated by using the 
provided files. 

Resources 
You’ll need the following resources for this try-it: 

• L2_T1_try1_food_catalog_starter.docx in this lesson’s Learning Activity Resources 
folder 

• The following files in the Media folder: 
o Food_apple_illustration.png 
o Food_carrot_whole_illustration.png 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. To the left side of the Apples! title, insert the Food_apple_illustration.png picture. 

2. Resize the picture of the apple to 1 inch (or 2.54 centimeters) high by 0.76 inches 
(or 1.9304 centimeters) wide. 

3. Apply the Glow: 8 point; Orange, Accent color 2 artistic effect to the picture of the 
apple. 
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4. To the left side of the Carrots title, insert the Food_carrot_whole_illustration.png 
picture. 

5. Resize the picture of the carrot to 1 inch (or 2.54 centimeters) high by 0.28 inches 
(or 0.7112 centimeters) wide. 

6. Apply the Light Screen artistic effect to the carrot. 

7. Save and close the file. 

Try-it 2 
In this try-it, you’ll use the available pictures to illustrate the meal being prepared. Reuse 
pictures as needed, and format them according to the specifications given. 

Resources 
You’ll need the following resources for this try-it: 

1. L2_T1_try2_pizza_party_starter.docx in this lesson’s Learning Activity Resources 
folder 

2. The following files in the Media folder: 

o Kitchen_tool_plate_illustration.png 
o Food_pizza_slice_illustration.png 
o Food_salad_on_plate_illustration.png 
o Food_apple_quarter_slice_illustration.png 
o Food_strawberry_whole_illustration.png 
o Food_3D_cookie_illustration.png 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Using the provided files, complete the flyer to promote the staff pizza party. Use 
each of the images that the preceding Resources section lists at least once to create 
an appealing picture by layering the food on the plates. 

2. Resize the images as needed. 

3. Save the file as Pizza_party_your name.docx, and then close the file. 
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Topic 2: Remove the picture 
background 

 Have you ever wanted to use a picture in a document, but the background of the 
picture distracted from the message? You can remove the background and specific 
areas of the picture by using the tools available in the Adjust group on the Picture 
Tools Format tab. You might have already noticed Remove Background, as the 
following screenshot depicts, when performing the try-it in the previous topic. 

 
Figure 6: The Picture Tools Format tab 

To remove the background from a picture, perform the following steps: 

1. Insert a picture into a document. 

2. Select the picture. 

3. On the Picture Tools Format tab, select Remove Background. 

4. Word removes the background and displays the Background Removal tab, as the 
following screenshot depicts. 

 
Figure 7: The Background Removal tab 

Remove part of a picture 
To remove part of the background from a picture, perform the following steps: 

1. Insert a picture into a document. 

2. Select the picture. 
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3. On the Picture Tools Format tab, select Remove Background. The Background 
Removal tab displays. 

4. If you want to keep an area of the picture, select Mark Areas to Keep. 

5. If you want to remove an area of the picture, select Mark Areas to Remove. 

6. If you want to keep the changes you made, select Keep Changes. 

7. If you want to remove the changes and start over, select Discard All Changes. 

Activity: Switch! 
In this activity, the teacher will share two pictures that you need to reuse by combining 
them into a single picture. Do you think you can combine them? The teacher will help 
you remove the background of the drone. 

Resources required 
You’ll need the following resource for this activity: 

• L2_T2_act_reuse_pictures_starter.docx in this lesson’s Learning Activity 
Resources folder 

Activity instructions  
Participate in the activity by following these instructions: 

1. Examine the two pictures and think of ways to reuse them. 

2. Volunteer to participate in this activity, and seek the teacher’s help as needed. 

3. If you choose not to volunteer, observe the steps that your classmate performs. 

Try-it: Remove the picture background 
 In this leveled try-it, you’ll remove the background from a picture. 

Try-it 1 
In this try-it, you’ll remove the background from an existing picture in a document. 

Resources 
You’ll need the following resource for this try-it: 

• L2_T2_try1_Hillary_Brennan_starter.docx in this lesson’s Learning Activity 
Resources folder 
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Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Select picture of Hilary Brennan, and then remove the background. 

2. Save and close the file. 

Try-it 2 
In this try-it, you’ll remove just part of the background from a picture in a document. 

Resources 
You’ll need the following resource for this try-it: 

• L2_T2_try2_dandelion_starter.docx in this lesson’s Learning Activity Resources 
folder 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Remove all the content except the stem and flower of the dandelion. 

2. Apply the Line Drawing effect to the picture. 

3. Apply your choice of Glow effect to the picture.  

4. Save the file in your student folder, and then close the file. 

Wrap-up 
Use these questions to check what you learned in this lesson: 

1. What’s the best way to remove part of the background from a picture? 

Select all that apply. 

a. Crop the background out of the picture 

b. Make the background transparent 

c. Mark the areas to remove 

d. Mark the areas to keep 
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2. To apply a border to a picture, which command would you use? 

Select all that apply. 

a. Picture Border 

b. Picture Quick Styles 

c. Picture Outline 

d. Artistic Effects 

3. Where do you find the option to change the layout of a picture? 

Select the correct option. 

a. Picture Tools Format tab, Arrange, Position 

b. Picture Tools Format tab, Arrange, Align 

c. Picture Tools Format tab, Arrange, Wrap Text 

d. Picture Tools Format tab, Arrange, Bring Forward 

4. Name three artistic effects that you can apply to a picture. 

Fill in the blank spaces. 

o  
o  
o  

In the next lesson, you’ll learn how to work with the SmartArt feature to communicate 
your message by using diagrams and flowcharts. Do you know about SmartArt? Have 
you used it? When might you need to create a diagram in another class or activity? Turn 
to a neighbor, and share your experiences with SmartArt. Share your ideas about when 
you might want to use a diagram to better communicate a message. 
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Lesson 3: Creating diagrams via 
the SmartArt feature 
Overview 
Why does Word have SmartArt? You can use SmartArt graphics to depict the 
relationship between ideas and words. For example, rather than list the steps of a 
process by using just text, you can quickly insert complex SmartArt diagrams for better 
communication. During this lesson, you’ll understand how SmartArt does this and learn 
how to insert, modify, and format SmartArt graphics. You’ll become familiar with the 
various SmartArt diagrams available and, importantly, understand how to determine 
the best diagram to use for the information you want to showcase. 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. Which of the following statements are true about SmartArt? 

Select all that apply. 

a. SmartArt is an effective way to depict a continual process. 

b. SmartArt is an effective way to depict a relationship between objects. 

c. SmartArt is an effective way to depict a process or timeline. 

d. SmartArt is an effective way to depict the management structure of an 
organization. 

2. On which ribbon tab can you find the options for SmartArt? 

Select the correct option. 

a. Design 

b. Layout 

c. Insert 

d. Draw 
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3. What types, or categories, of diagrams does SmartArt make available? 

Select all that apply. 

a. Pyramid 

b. Picture 

c. Cycle 

d. List 

4. What process do you do every day that you can depict by using SmartArt? 

 

Topic 1: Insert SmartArt 
 SmartArt offers an easy way to quickly turn an ordinary list of steps into a graphic. 

SmartArt helps draw attention to valuable information. For example, you can use it to 
create an organizational chart that displays each person in a company and whom they 
report to. 

Choose from the many design options that the SmartArt feature makes available to 
quickly make a graphic representation of the information in a list or paragraph. Word 
offers many design options, such as Process, Cycle, and Listjust choose the design 
that best fits your needs. 

Insert a SmartArt graphic 
To insert a SmartArt graphic, follow these steps: 

1. Place your cursor in the document where you want Word to insert the diagram. 

2. On the Insert tab, select SmartArt. The Choose a SmartArt Graphic dialog box 
displays with three sections: a section of the graphic categories, the List section 
(which displays the options for the selected category), and a preview (which displays 
a preview of the selected SmartArt graphic). 

3. Select the category you want, and then scroll through the List section to find the 
SmartArt diagram that best fits your needs. If you change your mind, you can switch 
the graphic to another diagram at any time. 
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Figure 8: The Choose a SmartArt Graphic dialog box 

 

Additional information 

For more information about how to work with SmartArt graphics, 
refer to: Create a SmartArt graphic 

Add text to a SmartArt graphic 
You can add text to a SmartArt graphic in a document in either of the following ways: 

• After you insert a SmartArt graphic into your document, the SmartArt Tools 
Design contextual tab displays. Select the Text Pane command, and then select the 
[Text] placeholder to enter your text, as the following screenshot depicts. 

 
Figure 9: A [Text] placeholder in the Text pane 

  

https://aka.ms/Create_a_SmartArt_graphic
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• Select the SmartArt graphic, place your cursor in the [Text] placeholder in the 
SmartArt graphic, and then enter your text, as the following screenshot depicts. 

 
Figure 10: A [Text] placeholder in a SmartArt graphic 

Activity: Discuss and learn 
In this activity, the teacher will share a document that has some information presented 
both as text and as a SmartArt graphic. Be ready to answer questions related to the 
document, and then observe a demonstration on how to insert SmartArt graphics. 

Resources required 
You’ll need the following resource for this activity: 

• L3_T1_act_which_way_is_better_starter.docx in this lesson’s Learning Activity 
Resources folder 

 

Did you know? 

If the Text pane doesn’t display, select the arrow near the SmartArt 
graphic. If you want to hide the Text pane, select the same arrow. 
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Activity instructions 
Participate in the activity by following these instructions: 

1. Compare the two ways that the document presents the information. 

2. Share your thoughts on which presentation method is better, and include the 
reasons. 

3. Observe the demonstration by the teacher. 

4. Interact and ask and answer questions, such as: 

o When do I use a SmartArt graphic? 
o How do I determine the best SmartArt graphic to choose? 
o How can I add text to the SmartArt graphic? 

Try-it: Insert SmartArt 
 In this leveled try-it, you’ll explore the options available to create SmartArt 

diagrams, and decide which diagram you feel will work best to present the information. 

Try-it 1 
In this try-it, you’ll explore the SmartArt command and select the appropriate SmartArt 
graphic for specific information. 

Resources 
You’ll need the following resource for this try-it: 

• L3_T1_try1_fall_harvest_catalog_starter.docx in this lesson’s Learning Activity 
Resources folder 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Explore the SmartArt command for the diverse types of SmartArt graphics 
available, noting the familiar ones. 

2. In the L3_T1_try1_fall_harvest_catalog_starter.docx document, analyze the first 
paragraph below the From our farm to your table title. Try identifying the 
SmartArt graphic that will work best for this content. Share the reason, as well. 

3. Insert the SmartArt graphic into a new blank Word document. 
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4. Add the text from the L3_T1_try1_fall_harvest_catalog_starter.docx document, to 
the SmartArt graphic. 

5. Save the file as My_farm_process_solution.docx, and then close the file. 

Try-it 2 
In this try-it, you’ll replace specific content with SmartArt graphics to present it in a 
better manner. 

Resources 
You’ll need the following resource for this try-it: 

• L3_T1_try2_fall_harvest_catalog_starter.docx in this lesson’s Learning Activity 
Resources folder 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Open the L3_T1_try2_fall_harvest_catalog_starter.docx document, and analyze the 
apple pie recipe to determine how you can convert the list of ingredients and the 
steps into appropriate SmartArt graphics. 

2. Replace the list of ingredients with the appropriate SmartArt graphic. 

3. Change the font size of all the text in the graphic to 12 pt. 

4. Replace the list of steps with the appropriate SmartArt graphic. 

5. Change the font size of all the text in the graphic to 12 pt. 

6. Note that you should now have two SmartArt graphics. Save and close the file. 

Topic 2: Modify and format SmartArt 
 After you insert a SmartArt graphic into your document, the colors and layout of 

the shapes have the default settings. You can change these colors from the SmartArt 
Tools Design and Format contextual tabs. 
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Review the options on the SmartArt Tools Design tab, as the following screenshot 
depicts: 

 
Figure 11: The SmartArt Tools Design tab 

• Create Graphic. The commands available in this group include Add Shape for 
adding another shape before or after the selected shape, Add Bullet for adding a 
bullet before the selected shape, Text Pane for entering text, Promote and Demote 
to increase or decrease the shape level, and Right to Left to switch the layout from 
right to left or vice versa. 

• Layouts. You can select a different diagram layout from here. 
• SmartArt Styles. The commands available within this group include Change Colors 

for changing the color variation of the SmartArt graphic, and SmartArt Styles for 
quickly applying a visual style, such as 3D effects. 

• Reset Graphic. With this command, you can discard all the formatting changes that 
have been applied to the SmartArt graphic. 

Now, understand the commands on the SmartArt Tools Format tab, as the following 
screenshot depicts: 

 
Figure 12: The SmartArt Tools Format tab 

• Shapes. The commands that this group includes are Edit in 2D to edit a 3D graphic 
in 2D, Change Shape to change the shape of all or one of the objects in the 
SmartArt graphic, and Larger and Smaller to increase or decrease the size of the 
selected graphic. 

• Shape Styles. In this group, you have commands for quickly applying visual effects 
to the selected graphic, such as changing the color and texture by using Shape Fill, 
changing the color of the outline by using Shape Outline, and adding effects such 
as shadows, reflections, and glows by using Shape Effects. 

• WordArt Styles. In this group, you have commands for using Quick Styles on text 
for different gradients, colors, and effects and for modifying the text by using Text 
Fill, Text Outline, and Text Effects (such as Shadow, Reflection, and Glow). 
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• Accessibility. If you select this command, the Alt Text pane will open, and you can 
then add text descriptions to the objects for a screen reader to pick up. 

• Arrange. This group has commands for positioning the diagram on the page, 
choosing how text will wrap around the diagram, bringing the diagram forward or 
sending it backward, displaying the Selection pane so you can observe a list of 
objects in the document, grouping objects together so you can format and move 
them as one object, and rotating the object. 

• Size. You use this command if you want to change the height and width of the 
objects in the diagram. 

 

Additional information 

For more information about modifying and formatting SmartArt graphics, 
refer to: Resize a SmartArt graphic shape or an entire SmartArt graphic 

Get to know the SmartArt keyboard shortcuts 
The following table lists some keys and keyboard shortcuts that will help you when 
you’re formatting SmartArt graphics. 

Action Key or keyboard shortcut 

Select the next element in a SmartArt graphic The Tab key 

Select the previous element in a SmartArt graphic Shift+Tab 

Select all shapes Ctrl+A 

Remove the focus from the selected shape The Esc key 

Undo the last action Ctrl+Z 

Promote the selected text Alt+Shift+Left arrow 

Demote the selected text Alt+Shift+Right arrow 

Switch between the Text pane and the drawing canvas Ctlr+Shift+F2 

Table 2: Keyboard shortcuts for formatting SmartArt 

Activity: Watch me first 
In this activity, the teacher will demonstrate how you can modify SmartArt graphics in 
multiple ways. 

https://aka.ms/Resize_a_SmartArt_graphic_shape_or_an_entire_SmartArt_graphic
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Resources required 
None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Observe the steps that the teacher demonstrates. 

2. Interact and ask and answer questions, such as: 

o How do I access all the available layouts? 
o How do I apply a predefined style to a SmartArt graphic? 
o Can I customize the color and outline for one of the shapes within a SmartArt 

graphic? 

Try-it: Modify and format SmartArt 
 In this leveled try-it, you’ll modify and apply formatting to existing SmartArt 

graphics. 

Try-it 1 
In this try-it, you’ll change the layout of a SmartArt graphic. 

Resources 
You’ll need the following resource for this try-it: 

• L3_T2_try1_company_overview_starter.docx in this lesson’s Learning Activity 
Resources folder 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Complete the SmartArt graphic on page 4 that depicts the four seasons of the 
Munson’s Pickles and Preserves Farm year by entering the remaining seasons 
mentioned in the Our Story section: 

o Spring 
o Summer 
o Autumn 

2. Delete any extra shapes from the SmartArt diagram. 

3. Change the format to Colorful Accent Colors. 
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4. Change the layout to Text Cycle. 

5. Apply the Bevel, Round effect to the arrows.  

6. Save and close the file. 

Try-it 2 
In this try-it, you’ll change the current layout of two shapes, change the color of the first 
and last shapes in the diagram, and copy a list of items on a page to the diagram. 

Resources 
You’ll need the following resource for this try-it: 

• L3_T2_try2_types_of_apples_starter.docx in this lesson’s Learning Activity 
Resources folder 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Create a Chevron Accent Process diagram below the Types of Apples heading. 

2. Under the Apples for eating raw heading, enter all the types of apples: 

o Honeycrisp 
o Braeburn 
o Fuji 
o Red Delicious 

3. Remove any unnecessary shapes. 

4. Format the diagram with Colorful Range – Accent Colors 3 to 4. 

5. Edit the SmartArt graphic to reverse the order of the steps in the depicted process. 

6. Save and close the file. 

Try-it 3 
In this try-it, you’ll depict the relationships and the hierarchy of the employees of the 
Munson’s Pickles and Preserves Farm organization by using the appropriate SmartArt 
graphic. 
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Resources 
You’ll need the following resources for this try-it: 

1. L3_T2_try3_company_organization_chart.starter.docx in this lesson’s Learning 
Activity Resources folder 

2. The following media files in the Media folder: 

o Farmer_Marcos_Serna_farm_general_manager_illustration.png 
o Farmer_Hilary_Brennan_Greenhouse_manager_illustration.png 
o Farmer_Fen_Long_irrigation_engineer_illustration.png 
o Farmer_Danielle_Gousse_agricultural_technologist_illustration.png 
o Farmer_Eugenia_Austin_soil_scientist_illustration.png 
o Farmer_Fernando_Vasquez_beekeeper_illustration.png 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Using the information from the organizational chart at the beginning of page 4, 
complete the SmartArt graphic, Circle Picture Hierarchy, as follows: 

o First level: Marcos Serna, General Manager 
o Second level: 

 Hilary Brennan, Greenhouse Manager 

 Fen Long, Irrigation Engineer 

o Reporting to Hilary Brennan: 

 Danielle Gousse, Agricultural Technologist 

 Fernando Vasquez, Beekeeper 

o Reporting to Fen Long: 

 Eugenia Austin, Soil Scientist 

2. Add the pictures for: 

o Marcos Serna 
o Hilary Brennan 
o Fen Long 
o Danielle Gousse 
o Eugenia Austin 
o Fernando Vasquez 

3. Apply the Colored Fill - Accent 2 color to the diagram. 
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4. Apply the Cartoon SmartArt style to the diagram.

5. Save and close the file.

Wrap-up 
Use these questions to check what you learned in this lesson: 

1. Which of the following SmartArt graphic types best represent a group of similar
items?

Select all that apply.

a. Matrix

b. Relationship

c. List

d. Cycle

2. What’s the process for inserting text in a SmartArt shape?

Select all that apply.

a. Enter the text in the shapes.

b. Copy and paste the text in the shapes.

c. Enter the text in the Text pane.

d. Copy and paste the text in the Text pane.

3. How can you find the options for changing one of the shapes in a diagram?

Select all that apply.

a. On the SmartArt Tools Format tab, select Change Shape.

b. On the SmartArt Tools Design tab, select Change Shape.

c. Right-click or access the context menu of the shape, and then select Change.

d. Right-click or access the context menu of the shape, and then select More
Layout Options.
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4. What’s the process for reversing the layout of a diagram? 

Select the correct option. 

a. Select the diagram, and then use the object handles to rotate the diagram. 

b. Select the diagram, and then select Right to Left. 

c. Select the diagram, and then select Move Down. 

d. Select the diagram, and then select Reset Graphic. 
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Lesson 4: Depicting information 
by using icons and screenshots 
Overview 
In this lesson, you’ll learn to use icons as a fun way to communicate information. You’ll 
then learn how to take a screenshot of what appears on your screen and then paste that 
picture into documents to display examples or share information. Finally, you’ll learn 
about using symbols and special characters and how to appropriately insert them into 
your document. 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. Which ribbon tab of Word has the Icons command? 

Select the correct option.  

a. Insert 

b. Draw 

c. Design 

d. Picture 

2. List four or five examples of icons you notice in your school building or your 
everyday routine. 

Fill in the blank spaces. 

a.  

b.  

c.  

d.  

e.  

  



Working with objects 
 

 
45 

3. How would you change the color of an icon? 

Select all that apply. 

a. Right-click or access the context menu of the icon, select Format graphic to 
open the Format Graphic pane, select Fill & Line, select Fill, and then select the 
color you want. 

b. Right-click or access the context menu of the icon, select Format graphic to 
open the Format Graphic pane, select Effects, select Artistic Effects, and then 
select the color you want. 

c. Select the icon, navigate to the Home tab, select the Font Color menu, and then 
select the color you want. 

d. Select the icon, navigate to the Graphic Tools Format tab, select the Graphics 
Fill menu, and then select the color you want. 

4. Give four or five examples of ways that you can use screenshots in documents. 

Fill in the blank spaces. 

a.  

b.  

c.  

d.  

e.  
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Topic 1: Insert and format icons 
You can use icons to emphasize essential information in a document. You can also 
format icons to match your branding theme. 

Insert icons 
To insert an icon, follow these steps: 

1. Place your cursor in the document where you want to insert the icon. 

2. On the Insert tab, select Icons. 

 
Figure 13: The Icons command on the Insert tab 

3. Note that the Insert Icons dialog box displays. 

 
Figure 14: The Insert Icons dialog box 

4. Browse through the categories to observe the available icons, or use the Search 
Icons box to quickly find what you want. 

5. Select one or more icons, and then select Insert to insert the icons into your 
document. 
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Format icons 
To format an icon, select the icon, and then use the Graphics Tools Format contextual 
tab, as the following screenshot depicts: 

 
Figure 15: The Graphic Tools Format tab 

• Change Graphic. Changes the selected graphic to a different graphic but keeps the 
current size and format. 

• Convert to Shape. Converts the pieces of the selected graphic into shapes that you 
can individually move and format. 

• Graphics Styles. Quickly adds styles, such as outline and fill colors, to the selected 
graphic; formats the icon fill and outline colors; and applies graphic effects, such as 
shadows and reflections, to the icon. 

• Accessibility. Opens the Alt Text pane, where you can add a text description of the 
object, which a screen reader (if used) will use to verbally describe the object. 

• Arrange. Supplies options for positioning the icon on the page, selecting how text 
will wrap around the icon, bringing the icon forward or sending it backward, opening 
the Selection pane to display a list of objects in the document, grouping objects 
together so you can format and move them as one object, and rotating the object. 

• Size. Changes the height and width of the icon and removes any unnecessary areas 
by cropping the selection from the icon. 

 

Video 

To observe a video, refer to Insert icons. 

Activity: Think-pair-share 
In this activity, you’ll pair up with a classmate to explore Word, think of answers, and 
then share your findings with the class. The teacher will lead a discussion, share a story, 
and demonstrate how to work with icons. 

Resources required 
None 

https://aka.ms/Insert_icons
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Activity instructions 
Participate in the activity by following these instructions: 

1. Pair up with a classmate as directed by the teacher. 

2. Think of ways that icons communicate messages, and participate in the class 
discussion. 

3. Observe the teacher demonstrate how to insert, modify, and format icons in Word. 

4. Understand the story shared by the teacher about Munson’s Family Day, and work 
with your classmate to search for icons for this story. 

5. Share your findings with the class. 

Try-it: Insert and format icons 
 In this leveled try-it, you’ll use icons to represent the information that a document 

is sharing. You can use icons in place of text to describe a process or to give directions 
to a location. 

Try-it 1 
In this try-it, you’ll decide which icons best depict the farm-to-table process, starting 
with the farm and ending with the grocery store. The following instructions describe the 
process for you. 

Resources 
You’ll need the following resource for this try-it: 

• L4_T1_try1_Farm-to-Table_Cookbook_starter.docx in this lesson’s Learning 
Activity Resources folder 

Instructions 
1. Replace the [Insert Icons here] placeholder text with icons that you feel best 

represent each of the following items: 

o A farmer to tend the soil 
o Seeds for the farmer to plant 
o Water to irrigate the fields 
o Vegetables harvested by the farmer 
o A barn to store the harvested vegetables 
o Transportation of the vegetables to stores 
o Food is purchased and made into tasty and nutritious meals 
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2. Resize the icon that represents the transportation of the vegetables to stores so that 
its height is 2 inches or 5.08 centimeters and its width is 2.5 inches or 6.35 
centimeters. 

3. Save and close the file. 

Try-it 2 
In this try-it, you’ll create a map of the square fields of Munson’s farm that the 
cookbook will include. You’ll decide which icons best depict specific areas on the map. 
You’ll then insert the icons and modify the format to match Munson’s branding. 

Resources 
A new blank Word document 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Create a map by inserting four 3-inch (or 7.62 centimeter) squares on the page, 
placing them so two squares exist in each row. 

2. Change the color of each square as follows: 

o Square 1: Orange 
o Square 2: Gold, Accent 4, Lighter 60% 
o Square 3: Green 
o Square 4: Green 

3. Enter the following text: 

o Square 1: Barn 
o Square 2: Farm stand 
o Square 3: Crops 
o Square 4: Crops 

4. Format the text as follows: 

o Black and bold with a font size of 9 
5. In each rectangle, insert an icon that best depicts the specific area of the farm on the 

map. 

6. Format the icons as Dark Blue. 

7. Save the file as L4_Munsons_map.docx. 

8. Close the file. 
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Topic 2: Insert screenshots and 
clippings 
Sometimes, you want to display to users all or part of a document or application open 
on your device. You can do this by displaying screenshots and screen clippings. 

It’s important to understand the difference between screenshots and screen clippings, 
two valuable tools in Office. Although both screenshots and screen clippings take 
snapshots of any open application on your device’s screen, how they capture the image 
is the differentiating factor. 

When you take a screenshot, Word captures a snapshot of the entire window on your 
computer screen and inserts it into your document. When you take a screen clipping, 
you can select the area of the screen you want to include. 

Create and insert a screenshot 
1. On the Insert tab, select Take a Screenshot. 

 
Figure 16: The Take a Screenshot command 

2. A list of the open, available windows on your device displays. 

 
Figure 17: The available windows 

3. Select the thumbnail of the window you want to take a snapshot of. 

4. Word immediately inserts the screenshot into your document. 
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Create and insert a screen clipping 
1. Select the window you want to create your screen clipping from. 

2. Navigate to the document you want to insert the clipping into. 

3. On the Insert tab, select Take a Screenshot. 

 
Figure 18: The option to insert a screen clipping 

4. In the Available Windows dialog box, select Screen Clipping: 

a. Your screen displays the last window you accessed. Note that this window is the 
only one you can create a screen clipping from. 

b. Your cursor changes to a crosshair. Select and drag around the area of the 
window that you want to capture. 

c. When you release your mouse or other input device, Word immediately inserts 
the clipping in your document. 

5. To save the screen clipping as an image file (a .png or .jpg file), follow these steps: 

a. Right-click or access the context menu of the screen clipping. 

b. Select Save as Picture. 

c. Navigate through the file system to choose where you want to save the file. 

d. Name the file, and then select one of Save as type options. 

e. Select Save. 
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5. The following table describes the image file types that Word makes available in the 
Save as type box. 

Image file type Description 

Portable Network Graphics (*.png) For storing image files with a smaller file 
size 

JPEG File Interchange Format (*.jpg) For storing image files in a compressed 
format with a smaller file size 

Graphics Interchange Format (*.gif) For animated objects in documents and on 
websites 

Tag Image File Format (*.tif) For storing high-quality graphics with a 
larger file size 

Windows Bitmap (*.bmp) For storing image files with a larger file size 

Table 3: Image file types 

Activity: Show me how 
In this activity, the teacher will demonstrate how to insert screenshots and screen 
clippings and explain how to use them. 

Resources required 
For this activity, you’ll need the following documents in this lesson’s Learning Activity 
Resources folder: 

• L4_T2_act_Farm-to-Table_Cookbook_screenshot_starter.docx 
• L4_T2_act_farm_process_screen_clipping_starter.docx 

Activity instructions 
Participate in the activity by following these instructions: 

1. Understand how to take and insert a screenshot and a screen clipping. 

2. Participate in the teacher-led discussion on using screenshots and screen clippings. 

3. Interact and ask clarifying questions, such as: 

a. When is using screenshots helpful? 

b. Can you use screen clippings from applications other than Word? 



Working with objects 
 

 
53 

Try-it: Insert screenshots and screen 
 In this leveled try-it, you’ll take a screenshot of information in one document and 

insert the picture into another. 

Try-it 1 
In this try-it, you’ll capture a snapshot of another open window and insert the snapshot 
into a document. 

Resources 
For this try-it, you’ll need the following documents in this lesson’s Learning Activity 
Resources folder: 

• L4_T2_try1_Farm-to-Table_Cookbook_starter.docx 
• L4_T2_try1_food_catalog_starter.docx 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Open both the documents from the Learning Activity Resources folder. 

2. Take a screenshot of the page that has the Pear Preserves recipe in the 
L4_T2_try1_Farm-to-Table_Cookbook_starter.docx document. 

3. Place the screenshot on page 2 of the L4_T2_try1_food_catalog_starter.docx 
document, after the Pear section. 

4. Save and close both documents. 

Try-it 2 
In this try-it, you’ll capture a section of a webpage and insert the screen clipping into a 
document. 

Resources 
You’ll need the following resource for this try-it: 

• The Word help center website. 
  

https://aka.ms/Word_help_center
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Instructions 
1. Open a new Word document, and save this file as L4_T2_try2_Microsoft_help.docx. 

2. On the Word help center website, take a screen clipping of the webpage title, Word 
help center. 

3. Save the screen clipping as L4_T2_try2_Microsoft_help.png in your student folder. 

4. Save and close the Word document. 

5. Close the website. 

Topic 3: Insert symbols and special characters 
 In addition to adding text, shapes, and images to a document, you can insert 

special characters and symbols, such as copyright and registered trademark symbols. 
Trademarks and copyrights are like patents in that they help protect intellectual 
property. Entering these symbols tells the reader that trademark or copyright laws are 
helping protect the information. 

You access symbols and special characters from the same window. To insert symbols 
and special characters, follow these steps: 

1. Place your cursor where you want to insert the symbol or special character. 

2. On the Insert tab, in the Symbols group, select Symbol. 

 
Figure 19: The Symbol command on the Insert tab 

3. Select More Symbols. 

4. Note that the Symbols dialog box displays and that you can choose among the 
symbols. To display more symbols, use the scrollbar on the tab. 

The bottom of the tab displays a Recently used symbols section for easy access to 
those symbols. 

  

https://aka.ms/Word_help_center
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5. Select the symbol to insert, and then select Insert. 

 
Figure 20: The Symbol dialog box 

6. Note that you can assign a keyboard shortcut to a symbol by selecting Shortcut 
Key, entering the keyboard shortcut, and then selecting OK. 

7. For instance, to create a keyboard shortcut for the copyright symbol (©), select the 
symbol, and then select Shortcut Key. The Customize Keyboard dialog box 
displays. 

8. Note that if a keyboard shortcut already exists for the symbol, the Current keys box 
will display it. To enter a new or different keyboard shortcut, select Alt+C in the 
Press new shortcut key box. If the keyboard shortcut already exists, Word will let 
you know. Otherwise, select Assign, and then select Close to close the dialog box. 
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9. Note that the keyboard shortcut for the copyright symbol is Alt+Ctrl+C. 

 
Figure 21: The Customize Keyboard dialog box 

10. Note that the Symbol dialog box also has the Special Characters tab. Select this tab 
to observe the available characters. 

 
Figure 22: The Special Characters tab 
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11. Select the character you want, and then select Insert. Note that the Special 
Characters tab displays each character along with its keyboard shortcut (under 
Shortcut key), if any. 

 

Did you know? 

What’s the difference between the copyright symbol (©) and the 
registered trademark symbol (®)? Copyright and trademark laws help 
protect distinct types of assets. Copyright laws help protect literary 
and artistic works, such as books and videos. A trademark helps 
protect items that define a company brand, such as its logo. 

Go beyond symbols 
A good place to search for symbols and characters in Word is the Symbol dialog box. In 
the Font box, select Webdings or Wingdings, as the following two screenshots depict. 

 
Figure 23: Webdings in the Symbol dialog box 
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Figure 24: Wingdings in the Symbol dialog box 

Activity: Guess and tell 
In this activity, the teacher will demonstrate how to insert symbols and special 
characters and how to create a keyboard shortcut to quickly insert a symbol. Get ready 
to try the steps with a classmate. 

Resources required 
None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Observe the teacher demonstrate how to insert symbols and special characters. 

2. Pair up with another student, and open a new blank document. 

3. Work together to find the keyboard shortcuts for inserting these symbols and special 
characters: 

a. Copyright symbol (©) 

b. Smiley face () 

c. Registered trademark symbol (®) 

4. Find a symbol that doesn’t have a keyboard shortcut, and then create a keyboard 
shortcut for it. 

5. Try the new keyboard shortcut in the document to make certain that it works 
correctly. 

6. Share the keyboard shortcut you created with the other teams. 
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Try-it: Insert symbols and special characters 
 In this standalone try-it, you’ll replace words in a document with an appropriate 

symbol or special character. 

Resources required 
You’ll need the following resource for this try-it: 

• L4_T3_try_company_overview_symbols_starter.docx in this lesson’s Learning 
Activity Resources folder 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Find all instances of descriptive text that you might substitute with symbols or 
special characters. 

2. Replace this text with the appropriate symbols or special characters. 

3. Save and close the document. 

Wrap-up 
Use these questions to check what you learned in this lesson: 

1. How might you use icons in a document to help all readers understand the meaning 
of the information? 

Select all that apply. 

a. To improve visual interest 

b. To grab a reader’s attention 

c. To guide readers while they’re navigating the page 

d. To help communicate information 
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2. What’s the process for inserting icons? 

Select the correct option. 

a. On the Insert tab, select Icons. 

b. On the Insert tab, in the Illustrations group, select Shapes, and then select 
Icons. 

c. On the Insert tab, select Online Pictures, and then select Icons. 

d. On the Insert tab, select Symbol, select Special Characters, and then select 
Icons. 

3. Where can you find symbols and special characters? 

Select all that apply. 

a. On the first row of the keyboard. 

b. On the Insert tab. 

c. On the Home tab. 

d. On the Draw tab. 

4. What’s the difference between a screenshot and a screen clipping? 
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Lesson 5: Adding text boxes 
and alternative text 
Overview 
In this lesson, you’ll learn how to insert and modify text boxes, manage the layout of 
text with respect to an image, and add alternative text to objects in a document to 
improve your document’s accessibility. Get ready for discussions and step-by-step 
demonstrations along with opportunities to practice what you learn. This is also the last 
lesson of this module. 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. Which of the following types of formatting can’t you apply to a text box? 

Select the correct option. 

a. Layout 

b. Fill 

c. Outline 

d. Effects 

2. Which of the following isn’t a text wrapping option that you can apply to a text box? 

Select the correct option. 

a. In line with text 

b. Tight 

c. Top and bottom 

d. Around 
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3. What are the ways to add alternative text to an object?

Select all that apply.

a. Enter the alternative text in the text box.

b. Right-click or access the context menu of the text box, and then select Edit Alt
Text.

c. On the Drawing Tools Format tab, select Alt Text.

d. Double-click the text box to open the Alternative Text dialog box.

4. Which of the following is the correct way to use alternative text so that screen
readers will skip the object?

Select the correct option.

a. Don’t include alternative text with the object.

b. Don’t include alternative text in the Alt Text pane.

c. In the Alt Text pane, select Mark as decorative.

d. in the Alt Text pane, select Skip.

Topic 1: Insert and modify text boxes 
 Sometimes, you need to add text at a specific position in your document. For 

example, assume that you want to add a quotation or a sidebar and to format this text 
differently so it stands out. A text box helps you add text anywhere in your document 
and then change the layout of only that text. It’s a terrific way to move your audience’s 
attention to any valuable information in your document. 
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Insert a text box 
1. Place your cursor in the document where you want to insert the text box.

2. On the Insert tab, select Text Box, and then select one of the built-in text box styles.
Use the scrollbar in the dialog box to browse the options.

Figure 25: Text box styles 

3. Select the text box style to insert it in the document.

4. Use the Drawing Tools Format tab to change the fill and outline colors and to apply
shape effects. You’ll find the same formatting options available for text boxes that
you used in an earlier lesson for formatting shapes.

Additional information 

For more information, refer to Add, copy, or delete a text box. 

Activity: Preview and select 
In this activity, the teacher will demonstrate how to choose a text box style from the 
built-in text box styles, add and modify text in the text box, and then format the text box 
by using the Drawing Tools Format tab. 

Resources required 
You’ll need the following resource for this activity: 

• L5_T1_act_Munsons_weekly_newsletter_starter.docx in this lesson’s Learning
Activity Resources folder

https://aka.ms/Add_copy_or_delete_a_text_box
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Activity instructions 
Participate in the activity by following these instructions: 

1. Carefully follow the steps that the teacher performs.

2. Interact and ask and answer questions.

Try-it: Insert and modify text boxes 
 In this leveled try-it, you’ll insert text boxes into a document. You’ll also format the 

text boxes by using the Drawing Tools Format tab. 

Try-it 1 
In this try-it, you’ll insert a text box into a document by using a built-in text box style 
and bring focus to the content it contains. 

Resources 
You’ll need the following resource for this try-it: 

• L5_T1_try1_Farm-to-Table_Cookbook_starter.docx in this lesson’s Learning
Activity Resources folder

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Insert a Simple Quote text box just after the Munson’s Pickles and Preserves Farm
Cookbook title on page 1.

2. Enter the same title, Munson’s Pickles and Preserves Farm Cookbook, into this
text box.

3. Save and close the file.

Try-it 2 
In this try-it, you’ll format text boxes in a document by using the Drawing Tools 
Format tab. You’ll change the style, position the text box on the page, and apply 
alternative text as specified. 

Resources 
You’ll need the following resource for this try-it: 

• L5_T1_try2_cookbook_text_box_samples_starter.docx in this lesson’s Learning
Activity Resources folder
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Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Change the format of each text box as follows:

o Text Box 1: Apply the Perspective Below shadow.
o Text Box 2: Apply the Intense Effect - Green, Accent 6 style.
o Text Box 3: Apply Glow: 18 point, Green, Accent color 6.
o Text Box 4: Apply the Divot bevel.

2. Insert a Simple Text Box into the document, after Text Box 4, with the text
Munson’s Pickles and Preserves Farm Cookbook.

3. Save and close the document.

Topic 2: Position objects and wrap text 
around objects 
Adding images, text boxes, and other objects is basic, but positioning those objects and 
making sure they stay where you want them might pose a challenge. Use the Layout 
Options menu of Word to position an object on the page, control how text wraps 
around the object, position the object in front of or behind another object, and anchor 
the object at a specific location. After you select an object, you can access the Layout 
Options menu in two ways: 

• Use the Layout Options menu that displays next to the object, or on the Picture
Tools Format contextual tab, select Position, as the following screenshot depicts.

Figure 26: The Layout Options menu and the Picture Tools Format contextual tab 
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Note that if you select the See more link in the Layout Options menu and then select 
Text Wrapping, the possible ways to arrange the object with respect to the text display, 
as the following screenshot depicts. 

Figure 27: The Layout dialog box with the Text Wrapping tab selected 

Note that you can access the same dialog box by selecting Position on the Picture 
Tools Format contextual tab, and then selecting More Layout Options. In this dialog 
box, you can select the option that meets your requirement:  

• In line with text. If you want to treat your object like the rest of the lines of text in a
paragraph, select this option. The object will move as you add or remove lines from
the paragraph.

• Square. If you want your text to form a square around the object, select this option,
as its name suggests.

• Tight. If you want the text to closely—or tightly—follow the shape of the object,
keeping a bit of a margin between the text and the object, select this option.

• Through. Note that this option is similar to Tight, except that the text will fill into
any empty space of your object.

• Top and bottom. If you want your text to arrange itself on the top and the bottom
of the object, select this option. No text will appear on the sides of the object.

• Behind text. To place your object behind your text, select this option. Note that
depending on the object, this option might reduce the readability of your text.

• In front of text. To place your object in front of your text, select this option, which is
the reverse of Behind text. The object will hide some of the text.
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• Wrap text. Use this option to help you control how text will wrap around the object.
The text can wrap on both sides of the object, only to the left side of the object, only
to the right side of the object, or only on the side of the object that has the greatest
distance from the page margin.

• Distance from text. Specify the distance of the text from the object by using this
option.

Position an object 
The Layout Options menu has two options to position an object: 

• Move with text. Select this option if you want the object to move as the text moves.
This is useful when the object is specific to a paragraph, for example.

• Fix position on page. Select this option if you want to lock the position of the
object. This is useful when you add a quotation, for example.

Activity: Show me how 
In this activity, the teacher will demonstrate the various ways to manage the position of 
an object with respect to text. 

Resources required 
None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Carefully follow the steps that the teacher performs.

2. Interact and ask and answer questions.

Try-it: Position objects and wrap text around 
objects 

 In this standalone try-it, you’ll apply text wrapping options to objects and position 
objects on the page. 

Resources 
You’ll need the following resource for this try-it: 

• L5_T2_try_cookbook_wrap_text_starter.docx in this lesson’s Learning Activity
Resources folder
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Instructions 
1. Set the layout option for the picture of the beet as Top and bottom and for the

strawberry as Through.

2. Position the picture of the beet under the heading, Pickled Beets.

3. Fix the position of the strawberry on the page.

4. Share your document with the teacher.

Topic 3: Add alternative text to an 
object 
Alternative text, or alt text as it’s popularly called, describes any picture or object in the 
context of the document it resides in. This alt text is useful for audiences that use screen 
readers. A screen reader reads the alt text added to each object aloud so the audience 
can understand the goal of the object. It’s therefore important to write effective alt text 
to prevent any misunderstanding of the purpose of each object. 

To add alt text to an object, follow these steps: 

1. Select the object.

2. On the Format contextual tab, in the Accessibility group, select Alt Text. Note that
different Format contextual tabs appear based on the image types, as the following
table describes.

Image type Contextual tab displayed

Shape Drawing Tools Format 

Icon Graphics Tools Format 

3D model 3D Model Tools Format 

SmartArt diagram SmartArt Tools Format 

Screenshot or screen clipping Picture Tools Format 

Table 4: Contextual tabs displayed for different image types 
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3. Note that the Alt Text pane displays, as the following screenshot depicts.

Figure 28: The Alt Text pane 

4. In the box, enter a description of the object and its context.

5. Alternatively, mark the object as decorative by selecting Mark as decorative in the
Alt Text pane. This option won’t expose a description of the object to screen
readers.

Activity: Read aloud 
In this activity, the teacher will display a picture on a projected screen. You’ll pair up with 
a classmate and figure out the best alt text for the picture. But, wait for the teacher’s 
instructions. This activity has a twist! 

Resources required 
Creating for everyone 

Activity instructions 
Participate in the activity by following these instructions: 

1. Review the video Creating for everyone. What are the two things that stood out for
you?

2. Understand the instructions that the teacher shares, and pair up with a classmate.

3. Decide who will play the role of the listener in this activity.

4. Figure out the best alt text for the picture that the teacher shares.

5. Observe the demonstration on how to add alt text to the picture.

https://aka.ms/video-creating-for-everyone
https://aka.ms/video-creating-for-everyone
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6. Interact and ask clarifying questions, such as: 

a. Should I keep any points in mind while writing alt text? 

b. What if multiple pictures make up a larger picture in a document? Do I add alt 
text for each picture? 

Try-it: Add alternative text to an object 
 In this standalone try-it, you’ll open objects, review the alt text for the objects, and 

insert any missing alt text for the objects. 

Resources 
You’ll need the following resources for this try-it: 

• L5_T3_try_Munsons_staff_starter.docx in this lesson’s Learning Activity 
Resources folder 

Instructions 
1. Open L5_T3_try_Munsons_staff_starter.docx. 

2. Add alt text as follows: 

o Object 1: Picture of Marcos Serna, Farm General Manager 
o Object 2: Picture of Eugenia Austin, Soil Scientist 

3. Modify the alt text as follows: 

o Object 3: Picture of Fen Long, Irrigation Engineer 
o Object 4: Picture of Hilary Brennan, Greenhouse Manager 

4. Save and close the document. 

Wrap-up 
Use these questions to check what you learned in this lesson: 

1. Where can you find the options for wrapping text around a selected object? 

Select all that apply. 

a. On the Drawing Tools Format tab, in the Arrange group. 

b. On the Drawing Tools Format tab, in the Shape Styles group. 

c. On the Home tab, in the Font group. 

d. On the Picture Tools Format tab, in the Arrange group. 



Working with objects 
 

 
71 

2. Why is it important to insert alternative text for the objects in a document? 

o  
o  

3. If an object doesn’t need a description in the Alt Text pane, what should you do to 
ensure that a screen reader will skip the object? 

Select the correct option. 

a. In the Alt Text task pane, enter Do not read. 

b. Select the Mark as decorative check box. 

c. Leave the box in the Alt Text pane blank. 

d. In the Alt Text task pane, enter Please skip this object. 

4. Which of the following items cannot be positioned with specific text wrapping on a 
page using the Position options in the Arrange group, on the Layout tab?  

Select all that apply. 

a. Shapes 

b. Pictures 

c. Paragraphs 

d. Headings 
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Glossary 
3D model A 3D image that you can rotate to display all angles. 

Alternative text Text that helps people who have visual impairments understand 
pictures and other graphical content. 

SmartArt graphic A visual representation of your information and ideas. 

Screenshot A snapshot of an application or window that you have open on your 
device. 

Contextual tab A hidden tab displayed with the other tabs when an object in the 
document, such as an image, is selected. A contextual tab has 
commands specific to the graphic type—pictures, shapes, 3D models, 
and SmartArt graphics might have different commands on their 
contextual tabs. 

Bring Forward A command for bringing an object to the front of the stack of layered 
objects. 

Diagram A simplified drawing that depicts an appearance, structure, or 
process. 

Flowchart A diagram of the sequence of movements or actions of people or 
things involved in a complex system or activity. 

Icon A graphic that visually communicates a thought. 

Send Backward A command for sending an object to the back of the stack of layered 
objects. 

Text box A rectangular frame into which you enter text. You use text boxes to 
showcase important text, such as titles, headings, and quotes. 

Table 5: Glossary terms and definitions 
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Cornerstone 
Overview 
In this Cornerstone, you’ll complete the announcement for the Cookbook Launch Party 
by adding and modifying pictures and a 3D model, checking for accessibility, and 
correcting any alt text errors. You’ll also create a poster to advertise the launch party 
that has a SmartArt diagram and a text box. 

Objectives 
The following table outlines the Cornerstone objectives and their corresponding 
Microsoft Office Specialist (MOS) exam objectives. 

Insert, format, and 
modify shapes 

• 5.3.2: Add and modify text in shapes 
• 5.4.2: Wrap text around objects 
• 5.4.1: Position objects 

Insert, format, and 
modify text boxes 

• 5.1.6: Insert text boxes 
• 5.3.1: Add and modify text in text boxes 

Insert, format, and 
modify SmartArt 
graphics 

• 5.1.4: Insert SmartArt graphics 
• 5.2.5: Format SmartArt graphics 
• 5.3.3: Add and modify SmartArt graphic content 

Insert and format 
3D models 

• 5.1.3: Insert 3D models 
• 5.2.6: Format 3D models 

Insert, format, and 
modify pictures 

• 5.2.1: Apply artistic effects  
• 5.2.3: Remove picture backgrounds 

Insert alt text • 1.4.2: Locate and correct accessibility issues 
• 5.4.3: Add alternative text to objects for accessibility 

Table 6: Cornerstone objectives 
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Duration 
40 minutes 

Instructions 
1. For each file, complete the tasks in the following section. 

2. When saving your file, add your name to the end of the file name—for example, 
You-pick_day_Dwayne_Espino. Follow your teacher’s directions for where to save 
your files. 

3. When you’re done with the Cornerstone, assess your completion, and enter the 
points you think you earned in the task lists. You can get help from your teacher if 
needed. 

Tasks 
You’ll work with two files in this Cornerstone. The following sections describe the tasks 
you need to do for each file. 

File 1: 
Cornerstone_launch_party_announcement_starter 
.docx 
Complete the announcement for the Cookbook Launch Party by adding and formatting 
images in the draft document. 

Task: Insert and modify a 3D model (4 points) 
1. Insert a 3D model of a barn. (1 point) (Exam objective 5.1.3) 

2. Position the 3D model to the right side of the tractor image by using In line with 
text. (1 point) (Exam objective 5.2.6) 

3. Apply the Above Front Right view to the barn. (1 point) (Exam objective 5.2.6) 

4. Remove the alt text, Red Barn, assigned to the barn. (1 point) (Exam objective 5.4.3) 

Points scored: ______ / 4 
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Task: Modify the tractor and trailer images (7 points) 
1. Remove the trailer from the image of the tractor, leaving the image of the tractor

with a width of 1.0 inches (or 2.5 centimeters) and a height of (0.8) inches (or 2.0
centimeters). (3 points) (Exam objective 5.2.3)

2. Position the image in line with text at the left margin. (2 points) (Exam objective
5.4.1)

3. Apply the Paint Strokes format to the image. (2 points) (Exam objective 5.2.1)

Points scored: ______ / 7

Task: Check for accessibility issues (3 points) 
1. Check the document for accessibility issues, and share your observations with the

teacher. (2 points) (Exam objective 1.4.2)

2. Add the following alt text to the 3D barn image: Munson’s Pickles and Preserve
Farm barn. (1 point) (Exam objective 5.4.3)

Points scored: ______ / 3

File 2: A new blank Word document 
Create a poster from scratch to advertise the Cookbook Launch Party. Create a new 
blank document, and then add and modify a text box and a SmartArt diagram. 

Task: Insert and modify text boxes (5 points) 
1. Insert a Simple Text Box at the beginning of the page. Resize the text box to 2.5

inches (or 6.35 centimeters) high and 6.5 inches (or 16.51 centimeters) wide. (2
points) (Exam objective 5.1.6)

2. Enter the following text in the text box: (1 point) (Exam objective 5.3.1)

o Line 1:  Farm-to-Table Cookbook
o Line 2:  Launch Party
o Line 3:  This Saturday from 1:00 PM to 5:00 PM
o Line 4:  Contact us for more information
o Line 5:  Phone: 360.555.0145
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3. Apply formatting as follows: (2 points) (Exam objective 5.3.1)

a. Format the text box with Intense Effect, Blue Accent 1.

b. Center all text in the text box.

c. Format the text with Verdana and a font size of 22 points.

Points scored: ______ / 5 

Task: Insert and modify a SmartArt diagram (4 points) 
1. Below the text box from the previous task, create a Vertical Box List diagram. (1 
point) (Exam objective 5.1.4)

2. Include the following items in the diagram: (1 point) (Exam objective 5.3.3)

o Pickles booth
o Preserves booth
o Pickling demonstration
o Seed, plant, and harvest demonstration
o Make your own preserves demonstration

3. Apply the Colored Outline - Accent 1 format to the diagram. (1 point) (Exam 
objective 5.2.5)

4. Apply the Cartoon style to the diagram. (1 point) (Exam objective 5.2.5) Points 

scored: ______ / 4

Total points: ______ / 23
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Module overview 
Description 
Tables and lists are used to organize and support the readability of content in a Word 
document. Instead of having multiple paragraphs of information that might overwhelm 
the reader, some types of content might be better represented as a structured table. 
Other types of content might work better as a bulleted or numbered list. Word provides 
features to help you create tables and lists from existing content or content that is still 
to be written in a document. 

By the end of this module, you will be able to create a table using new or existing 
content within a document. You will also be able to modify and format tables to better 
represent the information being conveyed to the reader. Finally, you will be able to 
create and modify bulleted or numbered lists to help organize information and help 
your readers to better understand the main points of a document. 

The following table provides an outline of the specific lessons and learning objectives 
that are covered in this module. 

Lesson Learning objective Exam objective(s) 

Creating and 
locating 
tables 

• Manually insert a table into a document 
• Convert text into a table and table into 

text 
• Navigate to tables within a document 

• 1.1.3 
• 3.1.1 
• 3.1.2 
• 3.1.3 

Modifying 
tables 

• Sort data in a table in a document 
• Resize cells, columns, rows, and entire 

tables 
• Configure cell margins, cell spacing, and 

row headers in a table 

• 3.2.1 
• 3.2.2 
• 3.2.4 
• 3.2.6 

Merging and 
splitting table 
elements 

• Split and merge cells and tables in a 
document 

• Insert and delete rows and columns 

• 3.2.3 
• 3.2.4 
• 3.2.5 
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Lesson Learning objective Exam objective(s) 

Creating and 
modifying 
lists 

• Insert a bulleted and numbered list and 
apply formatting for lists in a document 

• Insert a multilevel list, apply formatting 
to the list, and define a new multilevel 
list 

• 3.3.1 
• 3.3.2 
• 3.3.3 
• 3.3.4 
• 3.3.5 
• 3.3.6 

Cornerstone: 
Community 
Supported 
Agriculture 
(CSA) 
Program 

• Create a table in Word 
• Convert text to tables and tables to text 
• Sort data in a table 
• Resize table elements to fit content 
• Merge and split table elements 
• Create and modify a bulleted list 
• Create and modify a numbered list 
• Create and modify a multilevel list 

• 3.1.1 
• 3.1.2 
• 3.1.3 
• 3.2.1 
• 3.2.2 
• 3.2.3 
• 3.2.4 
• 3.2.5 
• 3.2.6 
• 3.3.1 
• 3.3.2 
• 3.3.3 
• 3.3.4 
• 3.3.5 
• 3.3.6 

Table 1: Objectives by lesson 
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Scenario 
Munson’s Pickles and Preserves Farm supports a local Community Supported 
Agriculture (CSA) project. Community members can become “farm members” and 
purchase shares of the produce to feed their families. Each month they receive a box of 
fresh produce. They can also participate in farm events such as workdays, potlucks, and 
you-pick gardens to experience the joy of harvesting their own food. 

During the wintertime lull from farming activities, you have been asked to update the 
CSA spring program and farm event documentation. You will add new tables of 
information as well as update existing tables to reflect next year’s crops and events. This 
includes instructions for the fresh produce box contents, a member potluck event, and 
an upcoming CSA Member produce seminar. 

Cornerstone 
You have been asked to update the upcoming spring CSA program and event 
documentation. To do this, you need to create tables to track fresh produce boxes and 
box content instructions. You also need to update and create lists of program selection 
options for participants of the upcoming produce seminar. 
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Lesson 1: Creating and locating 
tables 
Overview 
As you format a Word document, you may find that some content can be presented 
better when formatted as rows and columns within a table. Similar to an Excel 
spreadsheet, using a table format to organize specific types of content such as 
numerical or list data will help your readers better understand the point you are trying 
to make. 

Word provides several methods that you can use to create tables within a document. 
Depending upon how the original content is formatted, you might also choose to 
convert existing text to a table for better representation. In this lesson, you learn 
multiple ways to create tables using Word. You also learn how to navigate between 
tables within a larger document. 

Warm-up 
Your teacher will introduce the topics to be covered in this lesson. Be prepared to 
discuss and answer the following questions during the classroom discussion: 

1. What types of content might be useful in a table format? 

 

2. What is the difference between a table row and column? 

 

Topic 1: Manually create a table 
 Using a table in a Word document helps you display information in an organized 

manner. Content within a table is displayed in horizontal rows and vertical columns. The 
rectangle located at the intersection of a row and column is called a cell. Figure 1 
depicts an example of a five-column table containing four rows of information. 
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Figure 1: Table columns and rows 

 

Did you know? 

If you select the Show/Hide button on the Home ribbon, Word will 
display the End of Cell and End of Row markers. These markers help 
you determine where cells and rows are positioned in a table and are 
especially helpful when borders have been removed from the table.  

When you need to create a table within a document, Word provides several methods 
that you can use to perform the task. From the Insert tab on the ribbon, select the 
Table button to access the options as depicted in Figure 2. 

 
Figure 2: Insert Table options 
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Insert a table 
Two methods are available for inserting a blank table within a document. The first 
method uses a table grid, where you can simply trace out the dimensions of a table to 
indicate the desired number of rows and columns. The table grid only allows a 
maximum table size of eight rows and 10 columns; however, the table can be modified 
once it is created. 

The second method uses the Insert Table dialog box, where you input the number of 
columns and rows needed for the table you are creating. You can also include additional 
settings such as AutoFit behavior of the content and defining the default dimensions for 
any additional tables that you insert into the document.  

Figure 3 depicts the Insert Table dialog box configured to create five columns and two 
rows. 

 
Figure 3: Insert Table dialog box 

Draw a Table 
Another method to create a table is to manually "draw" the column and rows using an 
input device such as a mouse or a digital pen. Drawing the table provides granular 
control on exactly how you want the table to appear, including horizontal, vertical, and 
diagonal borders as needed.  
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To draw a table, select the Draw Table option to enable the pencil tool. As depicted in 
Figure 4, the cursor changes to a pencil to indicate that you are in the draw table mode. 

 
Figure 4: Table created using the Draw Table option 

 

Did you know? 

If you decide to remove a line while drawing a table, the Eraser tool 
enables you to "erase" lines. You can also use the Undo command to 
reverse your last few steps if you inadvertently draw an unnecessary 
line in the table.  

Insert a Quick Table 
For additional table options, Word provides the Quick Tables Gallery. By default, the 
gallery includes nine predefined and formatted tables for you to insert into a document. 
The built-in tables include commonly used table formats such as calendars, tabular lists, 
and tables with subheadings. When you select the Quick Tables option, you are 
presented with the preformatted tables stored in the Quick Tables Gallery as depicted 
in Figure 5. 
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Figure 5: Quick Tables Gallery 

For a custom table that you might have spent time creating and formatting, you can 
save the design and add it to the Quick Tables Gallery. This allows you to have your 
favorite table as an option on the Quick Tables list to quickly insert into the document 
as needed. After you have inserted a Quick Table, you can modify and edit the table as 
desired. 

Insert an Excel Spreadsheet 
Another option you can use to create a table in a Word document is to insert an Excel 
spreadsheet. The primary advantage to inserting an Excel spreadsheet is that you can 
use the Excel application to organize and format your table elements. This includes 
utilizing Excel formulas and functions. Once the spreadsheet is filled in, it is displayed in 
the Word document like a standard table. Word refers to the embedded Excel 
spreadsheet as a Worksheet Object. 

Editing a Worksheet Object is a bit different than editing a standard Word table. You 
can still apply basic formatting such as a border around the object. However, if you need 
to edit data or modify the formatting within the table, you can double-click, double-tap, 
or access the properties menu of the Worksheet Object. This will open the object in 
Excel and allow you to edit the content and modify the format of the table. 
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Video 

For more information on inserting a table in Word, review the video 
called Insert a table. 

Activity: Show me how 
This is a teacher-led demonstration to show you the various ways to insert a table in a 
Word document. 

Resources required 
None 

Activity instructions 
Pay close attention as your teacher demonstrates the following tasks. You may follow 
along as your teacher steps through the various methods to create a table in Word. You 
will have a chance to test out your new knowledge on your own after the teacher-led 
demonstration. 

1. Inserting a new table in Word. 

2. Drawing a new table. 

3. Inserting a Quick Table. 

4. Inserting an Excel Spreadsheet into a Word document. 

Try-it: Manually create a table 
 For this set of exercises, you will open an existing document and use several 

methods to insert a table as directed in the following instructions. 

Try-it 1 
Resources 
You will need the following resources for this try-it: 

• Open L1_T1_try1_CSA_potluck_starter.docx in this lesson’s Learning Activity 
Resources. 

  

https://aka.ms/Insert_a_table
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Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. In the space following Fruit items:, use the Table Grid feature to create a table with 
three columns and five rows. 

2. Enter the following text in the table: 

Cookbook Item Produce Category Amount Requested 
Simple Strawberry Preserves Fruit 5 
Blueberry Preserves Fruit 5 
Blackberry Preserves Fruit 3 

Pear Preserves Fruit 3 

Table 2: Fruit items 

3. In the space following Vegetable items:, use the Insert Table dialog box to create a 
table with three columns and four rows. 

4. Enter the following text in the table: 

Cookbook Item Produce Category Amount Requested 
Pickled Beets Vegetable 6 

Pickled Asparagus Vegetable 5 

Pickled Carrots and Peppers Vegetable 5 

Table 3: Vegetable items 

5. Save and close the file. 

Try-it 2 
Resources 
You will need the following resources for this try-it: 

• Open L1_T1_try2_CSA_potluck_list_starter.docx in this lesson’s Learning Activity 
Resources. 
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Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. In the space following …as outlined in the following:, insert a Quick Table based 
upon the Tabular List template. 

2. Modify the table with the following text: 

Cookbook Item Produce Category 
Simple Strawberry Preserves Fruit 
Pickled Beets Vegetable 
Pickled Asparagus Vegetable 

Blueberry Preserves Fruit 

Pickled Carrots and Peppers Vegetable 

Pickled Beets Vegetable 

Blackberry Preserves Fruit 

Pear Preserves Fruit 

Table 4: Potluck items 

3. Save and close the file. 

Try-it 3 
Resources 
You will need the following resources for this try-it: 

• Open L1_T1_try3_CSA_potluck_amounts_starter.docx in this lesson’s Learning 
Activity Resources. 
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Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. In the space following …as outlined in the following:, insert an Excel Spreadsheet. 

2. In Excel, enter the following text: 

S. 
No. 

Cookbook Item Produce 
Category 

Date to be 
delivered 

Amount 
Requested 

1 Simple Strawberry 
Preserves 

Fruit May 20 5 

2 Blueberry Preserves Fruit May 20 5 

3 Blackberry Preserves Fruit May 20 3 

4 Pear Preserves Fruit May 20 3 

5 Pickled Beets Vegetable May 27 6 

6 Pickled Asparagus Vegetable  5 

7 Pickled Carrots and 
Peppers 

Vegetable May 27 5 

8 Total Amount    

Table 5: Potluck items 

3. Place the cursor in cell D9, and then select the Sum tool to automatically add the 
Amount Requested column. 

4. Save and close the file. 

Topic 2: Convert text to table and table 
to text 

 In some situations, you might have a Word document that already contains text 
that you need to format. As you format the content, you may decide that specific text 
might be better presented as a table, or possibly an existing table within the document 
might work better as bulleted or standard text. Instead of deleting and re-writing the 
content, Word provides features to convert existing text to a table or even convert an 
existing table to standard text within the document. 
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Convert text to a table 
When you attempt to convert existing text to a table, for best results it is important to 
ensure that the text is separated by a consistent character used to indicate the intended 
columns and rows in the table. For example, characters commonly used to separate text 
include commas and tab stops. You can also separate text using paragraphs or other 
character types that might be commonly used within your document. 

To convert text to a table, you first need to select the intended text. After the text is 
selected, the Convert Text to Table option is available on the Insert Table ribbon 
command. 

Figure 6 depicts the Convert Text to Table dialog box configured to create two 
columns and two rows. In this example, based upon the selected content, the default 
option is to separate the text based upon commas. Notice that you have other options 
such as paragraphs, tabs, and other symbols. The option that you choose would depend 
upon which type of character is being used to separate the selected text and the desired 
number of columns and rows you would like the text to be converted to. 

 
Figure 6: Convert Text to Table dialog box 

Convert a table to text 
You can easily convert an existing table to text by using the Convert to Text command.  

To convert a table to text, you first need to select the table or simply move the cursor 
anywhere within the table. From the Table tools Layout tab on the ribbon, you can then 
select the Convert to Text option to view the box as depicted in Figure 7. 
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Figure 7: Convert Table to Text dialog box 

You will need to choose which type of character to use to separate the text when the 
table is removed. In this example, the text within the table will be converted and 
separated with tabs in the document. 

 

Did you know? 

On the ribbon, the Table tools Layout and Table Design tabs are 
only displayed when you have a table selected or if the cursor is 
located within a table.  

 

Additional information 

For more information on converting text and table conversion, refer 
to: Convert text to a table or a table to text 

Activity: Pose a challenge 
In this activity, your teacher will present text and table samples, each formatted in a 
different way. Based upon the initial formatting, you will determine what will happen 
when the text is converted to a table and when a table is converted to text. 

https://aka.ms/convert-text-to-a-table-or-a-table-to-text


Inserting and managing tables and lists 
 

 
19 

Resources required 
None 

Activity instructions 
Your teacher will open a sample document with text and tables preformatted. Based 
upon the initial formatting, discuss with the class and determine what will happen in the 
following circumstances: 

1. For sample 1, try to determine how many rows and columns will be created when the 
text is converted to a table using the default settings. 

2. For sample 1, what will happen if you select a different separator character and how 
does this affect the table? 

3. For sample 2, try to determine what will happen when the table is converted to text 
using the default settings. 

4. For sample 2, what will happen if the separator character is changed? 

Try-it: Convert text to table and table to text 
 In each of these exercises, you will open a sample document and practice 

converting existing text to a table and a table to text.  

Try-it 1 
Resources 
You will need the following resources for this try-it: 

• Open L1_T2_try1_CSA_potluck_starter.docx in this lesson’s Learning Activity 
Resources. 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Following the Fruit items heading, use the Convert Text to Table feature to convert 
the next five lines of text to a standard table by using the default settings. 

2. Save and close the file. 
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Try-it 2 
Resources 
You will need the following resources for this try-it: 

• Open L1_T2_try2_CSA_potluck_starter.docx in this lesson’s Learning Activity 
Resources. 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. In the space following the Vegetable items heading, enter the following text using a 
comma to separate the text on each line: 

Cookbook Item, Produce Category, Amount Requested 

Pickled Beets, Vegetable, 6 

Pickled Asparagus, Vegetable, 5 

Pickled Carrots and Peppers, Vegetable, 5 

2. Use the Convert Text to Table feature to convert the text to a standard table by 
using the default settings. 

3. Save and close the file. 

Try-it 3 
Resources 
You will need the following resources for this try-it: 

• Open L1_T2_try3_CSA_potluck_starter.docx in this lesson’s Learning Activity 
Resources. 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Convert the Fruit items table to text separated with tabs. 

2. Convert the Vegetable items table to text separated with commas. 

3. Save and close the file. 
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Topic 3: Navigate tables within a 
document 

 As you become more proficient in Word, you will most likely begin to work in large 
documents that contain many tables. To help you become more efficient in formatting 
larger documents, it is important to understand how to quickly navigate to specific 
locations and objects. Word provides two primary methods for navigating large 
documents: using the Navigation pane and accessing the Go To tab. 

Find tables using the Navigation pane 
The Navigation pane in Word is used for several tasks, such as browsing to styled 
headings, quickly going to specific pages, and displaying search results. To open the 
Navigation pane, enter Ctrl +F on the keyboard, or on the ribbon, select the View tab 
and then select the check box next to Navigation pane.  

 

Did you know? 

To access the Navigation pane, you can also double-click the page 
count area on the status bar. 

As depicted in Figure 8, the Navigation pane contains several Advanced Find, Replace, 
and various navigational features, including the ability to filter and go to objects such as 
graphics, tables, equations, footnotes/endnotes, and comments. 
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Figure 8: Viewing the Navigation pane 

To find tables within a document, select the Tables option in the search menu. The 
Navigation pane then provides directional indicators, which when selected, allow you to 
browse through all the tables located in the document. 

 

Did you know? 

When you select Find, Table in the Navigation pane, the Headings 
section highlights any heading that contains a table. The Pages 
section filters the results to display only the pages that contain tables.  
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Browse tables using the Go To command 
Another method to browse tables in a large document is to use the Go To command. 
You may recall Go To as a tab found on the Find and Replace dialog box as depicted in 
Figure 9. 

 
Figure 9: Find and Replace dialog box with the Go To tab selected 

The Go To command is accessible from the search menu on the Navigation pane. You 
can also access the command by selecting the drop-down menu next to the Find button 
located on the Home tab on the ribbon. 

After selecting the Table option on the Go To tab, you can then use the Next and 
Previous buttons to browse the tables in the document. To browse to a specific table, 
you can enter the table number in the Enter table number field. For example, if you 
want to move to the third table in the document, you can enter 3 in the Enter table 
number field and then select Next. 

 

Did you know? 

For the example mentioned above, if you enter +3 in the Enter table 
number field, you will move forward three tables from your current 
location. If you enter -3 you will move backward three tables from 
your current location. The + and - indicators allow you to jump a 
specified number of objects as needed. 

Activity: Pose a challenge 
In this activity, your teacher will have you open a large document and navigate to 
specific tables as directed. 
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Resources required 
You will need the following resources for this activity: 

• Open L1_T3_act_cookbook_recipes.docx in this lesson’s Learning Activity 
Resources. 

Activity instructions 
As directed and demonstrated by your teacher, find the following table objects: 

1. Find the fifth table in the document. When you find the table, raise your hand. 

2. Go to the second table in the document. When you have placed your cursor in the 
table, raise your hand. 

3. From your current location, go forward four tables. What is the name of the table? 

Try-it: Navigate tables within a document 
 In each of these exercises, you will open a sample document and practice 

navigating tables within the document. 

Try-it 1 
Resources 
You will need the following resources for this try-it: 

• Open L1_T3_try_quarterly_report.docx in this lesson’s Learning Activity Resources. 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. On the Home tab of the ribbon, in the Editing group, select the drop-down arrow 
next to the Find button, and then select Go To. 

2. In the Find and Replace dialog box, on the Go To tab, under Go to what, scroll 
down, and then select Table. 

3. In the Enter table number field, enter 2, and then select Go To. 

4. Delete the number in the Enter table number field. 

5. Select the Previous and Next buttons to navigate the tables. 

6. Close the Find and Replace dialog box. 
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Try-it 2 
Resources 
You will need the following resources for this try-it: 

• Open L1_T3_try_quarterly_report.docx in this lesson’s Learning Activity Resources. 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. On the Home tab of the ribbon, in the Editing group, select the Find button. 

2. In the Navigation pane, select the drop-down arrow (Search for more things 
command) next to the search icon. 

3. In the Find section, select Tables. 

4. Ensure that the Results link is selected, and then use the browse buttons to browse 
the tables in the document. 

5. Select the Pages link to display all pages that contain a table. 

6. Close the Navigation pane. 

Try-it 3 
Resources 
You will need the following resources for this try-it: 

• Open L1_T3_try_quarterly_report.docx in this lesson’s Learning Activity Resources. 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. On the status bar, select the page number indicator to open the Navigation pane. 

2. In the Navigation pane, select the drop-down arrow next to the search icon (Search 
for more things command), and then select Go To. 

3. In the Find and Replace dialog box, on the Go To tab, under Go to what, scroll 
down, and then select Heading. 

4. Select the Next and Previous buttons to browse through the document headings. 
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5. In the Enter heading number field, enter +2 and then select Go To. You move 
forward two headings in the document. 

6. Save and close the file. 

Wrap-up 
Use these questions to check what you learned in this lesson:  

1. Which of the following are valid methods used to insert a table in a Word 
document? 

Select all that apply. 

a. Insert a text box 

b. Convert existing text 

c. Use the drawing tool 

d. Insert a cross-reference 

e. Insert an Excel spreadsheet 

2. You can insert a built-in preformatted table into your document using which of the 
following options? 

Select the correct option. 

a. Insert Table 

b. Draw Table 

c. Insert SmartArt 

d. Quick Tables 

3. In a table, the rectangle that is formed at the intersection of a row and column is 
called a: 

Select the correct option. 

a. Box 

b. Cell 

c. Marker 

d. Cross-reference 
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4. Which of the following ribbon commands can you use to navigate multiple tables 
within a large document? 

Select the correct option. 

a. Home, Find 

b. Review, Next 

c. Review, Compare 

d. View, Side to Side 
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Lesson 2: Modifying tables 
Overview 
Now that you know how to insert a table into a document, you will likely need to modify 
the table in various ways. For example, you might want to re-arrange the content within 
the table, or you may have to resize a cell, column, row, or entire table.  

In this lesson, you learn how to rearrange content within a table by using the Sort 
feature. You also learn how to resize table elements to ensure that the content of the 
table displays as intended to the reader. 

Warm-up 
Your teacher will discuss and introduce the topics to be covered in this lesson. Use these 
questions to find out what you already know about this lesson’s topics: 

1. You need to sort content within a table so that the last name displays lowest to 
highest in alphabetical order. What type of sort order do you use? 

 

2. What is the importance of the Header row in a table? 

 

Topic 1: Sort table data 
 To help readers find data more quickly and effectively, you might choose to sort 

the content in your table. When you sort table data, you are arranging the content 
alphabetically, numerically, or chronologically. Word tables allow you to sort text, 
numbers, or dates in either ascending or descending order. Ascending order refers to 
sorting text from beginning to end, such as from A to Z, 1 to 10, or January to 
December. When you sort a table in descending order, the content is arranged from the 
end to the beginning, such as from Z to A, 10 to 1, or December to January. 
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To help you organize the content to be sorted, you can assign a Header row. The 
header row is usually the first row of the table and contains the headings for each 
column. Specifying the header row will exclude the column titles from being included in 
the sorted content. 

 

Did you know? 

A header row also helps to ensure that the column titles are repeated 
at the beginning of each new page for any table that might extend 
beyond a single page. You can select more than one row to be 
considered a header row if you need to have multiple rows repeated 
across pages. To configure a repeating header row, select the header 
rows to be repeated, and then on the table Layout tab, in the Table 
group, select Properties. The Row tab contains a check box option 
Repeat as header row at the top of each page. 

Figure 10 depicts a table with the first row specified as a header row. Notice that the 
header row contains the headings for each column. You might also choose to format 
the header row differently to distinguish it from the rest of the table content. 

 
Figure 10: Table with Header row 

Sort a table 
To sort content within a table, place the cursor in a table cell to display the Table 
Design and Layout tabs on the ribbon. After selecting the Layout tab, the Sort button 
is found in the Data section of the ribbon. 

Select the Sort button to display the dialog box as depicted in Figure 11. In this 
example, the sort feature automatically detected the header row and filled in the 
Customer Type field to sort in Ascending order. 
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Figure 11: Sort dialog box 

The Sort feature can sort by a maximum of three columns at a time in ascending or 
descending order. If needed, you can also modify the type of content to be sorted to 
match either Text, Number, or Date formats. If you have column headings that should 
not be part of the sort, be sure to select Header row to ensure that the headings are 
ignored. 

 

Additional information 

For more information on sorting table data, go to: Sort the contents of 
a table 

Activity: Guess and show 
This is a teacher-led discussion and demonstration about how to sort data within a 
Word table. 

Resources required 
None 

  

https://aka.ms/Sort-the-contents-of-a-table
https://aka.ms/Sort-the-contents-of-a-table
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Activity instructions 
Your teacher will open a document that contains a table that requires sorting. You will 
discuss with the class the best sort options to view the table. Your teacher will then 
demonstrate how to sort the table based upon the classroom discussion. After this 
activity, you will have a chance to test out your new knowledge on your own. 

1. Reviewing at the table in the demonstration, what are the best ways to sort and 
display the data? 

2. Which column or columns would you sort by? 

3. Is a Header row needed? What happens if you do not specify the Header row? 

Try-it: Sort table data 
 For this set of exercises, you will open an existing document and sort tables as 

directed in the following instructions. 

Try-it 1 
Resources 
You will need the following resources for this try-it: 

• Open L2_T1_try1_CSA_potluck_starter.docx in this lesson’s Learning Activity 
Resources. 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Sort the Fruit and Vegetable items table by the Cookbook Item column in 
ascending order. Be sure to specify a Header row. 

2. Save and close the file. 

Try-it 2 
Resources 
You will need the following resources for this try-it: 

• Open L2_T1_try2_CSA_potluck_starter.docx in this lesson’s Learning Activity 
Resources. 
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Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Sort the Fruit and Vegetable items table by the Cookbook Item column in 
ascending order. 

2. Specify a secondary sort based upon Amount requested in ascending order. Be sure 
to specify a Header row. 

3. Save and close the file. 

Topic 2: Resize cells, columns, rows, 
and tables 

 As you work with tables in a document, adjustments are almost always necessary 
to present the table as intended. For example, you may need to resize a column or row, 
or adjust the size of a cell to better fit the content. Word provides both manual and 
automated methods for resizing table elements during your editing process. 

Manually resize columns, rows, and tables 
Using a table in your document will help organize content in a more structured format. 
However, you need to determine how the content will be presented to make it easy to 
interpret and read throughout the document. For example, will text be permitted to 
wrap within the cell, or is the column or row large enough to fit the text on a single line?  

One method commonly used to resize a column or row is to use the mouse or other 
input device pointer and drag the Column or Row markers. As depicted in Figure 12, the 
markers are located on the horizontal and vertical rulers and are displayed when the 
cursor is placed anywhere within the table. 

 
Figure 12: Row and Column markers 
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Placing the mouse or input device pointer on one of the markers will turn the pointer to 
a double-headed arrow. You can then drag the pointer to resize the column or row 
being edited. 

The ribbon also contains several options that you can use to resize the height and width 
of table elements. As you modify a table, the Layout tab displays editing tools as 
depicted in Figure 13. The tools outlined in a box are used to select and then modify the 
height and width of a cell, column, row, or entire table. 

 
Figure 13: Modifying the height and width of table elements 

Automate fit and distribution of content in a table 
Often it takes excessive time to manually edit the size of columns and rows in a table. 
For example, you may want to ensure that each column or row is set to the same size, or 
you may want to ensure that columns are always sized to perfectly display the content 
in a cell. 

The table editing tools on the ribbon include features to help automate the size of a 
column or row depending upon its content or window size: 

• AutoFit—Provides three options that determine how a column or table fits content: 
o AutoFit Contents—When you select this option, the table columns automatically 

adjust to fit the size of the content. Each column will adjust to fit the largest text 
entry in the column. 

o AutoFit Window—This option configures the table to automatically fit within the 
margins in Print Layout view. If you change to Web Layout view, the table 
automatically fits within the size of the window. 

o Fixed Column Width—This option turns off the AutoFit feature so that the table 
or column width is not automatically adjusted based upon window or content 
size. 

• Distribute Columns—You can make table columns the same size by first selecting 
the table or individual columns and then selecting the Distribute Columns button. 
This command evenly distributes the columns to fit within the selection. 

• Distribute Rows—Similar to the Distribute Columns button, this command evenly 
distributes rows to fit within the selection. 
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Configure cell alignment, margins, and spacing 
As you enter content in a table cell, you might be tempted to use a hard return to add 
space above and below the text. You might also use the space bar to line up text in cells 
within a table column. Both actions tend to add unnecessary paragraphs and spaces that 
often cause problems and frustration while editing the document. A better solution is to 
use table options that will control alignment, margins, and spacing for cell content 
within a table. 

To modify the space or alignment for cell content, use the tools found in the Alignment 
group on the table tools Layout tab of the ribbon. As depicted in Figure 13, the 
Alignment group contains: 

• Alignment buttons—These are used to align the text in top, center, and bottom 
alignment configurations. 

• Text direction buttons—These are used to change the direction of the text within the 
cell. 

• Cell margins—These are used to modify the default margins within each cell of the 
table. You can also increase the spacing between each cell to help increase space 
between the column and rows. Figure 14 depicts the Table options for modifying 
default cell margins and cell spacing. 

 
Figure 14: Configuring cell margins and spacing 
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Did you know? 

Any settings that you modify for the cell margins and alignment only 
affect the active table. All subsequent tables that you insert will use 
the default table settings. 

 

Additional information 

For more information on resizing table and cell elements, go to: 
Resize a table, column, or row 

Activity: Show me how 
This is a teacher-led demonstration about the various ways to resize columns, rows, 
cells, and tables in a Word document. 

Resources required 
None 

Activity instructions 
Pay close attention as your teacher demonstrates the following tasks. You may follow 
along as your teacher steps through the various methods to modify a table in Word. 
You will have a chance to test out your new knowledge on your own after the teacher-
led demonstration. 

1. Manually resize columns, rows, and tables. 

2. AutoFit content in a table. 

3. Modify cell alignment, text direction, and cell margins. 

Try-it: Resize cells, columns, rows, and tables 
 In each of these exercises, you will open a sample document and practice resizing 

cells, columns, rows, and tables. 

  

https://aka.ms/Resize-a-table-column-or-row
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Try-it 1 
Resources 
You will need the following resources for this try-it: 

• Open L2_T2_try1_CSA_potluck_starter.docx in this lesson’s Learning Activity 
Resources. 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Resize the columns for the Fruit items table. Ensure that the column headings do 
not wrap to the next line. 

2. Save and close the file. 

Try-it 2 
Resources 
You will need the following resources for this try-it: 

• Open L2_T2_try2_CSA_potluck_starter.docx in this lesson’s Learning Activity 
Resources. 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. For the Vegetable items table, use the table Layout tab on the ribbon to resize the 
width for the Cookbook Item column. All text in the Cookbook Item column should 
be on a single line. 

2. Use the AutoFit Contents feature to fit all content in the Vegetable items table. 

3. Evenly distribute the columns for both the Fruit items and Vegetable items tables. 

4. Save and close the file. 

Try-it 3 
Resources 
You will need the following resources for this try-it: 

• Open L2_T2_try3_CSA_potluck_starter.docx in this lesson’s Learning Activity 
Resources. 
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Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. For both Fruit items and Vegetable items tables, configure the numbers to be 
Align Top Center. 

2. For the Fruit items table, adjust the top and bottom cell margins to be 0.1". 

3. For the Vegetable items table, adjust the default cell spacing to be 0.05". 

Wrap-up 
Use these questions to check what you learned in this lesson:  

1. Which of the following options do you use to ensure that people can correctly 
observe the full table in the Web Layout view? 

Select the correct option. 

a. AutoFit Window 

b. AutoFit Contents 

c. Fixed Column Width 

d. Align Center 

2. Sorted data can consist of which of the following? 

Select all that apply. 

a. Text 

b. Numbers 

c. Dates 

d. Symbols 

3. In a table, how many columns can you sort at a time? 

Select the correct option. 

a. 2 

b. 3 

c. 1 

d. Unlimited 
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4. What do you call the first row of a table that identifies the data in the column? 

Select the correct option. 

a. Header row 

b. Header column 

c. Split row 

d. Sorted row 

5. You can insert a built-in preformatted table into your document using which of the 
following options? 

Select the correct option. 

a. Insert Table 

b. Draw Table 

c. Insert SmartArt 

d. Quick Tables 

6. In a table, what do you call the rectangle that the intersection of a row and column 
forms? 

Select the correct option. 

a. Box 

b. Cell 

c. Marker 

d. Cross-reference 

7. Which of the following ribbon commands can you use to navigate multiple tables 
within a large document? 

Select the correct option. 

a. Home, Find 

b. Review, Next 

c. Review, Compare 

d. View, Side to Side 
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Lesson 3: Merging and splitting 
table elements 
Overview 
In addition to resizing table elements and modifying cell spacing, there may be times 
that you need to split or merge cells to make the content fit a specific way in the table. 
You may also need to add or remove columns or rows from a table. 

At the beginning of this lesson, you learned additional formatting techniques such as 
merging and splitting cells and tables. The final topic of this lesson covers the tasks of 
adding or removing columns or rows from tables. 

Warm-up 
Your teacher will discuss and introduce the topics to be covered in this lesson. Use these 
questions to find out what you already know about this lesson’s topics: 

1. When would you want to merge cells within a table? 

 

2. You can only split a table cell into multiple columns. Is this a true statement? 

 

3. What are your four options for inserting rows and columns into a table? 
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Topic 1: Merge and split cells and 
tables 

 As you design and create tables in a Word document, you often need to combine 
and merge two or more cells into a single larger cell. For example, you may want to 
merge an entire row of cells into a single larger cell to display a table heading. 

The first step to combining multiple cells is to select two or more adjacent cells to be 
merged. After the cells are selected, the Merge Cells button is enabled on the table 
Layout tab on the ribbon as depicted in Figure 15. 

 
Figure 15: Merge group on the table Layout tab 

After you select the Merge Cells button, the selected cells combine into a single larger 
cell. All cell content is retained and separated with a paragraph hard return. 

Split cells 
When you split a cell, you are dividing one cell into multiple evenly sized cells. To split a 
cell, place the cursor in the cell to be divided. If you want to split multiple cells, you can 
select the cells first and then select the Split Cells button on the ribbon. 

As depicted in Figure 16, the Split Cells dialog box provides options to specify into how 
many columns and rows you would like to split the selected cells. The Merge cells 
before split option is only available when you select more than one cell in the table. 
This option treats the selection as if it was a single cell and then splits the merged cells 
as indicated in the Number of columns and Number of rows settings. 
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Figure 16: The Split Cells dialog box 

 

Did you know? 

You can also use the drawing tools to merge and split cells. If you 
want to split a cell, use the Draw Table tool to draw a line where you 
want the split to take place. The Eraser tool can be used to remove 
lines, essentially merging two cells together. 

Split tables 
There may be instances where a larger table might need to be split into two tables. To 
split a table, place the cursor into the row that you want to split away from the rest of 
the table. The row that you select becomes the first row of the new table. 

As depicted in Figure 15, select the Split Table button to split the table into two 
separate tables. 

 

Video 

To review the video on merging and splitting table cells, go to: Merge 
and split table cells in Word 

Activity: Show and Tell 
This is a teacher-led discussion and demonstration about how to merge and split cells 
within a table. Your teacher will also demonstrate how to split a table into two separate 
tables. 

https://aka.ms/Video-Merge-and-split-table-cells-in-Word
https://aka.ms/Video-Merge-and-split-table-cells-in-Word
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Resources required 
None 

Activity instructions 
Your teacher will open a document that contains a table. Your teacher will then perform 
and explain the steps to complete the following tasks: 

1. Merge multiple cells across a row to make a table header. 

2. Split a selected cell into multiple cells. 

3. Split the table into two tables. 

Try-it: Merge and split cells and tables 
 For this set of exercises, you will open an existing document and merge and split 

cells and tables as directed in the following instructions. 

Try-it 1 
Resources 
You will need the following resources for this try-it: 

• Open L3_T1_try1_CSA_potluck_starter.docx in this lesson’s Learning Activity 
Resources. 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. In the Fruit and Vegetable items table, merge the first row and then center the 
heading. 

2. Under the Amount Requested/Received column, split the cells into two columns 
and seven rows. Do not merge cells before split. 

3. Save and close the file. 
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Try-it 2 
Resources 
You will need the following resources for this try-it: 

• Open L3_T1_try2_CSA_potluck_starter.docx in this lesson’s Learning Activity 
Resources. 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Sort the table by Produce Category in ascending order. Be sure to select a Header 
row. 

2. Split the table at the first Vegetable entry (row 6). 

3. In the space following the first table, enter Vegetable items: for the second table. 

4. Copy the formatting from the Fruit items text to the Vegetable items text. 

5. Save and close the file. 

Topic 2: Insert and delete rows and 
columns 

Working with tables in Word, you will find that one of the most common editing 
tasks is inserting or deleting rows and columns. Often you may find that your table is 
too small to fit all the content that you are entering, or you may have defined too many 
rows or columns when you first created the table. For both scenarios, Word provides 
simple methods to add and remove rows and columns to existing tables. 

Insert a new row or column 
Like most options in Word, you have a choice of several ways to insert or delete rows 
and columns in a table. Methods include: 

• The Rows & Columns commands found on the Layout tab of the ribbon. 
• The Insert and Delete commands on the Mini Toolbar. 
• The Insert controls located next to the row or column. 
After selecting a row or column, or placing the cursor within a cell, select the table 
Layout tab to access the Rows & Columns commands. 
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As depicted in Figure 17, commands are available to perform four primary insertion 
tasks: Insert Above, Insert Below, Insert Left, and Insert Right. A new column or row 
is inserted depending upon which command is selected. 

The Delete button, when selected, provides several additional options such as Delete 
Cells, Delete Columns, Delete Rows, and Delete Table. 

 
Figure 17: Rows & Columns group on the Layout tab 

The Mini Toolbar is also commonly used to perform editing tasks such as inserting and 
deleting rows and columns. To access the toolbar, right-click or access the context menu 
in a table cell next to where you want to add a row or column. As depicted in Figure 18, 
the Mini Toolbar displays to allow you to perform several editing tasks, including the 
ability to insert and delete columns and rows. 

 
Figure 18: The Mini Toolbar showing the Insert and Delete buttons 

An Insert Control object is displayed when you move the mouse or other input device 
pointer just above or to the left of two columns or rows. As depicted in Figure 19, when 
you select the “plus sign”, a new column or row will be inserted at the location indicated 
by the Insert Control object. 

 
Figure 19: Insert Control object used to insert a new row 
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Did you know? 

You can insert more than one row or column at the same time by first 
selecting multiple rows or columns. When you select the insert 
command, the same number of empty rows or columns will be 
created in the table. 

Activity: Show me how 
This is a teacher-led demonstration about the various ways to insert and delete rows 
and columns in a Word document. 

Resources required 
None 

Activity instructions 
Your teacher will demonstrate how to insert rows and columns in a table. You may 
follow along as your teacher steps through the various methods. You will have a chance 
to test out your new knowledge on your own after the teacher-led demonstration. 

1. Use the ribbon and Mini Toolbar to insert and delete rows and columns. 

2. Insert rows and columns using the Insert Control object. 

Try-it: Insert and delete rows and columns 
 In this activity, you will practice inserting and deleting rows and columns in a 

table. 

Resources 
You will need the following resources for this try-it: 

• Open L3_T2_try_CSA_potluck_starter.docx in this lesson’s Learning Activity 
Resources. 
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Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. For both tables, insert a new row at the start of each table. 

2. For the Fruit Items table, move the Fruit items text into the first cell of the first row. 

3. For the Vegetable Items table, move the Vegetable items text into the first cell of 
the first row. 

4. For the Vegetable Items table, insert a new row under the Vegetable items 
heading. 

5. Copy the column headings from the Fruit Items table to the Vegetable Items table. 

6. For both tables, delete the Amount requested columns. 

Wrap-up 
Table 6 depicts a customer table. Use this table to answer the following questions. 

Customer Type City State  Number 

Wholesale Atlanta GA 140 

Retail Springfield MO 232 

Retail Portland OR 138 

Wholesale Mesa AZ 97 

Table 6: Customer table 

1. You need to insert a new column between the Customer Type and City fields. You 
select the cell that contains the text Wholesale. Which command would you select to 
insert the new column? 

Select the correct option. 

a. Insert Above 

b. Insert Below 

c. Insert Left 

d. Insert Right 
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2. You decide to have the Customer Table heading span across all four columns. What 
two tasks must you do? 

Select all that apply. 

a. Highlight the row that starts with Wholesale 

b. Highlight the row that starts with Customer Table 

c. Select the Merge Cells command 

d. Select the Insert Above command 

3. You have been asked to resize the table columns to minimize the amount of white 
space in each cell. What should you do? 

Select the correct option. 

a. Select the table and then select the Distribute Rows command 

b. Select the table and then select the AutoFit Contents command 

c. Select the table and then select the Distribute Columns command 

d. Select the table and then select the Align Center command 

4. You need to remove the row with the Portland entry and customer number 138. 
Which of the following commands do you select? 

Select the correct option. 

a. Delete Rows 

b. Delete Columns 

c. Delete Table 

d. Delete Cells 

5. True or False? You can use the Eraser to merge cells. 

Select the correct option. 

a. True 

b. False  
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Lesson 4: Creating and 
Modifying Lists 
Overview 
Using lists in documents can be an effective way organize information and make it 
easier for readers to understand key points. In this lesson, you learn how to create 
bulleted and numbered lists. You also learn how to modify the lists so that the bullet 
characters and number format match the style of the document you are creating. Finally, 
you learn how to create and format multilevel lists commonly used in document 
outlines. 

Warm-up 
Your teacher will discuss and introduce the topics to be covered in this lesson. Use these 
questions to find out what you already know about this lesson’s topics: 

1. Provide some common examples of when you would create a list in a document. 

 

2. When would you use a bulleted list as opposed to a numbered list? 

 

3. What is a multilevel list? 
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Topic 1: Create lists and apply formats 
 Using a list is an efficient way to organize content and provide concise details that 

might otherwise be confusing if written in paragraph format. For example, step-by-step 
instructions work best in a list format so that the reader can easily follow the steps to 
perform a task. 

You have the option of formatting existing text as a list, or you can create a list as you 
enter information into the document. Lists can be formatted with bullets, numbers, or a 
mixture of both. 

Create and manage bulleted lists 
Formatting text as a bulleted list is an effective way to organize points that do not have 
to appear in any specific order. Each list item is marked by a small symbol such as a dot, 
diamond, check box, and so on. Word provides a library of bullet characters that you can 
customize based upon symbols, pictures, and fonts. 

To create a bulleted list, select the text to be formatted, and then on the Home tab, in 
the Paragraph group, select the Bullets command. By default, a standard round bullet 
is used. If you want to choose or change to a different symbol, you can select the 
Bullets arrow to display the Bullet Library, where there are several options to choose 
for bullet symbols. 

Figure 20 depicts the Bullet Library with bullets that can be selected and used in 
bulleted lists. 

 
Figure 20: Bullet Library 
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Did you know? 

If you enter an asterisk (*) at the beginning of a paragraph and then 
press the spacebar or tab key, the paragraph automatically formats as 
a bulleted list. As you enter text and press Enter, each item is 
formatted as part of the bulleted list. To end the list, you can simply 
press Enter twice. 

Defining custom bullets 
The Bullet Library contains the most commonly and recently used bullet symbols. 
However, you may want to use a specific symbol or picture for the items in your bulleted 
list. The Define New Bullet command, located in the Bullet Library dialog box, is used 
to provide alternate symbols or pictures which can be used for your bulleted list. 

Figure 21 depicts the Define New Bullet dialog box with the Bullet character option 
displaying the Symbol font, which is commonly used for specifying custom bullets. 

 
Figure 21: Define New Bullet dialog box 
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Create and manage numbered lists 
A numbered list is typically used to organize points that need to appear in a specific 
order or progressive structure. Similar to bullets, you can either apply a number format 
to existing text, or you can automatically create a numbered list as you enter text or 
numbers. 

To create a standard numbered list, select the text to be formatted, and then on the 
Home tab, in the Paragraph group, select the Numbering command. The numbering 
format can also be specified by selecting the Numbering arrow and then choosing the 
desired format from the options available in the Numbering Library as depicted in 
Figure 22. 

 

Did you know? 

If you enter the number 1 followed by a period (1.) at the beginning 
of a paragraph and then press the spacebar or tab key, the paragraph 
automatically formats as a standard numbered list. As you enter text 
and press Enter, each additional list item is formatted as part of the 
sequential numbered list. Press Enter twice to end the list. 

 
Figure 22: Numbering Library 
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The Numbering Library includes formats related to standard numbers, letters, and 
roman numerals. 

Defining a custom numbering format 
If the default number styles do not fit the theme of your document, you can select the 
Define New Number Format option. This option provides additional number styles 
and provides the ability to change the font of the number format. 

Figure 23 depicts an example of the Define New Number Format dialog box. Notice 
that you have a variety of numbering-related styles that can be selected to best fit with 
your document. 

 
Figure 23: Define New Number Format dialog box 

Modifying the numbering value 
As you work with numbered lists, you have the choice to continue the numbering 
format from the previous list, restart the numbering for each new list, or you can specify 
a specific number value to begin the list of items. 

From the Numbering Library, select the Set Numbering Value option. This option 
opens the dialog box as depicted in Figure 24. In this example, numbering is configured 
to start a new list with the starting number value set to 4. 
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Figure 24: Set Numbering Value dialog box 

The Set Numbering Value dialog box provides the following options that can be 
configured for your numbered list: 

• Start new list—Used to separate the new list from the previous list and start 
numbering based upon the Set value to option. 

• Continue from previous list—Maintains the connection to and sequential 
numbering of a previous list in the document. The Advance value (skip numbers) 
option maintains the connection to a previous list and provides the option to set a 
greater starting number for the new list. 

• Set value to—Used to set the starting number for a new list or a continued list with 
the Advance value (skip numbers) option selected. 

 

Did you know? 

To quickly restart a numbered list, right-click or access the context 
menu on the number of the first list item that you want to change, 
and then select Restart at 1. Alternatively, to continue a numbered 
list format, right-click or access the context menu on the first list 
item, and then select Continue Numbering. 

 

Video 

To review the video on creating a bulleted or numbered list, go to: 
Create a bulleted or numbered list 

  

https://aka.ms/Create_a_bulleted_or_numbered_list
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Activity: Show and Tell 
This is a teacher-led discussion and demonstration about how to apply bullets and 
numbering in a document. 

Resources required 
None 

Activity instructions 
Your teacher will open a document and perform and explain the steps to complete the 
following tasks: 

1. Apply standard bullets to existing text. 

2. Change the bullets. 

3. Create and manage numbered lists. 

4. Reset and continue numbered lists. 

Try-it: Create lists and apply formats 
 For this set of exercises, you will open an existing document and create lists and 

apply formats as directed in the following instructions. 

Try-it 1 
Resources 
You will need the following resources for this try-it: 

• Open L4_T1_try1_cleaning_instructions_starter.docx in this lesson’s Learning 
Activity Resources. 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. In the space following ….complete the following check list before leaving your 
garden area, enter 1 followed by a period (.) and then press Tab to start the 
numbering format. 

2. Enter the following text after the 1.: 

All garden tools to be returned and checked in to the main toolshed. 
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3. Press Enter to display 2, and then enter the following text: 

Weeding refuse and unwanted produce to be placed in the compost area. 

4. Continue adding the next three lines of text as lines 3–5 in the document: 

Irrigation faucets turned off in your garden area. 
Paths are raked of any excess footprints. 
Garbage is picked up and placed in appropriate containers. 

5. Use the Numbering Library to change the numbered list to be small letters 
followed by a period; for example, “a.”. 

6. Save and close the file. 

Try-it 2 
Resources 
You will need the following resources for this try-it: 

• Open L4_T1_try2_produce_list_starter.docx in this lesson’s Learning Activity 
Resources. 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Following the Apples for eating heading, apply a standard number format to the 
apples listed. 

2. Following the Apples for cooking heading, apply a standard number format to the 
apples listed. 

3. Following the Apples for cooking heading, configure the number format to 
Continue Numbering from the previous list. 

4. Following the Pears heading, apply a standard letter format to the pears listed. 

5. Following the Apples for cooking heading, configure the number format to Restart 
at 1. 

6. Following the Pears heading, change the number format for the pear items to a 
bullet format with a check-mark symbol. 

7. Save and close the file. 
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Topic 2: Create and format multilevel 
lists 

A multilevel list is often used in documents that have a logical hierarchy of items or 
titles. Examples of where you might use a multilevel list include documents such as 
meeting agendas, meeting minutes, and document outlines. Organizing document 
headings using multiple levels can also assist in navigating through the document and 
creating a table of contents based upon the multiple levels being applied throughout 
the document. 

Figure 25 depicts an illustration of how multilevel lists might be organized in a 
document. Word supports from one to nine levels, each formatted in an indented 
subordinate manner. 

 
Figure 25: Multilevel list 

Create a multilevel list 
To create a multilevel list, you can either select existing text or you can enable the 
multilevel format to create list levels as you enter text or numbers. On the ribbon, select 
the Multilevel list button found on in the Paragraph group of the Home tab. 

Similar to standard bullets and numbering, the Multilevel list button displays a library of 
several types of multilevel lists that you can use in your document. 

As depicted in Figure 26, you can select from several options available in the List 
Library. You can also define a new multilevel list that provides more granular control on 
how your list is formatted in the document. 
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Figure 26: Multilevel list library 

Work with a multilevel list 
After you select and enable a multilevel list format from the library, by default the Level 
1 format applies to each list item that you enter. If a subsequent list item needs to be 
formatted at a subordinate level, such as Level 2 or 3, the following commands can be 
used: 

• Increase Indent—This command is found in the Paragraph group on the Home tab 
of the ribbon. The Increase Indent button will indent the item toward the right 
margin and apply the appropriate number format as defined in the multilevel 
settings. 

• Tab key—The Tab key on the keyboard is a quick and useful way to increase the 
indent and apply the next level format for the multilevel list. 
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Alternatively, if you need to format the level of a subordinate item to a higher-level list 
item, for example back to Level 1, use the following command: 

• Decrease Indent—This command is found in the Paragraph group on the Home 
tab of the ribbon. The Decrease Indent button will move the item toward the left 
margin and apply the appropriate number format as defined in the higher level of 
the multilevel settings. 

• Shift Tab keys—Press the Shift and Tab keys together on the keyboard to move the 
list item towards the left margin and apply the higher-level format for the multilevel 
list. 

Define a new multilevel list 
Although the List Library contains a sufficient variety of multilevel list formats, you may 
still want to customize your list to match the theme of your document. For example, you 
might want to define the number format or style for a specific level. Or you might need 
to adjust the alignment or text indentation for all of the levels of the entire list. 

On the List Library menu, select the Define New Multilevel List option to display the 
settings as depicted in Figure 27. 

 
Figure 27: Define new Multilevel list dialog box 
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Some of the more relevant options are described as follows: 

• Click level to modify—You can modify any of the one to nine levels of the 
multilevel list. Select the list level that you want to modify, as most of the remaining 
options will relate to the level selected. 

• Enter formatting for number—The Number format section allows you to specify 
how you would like the number to appear. For example, do you want to include a 
dot or dash with the number? You can also select the Font button to specify a 
specific font format for the number. 

• Number style for this level—This option allows you to specify how you would like 
the numbers at this level to display. For example, you can select standard numbers, 
roman numerals, letters, or any other bullet symbol that you specify. Note that this 
will only affect the level that you have selected at the top of the dialog box. 

• Position—The Position section contains several options such as number alignment 
and the amount of indent for the level. You can also select the Set for All Levels 
button to specify the position settings globally for the entire list. 

 

Additional information 

For more information on bullets, numbers, and multilevel lists, go to: 
Define new bullets, numbers, and multilevel lists 

Activity: Pose a challenge 
In this activity, your teacher will present a document with various headings and sub-
headings. After analyzing the document, you will direct your teacher to apply various 
levels to help organize and format the document in a logical order. 

Resources required 
None 

Activity instructions 
Your teacher will open a sample document. Based upon the initial formatting, discuss 
with the class and determine what will happen in the following circumstances: 

1. Which items of the list should be assigned a Level 1 heading? 

2. Which items of the list should be assigned a Level 2 heading? 

3. Which items of the list should be assigned a Level 3 heading? 

4. You decide to change the format of the list to contain bullets for the Level 3 
headings. What can you do? 

https://aka.ms/Define-New-Bullets-Numbers-and-Multilevel-Lists
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Try-it: Create and format multilevel lists 
 For this set of exercises, you will open an existing document and then create 

multilevel lists and apply formats as directed in the following instructions. 

Try-it 1 
Resources 
You will need the following resources for this try-it: 

• Open L4_T2_try1_location_list_starter.docx in this lesson’s Learning Activity 
Resources. 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. On page 2, place the cursor in the space following ….upon the types of produce 
you are bringing to the potluck. 

2. On the Home tab of the ribbon, select the Multilevel List button and apply the first 
multilevel list. 

3. Next to the 1, enter North entrance and then press Enter. 

4. Press Tab, enter Gate 1, and then press Enter. (Note: You can also use the Increase 
Indent button on the ribbon.) Gate 1 is now a second-level list item that uses a 
lower-case letter (a) as its numbered bullet. 

5. Press Tab, enter Product, and then press Enter. Product is now a third-level list item 
that uses a lower-case roman numeral (i) as its numbered bullet. 

6. Press Tab, enter Blackberry Preserves, and then press Enter. Blackberry Preserves is 
now a fourth-level list item that uses numbers (1) as its numbered bullet. 

7. Enter Blueberry Preserves, and then press Enter. 

8. In the ribbon, select the Decrease Indent button two times to change the level to 
level two, which uses a lower-case letter (b). (Note: you can also press Shift+Tab on 
the keyboard.) 

9. Repeat the above steps to create the multilevel list as depicted in Figure 28. 
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10. Save and close the file when complete. 

 
Figure 28: Multilevel list 

Try-it 2 
Resources 
You will need the following resources for this try-it: 

• Open L4_T2_try2_location_list_starter.docx in this lesson’s Learning Activity 
Resources. 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. On page 2, place the cursor anywhere in the multilevel list. 

2. Use the Multilevel list library to change the list using the symbol format. Level 1 
should use a diamond symbol, Level 2 should use an arrow symbol, Level 3 should 
use a square symbol, and Level 4 should use a circle symbol, as depicted in Figure 
29. 

3. Save and close the file when complete. 
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Figure 29: Multilevel list with symbol bullets 

Try-it 3 
Resources 
You will need the following resources for this try-it: 

• Open L4_T2_try3_location_list_starter.docx in this lesson’s Learning Activity 
Resources. 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. On page 2, place the cursor anywhere in the multilevel list. 

2. Use the Define New Multilevel List option to customize the list. Level 3 should use 
a circle symbol, and level 4 should use a check mark symbol as depicted in Figure 30. 
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3. Save and close the file when complete. 

 
Figure 30: Customized multilevel list 

Wrap-up 
Use these questions to check what you learned in this lesson:  

1. You need to configure a specific symbol as a bullet in a list item. Which command 
would you choose to perform this task? 

Select the correct option. 

a. Define new bullet 

b. Define new number format 

c. Change list level 

d. Define new list style 
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2. You want to quickly change the list level of a line from Level 1 to Level 2. Which 
shortcut command do you select on the keyboard? 

Select the correct option. 

a. Ctrl+Tab 

b. Alt+Tab 

c. Shift+Spacebar 

d. Tab 

3. How many levels can you specify for a multilevel list? 

Select the correct option. 

a. 2 

b. 9 

c. 7 

d. 5 

4. You are editing a document that contains three separate lists of content. You need 
to ensure that the last list begins at number 5. What two tasks would you perform? 

Select all that apply. 

a. Select Set Numbering Value 

b. Select Change List Level 

c. Select Start new list 

d. Select Continue from previous list 
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Glossary 
Column In a Word table, the cells that reside in the vertical direction. 

Row In a Word table, the cells that reside in a horizontal direction. 

Cell The rectangle that is formed at the intersection of a row and column. 

End of cell marker In Word, when the Show/Hide button is enabled, the square that 
indicates the end of a cell. 

End of row marker In Word, when the Show/Hide button is enabled, the square that 
indicates the end of a row. 

Column marker Located on the horizontal ruler, the solid square that indicates where 
the column margins reside. 

Row marker Located on the vertical ruler, the solid square that indicates where 
the row margins reside. 

Header row The first row in a table that usually contains column headings. 

Table 7: Glossary terms and definitions 
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Cornerstone 
Overview 
To prepare for the upcoming spring CSA programs and events, you have been asked to 
prepare two of the supporting documents. You need to create and apply table and list 
formatting for the Munson's Spring CSA Member's Product Box letter and the 
Munson's CSA Member's Produce Seminar event schedule. 

Objectives 
The following table outlines the Cornerstone objectives and their corresponding MOS 
exam objectives. 

Create a table in 
Word 

• 3.1.3: Create tables by specifying rows and columns 

Convert text to 
tables and tables 
to text 

• 3.1.1: Convert text to tables 
• 3.1.2: Convert tables to text 

Sort data in a table • 3.2.1: Sort table data 
• 3.2.6: Configure a repeating row header 

Resize table 
elements to fit 
content 

• 3.2.2: Configure cell margins and spacing 
• 3.2.4: Resize tables, rows, and columns 

Merge and split 
table elements 

• 3.2.3: Merge and split cells 
• 3.2.5: Split tables 

Create and modify 
a bulleted list 

• 3.3.1: Format paragraphs as numbered and bulleted lists 
• 3.3.2: Change bullet characters and number formats 
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Create and modify 
a numbered list 

• 3.3.1: Format paragraphs as numbered and bulleted lists 
• 3.3.2: Change bullet characters and number formats 
• 3.3.4: Increase and decrease list levels 
• 3.3.5: Restart and continue list numbering 
• 3.3.6: Set starting number values 

Create and modify 
a multilevel list 

• 3.3.1: Format paragraphs as numbered and bulleted lists 
• 3.3.3: Define custom bullet characters and number 

formats 
• 3.3.4: Increase and decrease list levels 

Table 8: Cornerstone objectives 

Duration 
50 minutes 

Instructions 
1. Complete the tasks below for each file. 

2. When saving your file, add your name to the end of the filename; for example, 
“Cornerstone_producebox_Dwayne_Espino.docx”. Follow your teacher’s directions for 
where to save your files. 

3. When you’re done with the Cornerstone, assess your completion and enter the 
points you think you earned within the task lists below. You can use the help of your 
teacher if required. 

Tasks 
You will work with two files in this Cornerstone. The following are the tasks you need to 
do within each file. 
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File 1: Cornerstone_produce_box_starter.docx 
Task: Create a table in Word (5 points) 
1. Start Word and open Cornerstone_produce_box_starter.docx. Following the 

heading April produce box, insert a blank table that contains 4 columns and 8 rows. 
(2 points) (Exam objective 3.1.3) 

2. Enter the following text in the April produce box table (2 points): 

Produce Category Produce Type Produce Variety Number in Box 

Fruits Apples McIntosh 24 

Vegetables Cucumbers Persian 10 

Fruits Pears Concord 10 

Vegetables Potatoes Russet 30 

Produce Eggs White 24 

Vegetables Beets Red 10 
Produce Honey Clover 4 

Table 9: April produce box table 

3. Select the table and apply a 12pt Cambria font to the text. Select the first row 
starting with Produce Category and make the text bold to indicate the headings for 
each column. (1 point) 

Points scored: ______ / 5 

Task: Convert text to tables and tables to text (5 points) 
1. Following the heading May produce box, select the following 8 lines of text and 

convert the text to a table. Select the most appropriate separator which will result in 
a table with 4 columns and 7 rows. (2 points) (Exam objective 3.1.1) 

2. Select the first row starting with Produce Category and make the text bold to 
indicate the headings for each column. (1 point) 

3. After the text …on the following dates, select the table and then convert the table 
to text separated by tabs. (2 points) (Exam objective 3.1.2) 

Points scored: ______ / 5 
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Task: Sort data in a table (5 points) 
1. Sort the April produce box table by Produce Category in ascending order. Be sure 

to retain the column headings. (1 point) (Exam objective 3.2.1) 

2. Sort the May produce box table by Produce Category and then by Produce Type 
in ascending order. Be sure to retain the column headings. (1 point) (Exam objective 
3.2.1) 

3. Sort the June produce box table by Produce Category and then by Produce Type 
in ascending order. Add a third sort by Number in Box in descending order. Be sure 
to retain the column headings. (2 points) (Exam objective 3.2.1) 

4. For the June produce box table, configure the column headings to repeat at the top 
of each page. (1 point) (Exam objective 3.2.6) 

Points scored: ______ / 5 

Task: Resize table elements to fit content (7 points) 
1. Change the cell spacing for the April, May, and June produce box tables to be 

0.03". (3 points) (Exam objective 3.2.2) 

2. Resize the April produce box table so the largest entry fits in each column. (1 point) 
(Exam objective 3.2.4) 

3. Resize the May produce box table so the header in each column wraps after the 
first word. All other text in the table should not wrap to the next line. (1 point) (Exam 
objective 3.2.4) 

4. Resize the June produce box table so the largest entry fits in each column. (1 point) 
(Exam objective 3.2.4) 

5. For the May produce box table, center the column headers. (1 point) (Exam 
objective 3.2.2) 

Points scored: ______ / 7 

Task: Merge and split table elements (8 points) 
1. For the April produce box table, insert a new row above the Produce Category 

header row. Move the April produce box text into the first cell of the new row. (1 
point) (Exam objective 3.2.4) 

2. For the May produce box table, insert a new row above the Produce Category 
header row. Move the May produce box text into the first cell of the new row. (1 
point) (Exam objective 3.2.4) 
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3. For the June produce box table, insert a new row above the Produce Category 
header row. Move the June produce box text into the first cell of the new row. (1 
point) (Exam objective 3.2.4) 

4. In the April produce box table, in the first row, merge the cells to create a single cell 
for the table title. Repeat for the May and June tables. Center the column headings 
if necessary. (3 points) (Exam objective 3.2.3) 

5. In the June produce box table, delete the row that contains Sunflower Honey. (1 
point) (Exam objective 3.2.4) 

6. In the June produce box table, split the table at the first produce category entry. (1 
point) (Exam objective 3.2.5) 

Points scored: ______ / 8 

FILE 1 TOTAL POINTS: ______ / 30 

File 2: Cornerstone_produce_seminar_starter.docx 
Task: Create and modify a bulleted list (8 points) 
1. Start Word and open Cornerstone_produce_seminar_starter.docx. Place the cursor 

in the empty space under The primary goals of the produce seminar are…. 

2. Create a bulleted list using the standard round bullet symbol. Use the following text 
for your bulleted list. (5 points) (Exam objective 3.3.1) 

The types of fruit produce available this spring. 

The types of vegetable produce available this spring. 

New produce to be added for this next season. 

Tips and tricks for effective planting. 

Tips and tricks for efficient harvesting. 

3. Select the sentences Mingle with your farm member peers and Have fun with 
your family. Apply a bulleted list to the two sentences. Use the same bullet symbol 
as step 2. (2 points) (Exam objective 3.3.1) 

4. Change the bulleted lists created in steps 2 and 3 to a check-mark symbol. (1 point) 
(Exam objective 3.3.2) 

Points scored: ______ / 8 
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Task: Create and modify a numbered list (10 points) 
1. Following the Produce seminar registration process heading, under To register 

for the seminar…. apply a standard numbering format to the next four lines of text. 
(2 points) (Exam objective 3.3.1) 

2. Under Review the seminar sessions and select up to a maximum of, create a 
space, and then enter the following text: (2 points) (Exam objective 3.3.1) 

Two for the morning time period. 

Three for the afternoon time period. 

3. For the text entered in step 2, increase the list level so that these two points are 
indented and contain a letter symbol. (2 points) (Exam objective 3.3.4) 

4. Under The primary goals of the produce seminar are…., change the bullets to a 
standard numbering format. (1 point) (Exam objective 3.3.2) 

5. Under And don’t forget the most important goals, change the bullets to a 
standard number format that continues numbering from the previous list. (1 point) 
(Exam objective 3.3.2) 

6. Change the following lines of text to a check-mark bullet symbol. (1 point) (Exam 
objective 3.3.2) 

Two for the morning time period. 

Three for the afternoon time period. 

7. Under And don’t forget the most important goals, restart the numbering at 1. (1 
point) (Exam objectives 3.3.5 and 3.3.6) 

Points scored: ______ / 10 
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Task: Create and modify a multilevel list (10 points) 
1. Following the Event schedule heading, under The following information outlines 

the proposed event schedule:, apply a standard multilevel list format. (2 points) 
(Exam objective 3.3.1) 

2. Apply a multilevel format for the text such that Morning, Afternoon, and Evening are 
Level 1; sessions are Level 2; and workshops are Level 3, as depicted in Figure 31. 
Increase levels as needed. (5 points) (Exam objective 3.3.4) 

 
Figure 31: Cornerstone Multilevel list 

3. Customize the Event schedule so that the Level 3 items are represented with a 
check mark symbol. (1 point) (Exam objective 3.3.3) 

4. In the 4pm sessions section, under Tools used for effective planting, add a new 
level 2 heading 6pm sessions. Under 6pm sessions, enter Introduction to farming 
honeybees. (2 points) (Exam objective 3.3.3) 

Points scored: ______ / 10 

FILE 2 TOTAL POINTS: ______ / 28 
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Module overview 
Description 
Documentation in the smart-agriculture industry must be readable, accurate, and 
inclusive for all audience members. When you create reports that use information from 
research or specific contributors, your audience must be able to track your sources of 
information. Microsoft Word provides source reference tools that you can use to: 

• Improve the readability of your reports and other documentation. 
• Prepare and finalize documents. 

• Share your documents with others by printing or sharing electronically.  
At the end of this module, you’ll be able to create and change tables of contents, 
footnotes, endnotes, bibliographies, and bibliography citations sources. You’ll also 
finalize documents for electronic sharing by using document improvement tools such as 
the Spelling and Grammar Checker, Thesaurus, Word Count, Accessibility Checker, and 
compatibility mode. 

Lesson Learning objective Exam objective(s) 

Creating and 
managing 
references 

• Create and update a table of contents 
• Insert and modify endnotes and 

footnotes 

• 4.2.1 
• 4.2.2 
• 4.1.1 
• 4.1.2 

Creating and 
modifying 
bibliographies 

• Create and modify citation sources 
• Insert citations for bibliographies 
• Insert bibliographies 

• 4.1.3 
• 4.1.4 
• 4.2.3 

Proofreading a 
document 

• Apply spelling and grammar check 
• Apply Thesaurus and word count 
• Share a document electronically 

• Not mapped 
• Not mapped 
• 1.3.4 

Finalizing a 
document 

• Customize pages 
• Insert and modify headers and footers 
• Modify page setup options 
• Modify print settings 

• 1.2.4 
• 1.2.3 
• 2.3.3 
• 1.3.3 
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Lesson Learning objective Exam objective(s) 

Checking for 
document issues 

• Modify basic document properties 
• Check for document properties 
• Check for compatibility issues 
• Check for accessibility issues 

• 1.3.2 
• 1.4.1 
• 1.4.3 
• 1.4.2 

Cornerstone: 
Farm-to-Table 
Cookbook and 
Food Catalog 

Update the references and Table of 
Contents in the Farm-to-Table Cookbook 
and the Food Catalog 

All the previous 
objectives 

Table 1: Objectives by lesson 

Scenario 
Munson’s Pickles and Preserves Farm is finalizing their fall Farm-to-Table Cookbook. As 
a contributing editor, you must update document references before publishing the 
book. You’ll be working with the table of contents, footnotes, and endnotes. 

In conjunction with the cookbook, the farm wants a Food Catalog that lists the produce 
available for purchase directly from the farm. The Food Catalog will list products used in 
the Farm-to-Table Cookbook, with references to quickly locate recipes using specific 
fruits and vegetables. 

Cornerstone 
The farm is finalizing a Farm-to-Table Cookbook and a Food Catalog that will they 
update with each new season of crops available. To get this catalog prepared you need 
to add information and verify that it’s correct using the spelling and grammar checking 
tool. You’ll need to add citations acknowledging sources referenced in the document 
and stored in the Source Manager. You’ll manage the page and printing requirements 
for the catalog, and prepare both documents for final review, ensuring that all the 
content is accurate before publishing. Specifically, you’ll create and manage a table of 
contents, insert footnotes and endnotes as needed, and create and manage a 
bibliography. You’ll also finalize the documents by setting printing and page setup 
options, running the spelling and grammar checker, and ensuring readability by using 
the Word Count and Thesaurus tools. 
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Lesson 1: Creating and 
managing references  
Overview 
When you create multipage documents, you can use footnotes and endnotes. These 
reference tools point your readers to specific quotes, thoughts, and additional reading 
on a topic. Another important reference tool is the table of contents, which makes the 
content much easier for your readers to navigate. In this lesson, you’ll learn how to 
create and manage these reference tools and prepare for the upcoming work on 
multipage research papers and other documentation at Munson’s. 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. Which of the following answers refers to a reference at the end of the page? 

Select the correct option. 

a. Bibliography 

b. Caption 

c. Endnote 

d. Footnote 

2. Which of the following answers refers to a reference that appears at the end of the 
document? 

Select the correct option. 

a. Bibliography 

b. Caption 

c. Endnote 

d. Footnote 
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3. You must update a ____________________ table of contents by hand if someone made 
changes to the document. 

Fill in the blank space. 

4. Which tab includes tools for inserting and managing endnotes and footnotes? 

Select the correct option. 

a. Insert 

b. Design 

c. References 

d. Review 

5. Which of the following options do you use to add information about the source of a 
quotation or idea? 

Select all that apply. 

a. Endnote 

b. Footnote 

c. Margins 

d. Page header 

e. Page footer 

f. Title page 

Topic 1: Insert and modify endnotes 
and footnotes  

 If you must research and write a paper, you’ll need to reference information in that 
paper. In your position at Munson’s, you’ll need to provide references in the 
documentation you’ll work on. 

There are two different reference types you can choose from: a footnote or an endnote. 
Both are similar in use, but the most distinct difference is where they put the reference 
information. Both provide additional details about content you’ve included in your 
document, such as unfamiliar words, people, sources, quotes, or facts you have 
described. 
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Footnotes and endnotes give the reader a place to read and learn more about the 
claims stated in the document. By using footnotes, readers can do further investigation 
about the research mentioned in the document. Research paper style guidelines, such as 
the American Psychological Association (APA) or the Chicago Manual of Style will define 
the specific uses of footnotes and endnotes. 

Insert a footnote 
A footnote is a note placed at the bottom of the page that has more information about 
content in your document. You can also use footnotes to provide reference information 
to a source. In some documentation styles, footnotes are used to cite sources for 
quotations, summaries of the content, and any content in your document that you may 
have paraphrased. However, if there are several footnotes on a single page or they are 
lengthy in listing citation information, footnotes may not be the best option. 

A footnote is indicated with a superscript number (a small number) called a reference 
mark, which corresponds to a note at the bottom of the page. Word automatically 
creates, modifies, and updates marks and footnotes by default, using Arabic numerals 
(for example, 1, 2, 3). 

You insert a footnote in your document by positioning the cursor where you want the 
reference mark placed. This is often at the end of a sentence. From the References tab, 
select Insert Footnote, as the following screenshot depicts. 

 
Figure 1: The Insert Footnote option in the References tab 

A reference mark will be placed in your document, and a footnote will be added at the 
bottom of the page. The cursor is placed in this footnote so you can add the note text. 
The following screenshot is of the final product, a footnote mark with the corresponding 
note at the bottom of the page. 
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Figure 2: A footnote and the corresponding reference mark 

 

Did you know? 

When you really get working in your document and find that you are 
applying many footnotes, you can use the keyboard shortcut of 
Alt+Ctrl+F to insert a footnote, saving you time from having to 
navigate to the References tab. 

Insert an endnote  
An endnote is a note placed at the end of the document. Similar to the footnote, it has 
more information about content in your document, but because endnotes are at the 
end of the document, you can include more information. 

As with footnotes, an endnote includes a small reference mark. To distinguish endnotes 
from footnotes for the reader, by default Word uses Roman numerals (for example, i, ii, 
iii) to indicate endnotes. 

To insert an endnote, position the cursor where you want to add the reference mark. In 
the References tab, Footnotes group, select Insert Endnote. A reference mark is added 
to the document. The following screenshot depicts Insert Endnote in the Footnotes 
group of the References tab. 
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Figure 3: Insert Endnote on the References tab 

The cursor will move to the new endnote at the end of the document so you can add 
the text for the note. 

 

Did you know? 

The keyboard shortcut Alt+Ctrl+D will insert an endnote, saving you 
time from navigating to the References tab. 

Managing footnotes and endnotes 
After adding footnotes and endnotes in your document, you may need to navigate 
quickly between these notes. You may also want to modify the settings applied to the 
notes. 

You can navigate between the footnotes and endnotes in a document by using the 
Next Footnote drop-down list in Footnotes group of the References tab. From this 
drop-down, you can select between Next Footnote and Previous Footnote, or Next 
Endnote or Previous Endnote, as in the following screenshot. 
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Figure 4: Next Footnote is selected in the Footnotes group of the References tab 

To jump to either the footnotes or endnotes in a document, in the Footnotes group you 
can select Show Notes, as in the following screenshot. 

 
Figure 5: Show Notes is selected in the Footnotes group of the References tab 

When you select Show Notes, the Show Notes dialog box opens. In this dialog box, 
select View footnote area to jump to the footnotes or select View endnote area to 
jump to the endnotes, as depicted in the following screenshot. 

 
Figure 6: In the Show Notes dialog box, View endnote area is selected 
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To view the endnote or footnote citation content without moving to the text’s location, 
hover over the reference mark to display the note’s text as a tooltip, as in the following 
screenshot. 

 
Figure 7: A tooltip with endnote content 

You can modify the settings for the footnotes and endnotes by using the Footnote and 
Endnote dialog box launcher icon in the Footnotes group. The following screenshot 
highlights the Footnote and Endnote dialog box launcher icon. 

 
Figure 8: The Footnote and Endnote dialog box launcher icon in the Footnotes group of 
the References tab 

You can also access the Footnote and Endnote dialog box by right-clicking or 
accessing the context menu for the text of a note, and then selecting Open Note. 

You can use the Footnote and Endnote dialog box to navigate to the different 
locations, change the footnote or endnote number format, and even create a custom 
mark to apply in the document. You can also insert a footnote or endnote from this 
dialog box. Finally, you can use the Convert button to switch between footnotes and 
endnotes. The following screenshot is of the Footnote and Endnote dialog box. 
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Figure 9: The Footnote and Endnote dialog box 

 

Additional information 

For additional information on inserting footnotes and endnotes, go to 
Insert footnotes and endnotes. 

For additional information on adding and customizing footnotes and 
endnotes, go to Add footnotes and endnotes. 

Activity: Show me how 
In this activity, the teacher will guide you through inserting a footnote and an endnote. 
You will also use Next Footnote to navigate endnotes and footnotes. 

Resources required 
You will need the following resource for this activity: 

• Open L1_T1_act_company_overview.docx in this lesson’s Learning Activity 
Resources. 

https://aka.ms/Insert-footnotes-and-endnotes
https://aka.ms/Add-footnotes-and-endnotes
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Activity instructions 
Participate in the activity by following these instructions: 

1. Insert a footnote as directed by the teacher. 

2. Insert an endnote as directed by the teacher. 

3. Participate as the teacher leads the group through navigating endnotes and 
footnotes. 

Try-it: Insert and modify endnotes and footnotes 
 In this leveled Try-it, you’ll insert footnotes and endnotes into an existing 

document. 

Try-it 1 
This Try-it will prompt you to add a footnote to the Quarterly Report. 

Resources 
You will need the following resource for this Try-it: 

• Open L1_T1_try1_quarterly_report_starter.docx in this lesson’s Learning Activity 
Resources. 

Instructions 
The following steps are the general tasks that you’ll need to perform during this Try-it: 

1. On the second page of the document, under the heading Concord Grapes, add a 
footnote to the last sentence in the first paragraph, which ends in …providing 
nutrients other colored fruits are lacking. 

2. Edit the text of the footnote to read: Blue and purple fruits are often high in 
pigments called anthocyanins. 

Try-it 2 
In this Try-it, you’ll practice adding endnotes to a document. You will also practice 
navigating to endnotes and footnotes. 

Resources 
You will need the following resource for this Try-it: 

• Open L1_T1_try2_quarterly_report_starter.docx in this lesson’s Learning Activity 
Resources. 
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Instructions 
The following steps are the general tasks that you’ll need to perform during this Try-it: 

1. On the third page of the document, locate the Romaine Lettuce section header. 

2. Add an endnote to the first line of the section, Part of the Lactuca genus. 

3. Edit the text of the endnote to read, This genus includes well over 50 species, 
including daisies. 

4. On the third page of the document, find the Growing pumpkins section header. In 
the Timing subsection, add an endnote to the end of the only sentence. 

5. Edit the text of the endnote to read, Allow three to four months for pumpkins to 
mature. 

6. In the Next Footnote drop-down menu, use the Next Endnote option to navigate 
through both endnotes. Note that Word automatically renumbers the endnote you 
added first, to accommodate the endnote you added above it. 

Topic 2: Create and update a table of 
contents 

 When you create a multipage document, adding a table of contents (TOC) can be a 
helpful addition for readers. Using it provides them with an overview of the document 
and enables them to find sections of interest. 

The TOC is an organized list of major sections in your document. It uses heading styles 
to determine what to put in the TOC. For example, you apply Heading 1 to top-level 
sections, then Heading 2 to subsections, and Heading 3 for the next smaller subsections. 
A TOC will reflect this organization. It has links that jump to each section in the 
document, in addition to page numbers for people using a printed copy. 

You have probably studied examples of TOCs in books of your own, which are usually 
found in the first few pages of a text. You might have even used them to help you find 
and go directly to the chapter or section you want. If you are reading an electronic 
book, you can select the section or chapter title, and it will take you directly to that 
location. 

By default, a Word TOC has the headings on the left side of the list and the 
corresponding page number on the right side of the list, with tab leaders in between. 
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Insert a table of contents 
To create TOC, on the References tab, in the Table of Contents group, select Table of 
Contents. Then, select the Table of Contents style you want. Automatic Table 1 
entitles the table “Contents,” while Automatic Table 2 uses “Table of Contents.” Aside 
from that, the two styles are the same, and each will populate the table automatically 
based on your headings. 

The Manual TOC option doesn’t use your headings, and instead simply creates 
placeholder text for you to overwrite. A manual TOC requires much more work to create 
and update. If you change or rearrange your document, Word can update an automatic 
table, but you must manually update a manual table. 

The following screenshot depicts Table of Contents options from the Table of 
Contents group on the References tab. 
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Figure 10: Table of Contents options in the Table of Contents group 

Update a table of contents 
As you continue working in your document, you may add or delete text or even 
rearrange portions of the text. This means that your Table of Contents may no longer 
reflect the organization and pages of the document. 
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A manual TOC requires you to go through and make all the changes necessary to 
ensure that the TOC is accurate. However, Word updates an automatic TOC for you. To 
update an automatic TOC, select the References tab, and then in the Table of Contents 
group, select Update Table. 

You can also update the TOC from the TOC itself. Select the TOC, and then select 
Update Table, as indicated in the following screenshot. 

 
Figure 11: TOC with Update Table option highlighted 

The Update Table of Contents dialog box offers two options. If you only want to 
update the page numbers for each section, select Update page numbers only. To 
update the entire table, including all headings and page numbers, select Update entire 
table. 

 

Additional information 

To review the article on format or customize a table of contents, go to 
Format or customize a table of contents. 

To review the article on delete a table of contents, go to Delete a table 
of contents. 

To review the article on updating a table of contents, go to Update a 
table of contents. 

 

Video 

To review the video on creating a table of contents, go to Create a 
table of contents. 

Activity: Volunteer blindfolded 
In this activity, the group will assist one student in creating a table of contents. The 
group will then modify the document and help the student update the table of contents 
to reflect those changes. 

https://aka.ms/format-or-customize-a-table-of-contents
https://aka.ms/Delete-a-table-of-contents
https://aka.ms/Delete-a-table-of-contents
https://aka.ms/Update-a-table-of-contents
https://aka.ms/Update-a-table-of-contents
https://aka.ms/Create-a-table-of-contents
https://aka.ms/Create-a-table-of-contents
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Resources required 
You will need the following resource for this activity: 

• Open L1_T2_act_company_overview.docx in this lesson’s Learning Activity 
Resources. 

Activity instructions 
Participate in the group activity as directed by the teacher. You, or someone else in the 
group will follow the directions of the group to create a table of contents, modify the 
document, and then update the table of contents. 

Try-it: Create and update a table of contents  
 In this standalone Try-it, you’ll create a table of contents based on the headings in 

an existing document. You’ll then modify the document and update the table of 
contents to reflect the changes. 

Resources 
You will need the following resource for this Try-it: 

• Open L1_T2_try_quarterly_report_starter.docx in this lesson’s Learning Activity 
Resources. 

Instructions 
The following steps are the general tasks that you’ll need to perform during this Try-it: 

1. Navigate to the second page of the document, which is blank. 

2. Insert a Table of Contents using Automatic Table 2. 

3. Move the entire Guests section on the last page of the document to the top of page 
three so It’s before Special Produce. 

4. Add a page break prior to Special Produce so that It’s now on page 4. 

5. Update the table of contents so that it matches your changes. 

6. Change the table of contents style to Automatic Table 1. 
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Wrap-up 
Use these questions to check what you learned in this lesson:  

1. Which of the following statements about footnotes is true? 

Select the correct option. 

a. They use Arabic numerals by default (1, 2, 3 …). 

b. They use Roman numerals by default (i, ii, iii …). 

c. They are in italics by default. 

d. They are in bold by default. 

2. You can use the ________________________________ dialog box to view the area of the 
documents on which either footnotes or endnotes reside. 

Fill in the blank space. 

3. Where are endnote entries located? 

Select the correct option. 

a. At the end of the page. 

b. At the end of the document. 

c. In the page footer. 

d. In a separate document. 

4. Which of the following statements is true regarding endnotes and footnotes? 

Select the correct option. 

a. You can use both endnotes and footnotes in the same document. 

b. There is a limit to how many endnotes and/or footnotes you can use. 

c. Once you create footnote entries and endnote entries, you cannot edit them. 

5. Which of the following statements is true of a table of contents? 

Select the correct option. 

a. You must manually maintain/update any table of contents. 

b. A table of contents is at or near the beginning of a document. 

c. A table of contents will include footnotes and endnotes. 

d. You cannot change a table of contents after you insert it. 
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Lesson 2: Creating and 
modifying bibliographies 
Overview 
In this lesson, you’ll explore helpful tools for managing and citing sources. If you’ve ever 
had to write a research paper, you know how important it is to keep track of your 
sources, and to give proper credit when you use those sources. Word has a variety of 
features to make this easier. 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. Which of the following refers to a detailed list of sources typically found at the end 
of a document? 

Select the correct option. 

a. In-text citation 

b. Bibliography 

c. Footnotes 

d. Endnotes 

2. Which of the following do you add by using Insert Citation? 

Select the correct option. 

a. In-text citation 

b. Bibliography  

c. Footnotes 

d. Endnotes 

e. All of the above 
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3. When can you add source information to a document? 

Select all that apply. 

a. Prior to citing the source 

b. The first time you cite the source 

c. After citing the source, by using a placeholder 

4. Which option do you use to add and maintain sources? 

Select the correct option. 

a. Bibliography 

b. Researcher 

c. Source Manager 

d. Placeholder 

Topic 1: Create and modify 
bibliography citation sources 

 Word maintains a list of all the sources you use within a document, and you can 
manage them in the Manage Sources dialog box. To access this dialog box, from the 
References tab, in the Citations and Bibliography group, select Manage Sources. The 
following screenshot depicts the Citations and Bibliography group with Manage 
Sources highlighted. 

 
Figure 12: The Citations and Bibliography group with Manage Sources highlighted 

You use the Source Manager to add, edit, copy, and delete the sources that relate to 
your document. The sources you add to the Manage Sources dialog box will be 
available in the Master List and a Current List. 

The Master List contains all the sources for all documents you have created using Word. 
The Current List includes all the sources you have created in the current document, and 
determines what will be included in the bibliography. The following screenshot depicts 
the Source Manager dialog box with both the Master List and the Current List. 
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Figure 13: The Source Manager dialog box 

To add a new source, in the Source Manager dialog box, select New to open the 
Create Source dialog box. From the Type of Source drop-down list, select the type of 
source you wish to create, such as a book or a website, as indicated in the following 
screenshot. Then enter the information in all the fields provided. 

 
Figure 14: The Create Source dialog box with Book selected from the Type of Source 
drop-down list 

By default, the dialog box displays the most common fields for the type of source you 
select. The Show All Bibliography Fields check box makes all fields available. Enter all 
relevant information, and then select OK to close the Create Source dialog box and 
return to the Source Manager dialog box. 
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In the Source Manager dialog box, select a source, and then select Edit. This opens the 
Edit Source dialog box, which is identical to the Create Source dialog box, and 
provides options to make changes to a previously created source. To delete a previously 
entered source, use the Delete button in the Source Manager dialog box. Finally, you 
can use the Copy option to copy a master source to the current document. 

 

Additional information 

For more information on creating and modifying bibliography sources, 
go to Add or change sources, citations, and bibliographies. 

Activity: Pose a challenge 
In this activity, the teacher will challenge you to apply your knowledge about 
bibliography source management. 

Resources required 
You will need the following resource for this activity: 

• Open L2_T1_act_company_overview.docx in this lesson’s Learning Activity 
Resources. 

Activity instructions 
Participate in the teacher-led discussion about sources for school reports. Then follow 
along as the group creates a source. 

Try-it: Create and modify bibliography citation 
sources 

In this standalone Try-it, you’ll practice modifying and creating citation sources. 

Resources 
You will need the following resource for this Try-it: 

• Open L2_T1_try_quarterly_report_starter.docx in this lesson’s Learning Activity 
Resources. 

  

https://aka.ms/Add-or-change-sources-citations-and-bibliographies
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Instructions 
The following steps are the general tasks that you’ll need to perform during this Try-it: 

1. Open the source information for the web page titled Directions for Growing 
Pumpkins by Kareem Kuzbari. Edit the date to August 23, 2019. 

2. Add a new book titled Grape Cultivation, by Lucia Estevez. Nod Publishers in 
Seattle, WA published it in 2016. 

Topic 2: Insert bibliography citations 
 In high school, college, and in many jobs, you may need to write research papers. 

An important part of any document that’s based on research is giving credit to the 
authors of the information you use. You do this by including in-text citations. An in-text 
citation is an acknowledgement of the information source, so the reader knows where 
the information or idea came from. 

The citation’s format is determined by style guidelines. One popular style guide is 
Modern Language Association (MLA), which is often used in humanities subjects such as 
literature, language, and arts. Another is American Psychology Association (APA), which 
is popular in social sciences such as psychology and history. Word supports MLA and 
APA, along with a wide variety of other style guides. If you’re not sure which style to use, 
ask your teacher or the person asking you to create the document. 

To select a style in Word, select the References tab, and then, in the Citations and 
Bibliography group, select Style, as in the following screenshot. 
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Figure 15: The Style options in the Citations and Bibliography group 

Insert a citation 
After you enter your research sources in Source Manager, you can quickly and easily 
insert citations into your document. A citation is a note identifying the source of 
information you’ve included in your work. In most cases, an in-text citation doesn’t give 
detailed information about a source. Instead, it gives a brief acknowledgement of the 
source, and the reader can find all the details at the end of the document in a 
bibliography. 

To cite a source, on the References tab, from the Citations and Bibliography group, 
select Insert Citation. All sources currently added to the Source Manager are available, 
and you can select the source you want to cite. In the following screenshot, after 
selecting Insert Citation, the two sources that you previously entered in the Manage 
Sources dialog box display. 
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Figure 16: Insert Citation with sources 

If you haven’t entered the source in Source Manager, from Insert Citation you can 
select Add New Source to open the Create Source dialog box. After you close the 
dialog box, a citation for the new source will appear in the document. 

If you want to insert a citation without inputting the source information, from Insert 
Citation, select Add New Placeholder. This makes it possible to keep writing and come 
back later to enter the details in the Source Manager. 

 

Additional information 

To review the article on adding citations in a Word document, go to 
Add citations in a Word document. 

To review the article on APA, MLA, or Chicago styles and automatically 
formatting bibliographies, go to APA, MLA, Chicago – automatically 
format bibliographies. 

Activity: Pose a challenge 
In this activity, the teacher will challenge your group to apply your knowledge about 
inserting citations into a document. 

Resources required 
You will need the following resource for this activity: 

• Open L2_T2_act_company_overview.docx in this lesson’s Learning Activity 
Resources. 

https://aka.ms/Add-citations-in-a-Word-document
https://aka.ms/automatically-format-bibliographies
https://aka.ms/automatically-format-bibliographies
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Activity instructions 
Participate in the teacher-led discussion about inserting citations. Then follow along as 
the group creates citations. 

Try-it: Insert bibliography citations 
In this standalone Try-it, you’ll cite a source in a document by using an in-text 

citation. 

Resources 
You will need the following resource for this Try-it: 

• Open L2_T2_try_quarterly_report_starter.docx in this lesson’s Learning Activity 
Resources. 

Instructions 
You will need to perform the following task during this Try-it: 

• On page 4 of the document, add an in-text citation to the last item of the bulleted 
list, They do not want to be near trees or buildings. The source is already in the 
document’s source list; it is a book called “Grape Cultivation.” 

Topic 3: Insert bibliographies 
 Now that you have brief in-text citations entered in the document, you need to 

create a bibliography that provides the reader with details about each source. You 
typically insert the bibliography at the end of the document. Because the details for 
each source are in the Source Manager, Word can automatically create and maintain a 
properly formatted bibliography in much the same way as it creates and updates a table 
of contents. 

Insert a bibliography 
To insert a bibliography, from the References tab, in the Citations and Bibliography 
group, select Bibliography. Next, select one of the predefined bibliography styles 
offered in the drop-down list. The only difference in the options is the title for the 
bibliography that you choose from, such as Bibliography, References, or Works Cited, 
as indicated in the following screenshot. 
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Figure 17: Options for Bibliography in the Citations and Bibliography group 

All sources you have added to your Current List in the Source Manager will display in 
the generated bibliography list. The bibliography format will be based on the Style 
option you selected in the Citations and Bibliography group of the References tab. 

Update a bibliography and citation 
If you add or modify sources in your document, you may find that you need to update 
your citations and the bibliography. An efficient way to update this information is to 
select Bibliography, and then from the top of the bibliography boundary, select 
Update Citations and Bibliography. The following screenshot depicts a selected 
Bibliography with the Update Citations and Bibliography option highlighted: 
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Figure 18: A selected Bibliography with Update Citations and Bibliography highlighted 

Word will update the bibliography and all in-text citations with any changes made to 
sources in the Source Manager. Next to Update Citations and Bibliography is an icon 
that when selected makes it possible to change the predefined style used for the 
bibliography. 

Remember that the bibliography’s format is determined by the Style you have selected. 

 

Additional information 

To review the article on creating a bibliography, citations, and 
references, go to Create a bibliography, citations, and references. 

Activity: Pose a challenge 
In this activity, the teacher will challenge your group to add a bibliography to a 
document. 

Resources required 
You will need the following resource for this activity: 

• Open L2_T3_act_company_overview.docx in this lesson’s Learning Activity 
Resources. 

Activity instructions 
Participate in the teacher-led discussion about inserting a bibliography. Then follow 
along as the group creates a bibliography. 

https://aka.ms/create-a-bibliography-citations-and-references
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Try-it: Insert bibliographies 
 In this standalone Try-it, you’ll add a bibliography to a document that has in-text 

citations. 

Resources 
You will need the following resource for this Try-it: 

• Open L2_T3_try_quarterly_report_starter.docx in this lesson’s Learning Activity
Resources.

Instructions 
The following steps are the general tasks that you’ll need to perform during this Try-it: 

1. Go to page 7 of the document, which is blank.

2. Insert a bibliography with the heading References.

Wrap-up 
Use these questions to check what you learned in this lesson: 

1. Which feature do you use to add a citation without entering source details until a
later time?

Select the correct option.

a. Add new Placeholder

b. Create Source dialog box

c. Insert Caption

d. Mark Entry

2. Which of the following features stores sources that you have entered in all
documents, including the current document?

Select all that apply.

a. Current List

b. Master List

c. Overall List

d. Global List
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3. Which of the following settings determines the format for in-text citations and the
bibliography?

Select the correct option.

a. The current user’s language and region settings

b. A setting in Word Options

c. The Style selection on the ribbon

d. A dialog box at the time you add citations

4. You can use the _______________________________ dialog box to add, edit, and delete
sources.

Fill in the blank space.
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Lesson 3: Proofreading a 
document 
Overview 
In this lesson, you’ll learn how Word can help you proofread your document for spelling 
and grammar errors. You’ll also observe how the Thesaurus feature can quickly find 
replacements for words you repeat too often in your text. Finally, you’ll send a Word 
document as an email attachment. 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. The _____________________________ can help you find a synonym for a selected word. 

Fill in the blank space. 

2. Which of the following can assist you with spelling and grammar suggestions? 

Select the correct option. 

a. Proofing pane 

b. Source Manager 

c. Thesaurus 

d. Word Count dialog box 

3. Which of the following statements best describes the Word Count feature? 

Select the correct option. 

a. It will only count the number of words in a document. 

b. It will determine word count and several other length measurements. 

c. It’s only available when you are finalizing your document for publication or 
printing. 

d. It can only determine the length of the entire document. 

4. The _________________________ group on the _________________________ tab contains tools 
for spelling and grammar, finding synonyms, and determining word count. 

Fill in the blank spaces. 
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Topic 1: Check spelling and grammar  
Before sharing your document, you’ll want to check that it doesn’t have spelling or 
grammar errors. This kind of check is called proofing your document.  

 

Video 

To review the video on how to check spelling, grammar, and clarity, go 
to Check spelling, grammar, and clarity.  

Check spelling 
When conducting a spell check on your document, the spelling and grammar checker 
uses a built-in dictionary based on your local language. This tool runs automatically, 
checking your spelling as you write and indicating potential misspelled words with a 
wavy line under your text. 

When spell check identifies a misspelling in your document, you can resolve the warning 
in a few different ways. You can right-click or access the context menu for the 
misspelled word, and then select Spelling, as in the following screenshot. 

 
Figure 19: The context menu for a misspelled word with Spelling selected 

The context menu displays suggested corrections to replace the misspelled word. If the 
word is spelled correctly but is not in the dictionary, you can select Add to Dictionary 
so it isn’t flagged in this or any other documents you create. This is a helpful feature for 
acronyms or jargon specific to your field of work or area of interest. If you want to keep 

https://aka.ms/check-spelling-grammar-and-clarity
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the spelling but you don’t want to add the word to your dictionary, select Ignore All to 
permanently ignore the word in the current document. 

Check grammar 
Word also includes a grammar check to help identify grammar and punctuation errors in 
your document. The following screenshot depicts the context menu for a sentence with 
a grammar suggestion. 

 
Figure 20: The context menu for a sentence with a grammar suggestion 

As with the spell check feature, you can choose to ignore the suggestion. The grammar 
check context menu also offers Don’t check for this issue, which will prevent Word 
from making similar suggestions elsewhere in the current document. 

 

Additional information 

For more information on using spelling and grammar check in 
Microsoft Office, go to Check spelling and grammar in Office. 

  

https://aka.ms/Check-spelling-and-grammar-in-Office
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The Proofing pane 
A useful tool for reviewing your document is the Proofing pane. This is a centralized 
location for reviewing spelling and grammar issues. It’s like having a personal editor 
read through your work and offer suggestions for improvement. 

To open the Proofing pane, you can right-click or access the context menu for text with 
a spelling or grammar suggestion, and then select See More. 

To access the Proofing pane from the ribbon, select the Review tab, and then in the 
Proofing group, select Spelling & Grammar, as in the following screenshot. 

 
Figure 21: The Proofing group 

The following screenshot is of the Proofing pane with suggestions for correcting a 
misspelled word. 
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Figure 22: The Proofing pane with suggestions for correcting a misspelled word 

 

Did you know? 

If you don’t have any text selected, the Proofing pane gives an 
overview of the corrections and refinements that spell check and 
grammar check have already found. It’s a great way to give your 
document one last review as you finish. It even offers a read aloud 
feature that will read your document back to you, which is a great way 
to catch errors and make improvements. 

 

Additional information 

For more information on how to select grammar and writing style 
options, go to Select grammar and writing style options. 

  

https://aka.ms/select-grammar-and-writing-style-options
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Activity: Switch 
In this activity, you’ll practice checking spelling and grammar with Word. 

Resources required 
You will need the following resource for this activity: 

• Open L3_T1_act_company_overview.docx in this lesson’s Learning Activity 
Resources. 

Activity instructions 
Participate in the activity by following these instructions: 

1. Perform the proofing task directed by the teacher. 

2. When the teacher signals the group to stop, move to your neighbor’s computer and 
perform the next proofing task, as directed. 

3. Continue to switch until the teacher instructs you to “Switch back home.” 

4. Return to your original computer. 

Try-it: Check spelling and grammar 
 In this leveled Try-it, you’ll practice checking spelling and grammar in a document. 

You’ll also add some words to your dictionary. 

Try-it 1 
In this Try-it, you’ll make changes to a document by accepting or rejecting spelling and 
grammar suggestions.  

Resources 
You will need the following resource for this Try-it: 

• Open L3_T1_try1_quarterly_report_starter.docx in this lesson’s Learning Activity 
Resources. 
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Instructions 
The following steps are the general tasks that you’ll need to perform during this Try-it: 

1. Open the Proofing pane. 

2. Accept or reject the suggestions as noted here: 

o Accept the spelling suggestions for sauteed, which is lacking an accent mark, and 
for mostknown, which is missing a space. 

Try-it 2 
In this Try-it, you’ll add suggestions to the custom dictionary. 

Resources 
You will need the following resource for this Try-it: 

• Open L3_T1_try2_quarterly_report_starter.docx in this lesson’s Learning Activity 
Resources. 

Instructions 
The following steps are the general tasks that you’ll need to perform during this Try-it: 

• Resolve the spelling and grammar suggestions as follows: 
a. The words Lactuca and Vitis are the names of the genus of lettuce and of grapes, 

respectively. At the farm, you’ll work with these terms occasionally. Add them to 
the dictionary so that Word doesn’t flag them as misspellings in the future. 

b. Remove the extra period at the end of the sentence. 

Topic 2: Use the Thesaurus and word 
count 
In addition to spelling and grammar checking, Word provides other proofing tools. 
Thesaurus is a tool that finds alternatives to words that you use too frequently. Word 
Count gives you details about the number of words, paragraphs, pages, and more, 
which is handy when you have specific size requirements for a document. 
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Use Thesaurus from the ribbon 
As you work on documents (particularly long documents that contain multiple pages), 
you may find that you’re repeating yourself. Thesaurus is a helpful proofing tool that 
suggests synonyms for you to use and replace some of those repeated words. 

To use the Thesaurus, select the word you want to look up. On the Review tab, in the 
Proofing group, select Thesaurus, as indicated in the following screenshot. 

 
Figure 23: Thesaurus selected in the Proofing group  

The Thesaurus pane displays a list of synonyms. To replace the selected word with a 
word from Thesaurus, select the down arrow next to the new word, and then select 
Copy to copy the new word to the Clipboard, as indicated in the following screenshot. 
You can then paste the new word into your document, and delete the old word. 
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Figure 24: The Thesaurus pane with the arrow next to the to the word change selected, 
displaying the options to Insert or Copy 

If you select a word in the list rather than selecting the arrow next to the word, Word 
looks up synonyms for that word. 

  

Additional information 

For more information on how to look up words in the Thesaurus, go to 
Look up words in the thesaurus. 

Use the Thesaurus from the context menu 
You can also access the Thesaurus from the context menu. Right-click or access the 
context menu for the word you want to look up, and then select Synonyms. To replace 
the word, select a new word from the list. You may also select Thesaurus to open the 
Thesaurus pane. The following screenshot depicts the context menu with Synonyms 
selected. 

https://aka.ms/look-up-words-in-the-thesaurus
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Figure 25: The context menu with Synonyms selected 

Find your word count 
To find the length of your document, use the Word Count tool. It will calculate and 
display the length of your document in a variety of ways, such as the number of words, 
the number of paragraphs, and the number of pages. 

To use this feature, from the Review tab, in the Proofing group, select Word Count. 
The following screenshot depicts the Word Count dialog box. 

 
Figure 26: The Word Count dialog box 
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Another way to open the Word Count dialog box is from the Word status bar, which 
also displays the current word count. By selecting the word count on the Word status 
bar, the Word Count dialog box opens. 

 

Additional information 

To find the length of a certain portion of your document, select the 
words you want to count, and then open the Word Count dialog box. 
This is useful if you want to measure the length of a segment of your 
document, or if you want to exclude some parts, such as a table of 
contents and bibliography. 

 

Video 

For additional information and to review the video on how to show 
word count, go to Show word count. 

Activity: Show and tell 
In this activity, the teacher will demonstrate how to use the Thesaurus. 

Resources required 
You will need the following resource for this activity: 

• Open L3_T2_act_company_overview.docx in this lesson’s Learning Activity 
Resources. 

Activity instructions 
Follow along as the teacher demonstrates the Thesaurus tool. 

Try-it: Use the Thesaurus and word count 
 In this standalone Try-it, you’ll use the Thesaurus to replace a few overused 

words. 

Resources 
You will need the following resource for this Try-it: 

• Open L3_T2_try_quarterly_report_starter.docx in this lesson’s Learning Activity 
Resources. 

https://aka.ms/Show_word_count
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Instructions 
The following steps are the general tasks that you’ll need to perform during this Try-it: 

1. Find the paragraph on page 4 that begins with, Grapes grow on vines and require 
support. It’s under the subheading, Support the vines. 

2. The word requires appears a couple of times in the paragraph. Use the Thesaurus 
pane to replace the second occurrence of requires with needs. 

3. Similarly, connect appears twice in the paragraph. Use the Thesaurus to replace the 
first occurrence with attach. 

Topic 3: Electronically share a 
document 

 In the modern workplace, you’ll need to share files and collaborate in different 
ways with Word and other apps. One common way to share a document is to send it as 
an email attachment. 

You can share a file as an attachment through email. To do this directly from Word, 
Select the File tab to open the Backstage view. Select Share, and then select Email. 

Next, select how you wish to email the document. A common way is to attach it to an 
email by selecting Send as an Attachment. The following screenshot depicts the Share 
options in the Backstage view with Email and Send as Attachment called out. 
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Figure 27: Share options with Email and Send as Attachment highlighted 

A Microsoft Outlook email message will open with the current document already 
attached. You simply need to add your subject, the body of your message and the email 
addresses for the recipients, and then select Send. 

When you share a file as an attachment, the recipients are receiving a copy of the 
document. Changes they make to the file will not affect your copy, and changes you 
make after sending the email will not be in their copy. 

 

Video 

To review the video on how to share a document, go to Share a 
document. 

https://aka.ms/Share_a_document
https://aka.ms/Share_a_document
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Additional information 

To review the article on how to collaborate on Word documents in 
real-time with co-authoring, go to Collaborate on Word documents 
with real-time co-authoring. 

Activity: Guess and tell 
In this activity, you’ll work with a group to uncover ways in which you can attach a 
document to an email from the Word app. 

Resources required 
You will need the following resource for this activity: 

• Open L3_T3_act_company_overview.docx in this lesson’s Learning Activity 
Resources. 

Activity instructions 
Participate in the activity by following these instructions: 

1. As directed by the teacher, guess how you can send a document by email from 
Word. 

2. When it’s your turn, demonstrate the process on the teacher’s projected computer. 

Try-it: Electronically share a document 
 In this activity, you’ll share a document with your teacher or another student. 

Resources 
You will need the following resource for this Try-it: 

• Open L3_T3_try_quarterly_report_starter.docx in this lesson’s Learning Activity 
Resources. 

Instructions 
Send the document as an email attachment from Word to the teacher, or to the student 
designated by the teacher. 

  

https://aka.ms/collaborate-on-word-documents-with-real-time-co-authoring
https://aka.ms/collaborate-on-word-documents-with-real-time-co-authoring
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Wrap-up 
Use these questions to check what you learned in this lesson:  

1. How can you access the Thesaurus in Word? 

Select all that apply. 

a. From the context menu 

b. Open the Editor pane 

c. From the Home tab 

d. From the References tab 

e. From the Review tab 

2. What can you access in the Proofing pane? 

Select all that apply. 

a. Spelling suggestions 

b. Grammar suggestions 

c. Bibliography sources 

d. Endnotes and footnotes 

e. Potential punctuation errors 

3. Which of the following tools can you access from the Proofing group on the Review 
tab? 

Select all that apply. 

a. Send an email attachment 

b. The Proofing pane 

c. Word Count 

d. Backstage View 

e. Thesaurus 

4. The grammar check tool will offer suggestions on all the following EXCEPT: 

Select the correct option. 

a. Proper punctuation 

b. Being more concise 

c. Overused words 
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Lesson 4: Finalizing a document 
Overview 
In this lesson, you’ll learn about tools you can use to ensure that your content looks 
great before you publish or print it. You’ll learn how to customize the appearance of 
pages in your document and preview it before printing. 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. You can use _________________________ to examine what a hard copy of your document 
will look like prior to printing. 

Fill in the blank space. 

2. Which of the following refers to text or an image placed under the regular content in 
a document? 

Select the correct option. 

a. Page color 

b. Header 

c. Footer 

d. Watermark 

3. The ______________________________ is an area at the top of each page that you can use 
for content shared across each page of the document 

Fill in the blank space. 

4. Which of the following is true of footers? 

Select the correct option. 

a. They only exist on specific pages you designate. 

b. They display footnotes. 

c. You can customize them to display different information. 
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Topic 1: Customize pages 
 Word makes it possible to customize document pages in a variety of ways. You can 

change the color of pages and add page borders and watermarks. These customizations 
can make your document stand out, and mark documents with important information. 

Change the background color 
Changing the color of pages can bring your document to life, and can also help with 
consistent branding. For example, you may want to use similar colors in documents, 
presentations, and spreadsheets. 

You must be careful to use colors that don’t interfere with the text of your document 
though. If you choose a light background color, be sure to use dark text in your 
document. Conversely, if you choose a dark page color, you’ll want to contrast the 
background with light text and visual elements.  

Also, keep in mind the impact a page color can have when printing the document. Page 
colors may require significantly more ink when you print it. And a color scheme that 
looks great on the screen might be difficult to read when printed in grayscale.  

To apply a page color to your document, navigate to the Design tab, and then in the 
Page Background group, select Page Color. As you hover over the colors available, 
Word will preview the appearance of the document based on the choice. The following 
screenshot depicts the Page Background group with Page Color selected. 

 
Figure 28: Page Color options 
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If you don’t find the color you want, you can select More Colors to open the Colors 
dialog box and find additional options. Select Fill Effects to add a gradient, pattern, or 
texture to the page color. 

 

Additional information 

For more information on adding or modifying the page color, go to 
Add, change, or delete the background color in Word. 

Add a border to a page 
To add a border to pages in your document, navigate to the Design tab, and then in the 
Page Background group, select Page Borders. The Borders and Shading dialog box 
provides a variety of border options. The following screenshot depicts the Borders and 
Shading dialog box with Page Border options displaying. 

 
Figure 29: Borders and Shading dialog box, Page Border tab 

  

https://aka.ms/Add-change-or-delete-the-background-color-in-Word
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You can use the Setting options to choose how Word applies the border to the four 
sides of the page, and the Preview box provides a preview of how your selections will 
appear. For example, Shadow places a heavier border on the right and bottom sides, 
making it seem like it has a shadow. You can use the options available for Style, Color, 
Width, and Art to customize the lines that you’ll use for the borders. Use the Apply to 
option to select which pages of the document to apply the border to, and select OK to 
apply the selections to the document. 

To remove page borders, return to the Borders and Shading dialog box and in Setting, 
select None. 

 

Additional information 

For more information about page borders, go to Add a border to a 
page. 

Add a watermark to a page 
A watermark is text or an image that displays behind the content of a document. It’s 
typically faint so that it doesn’t interfere with readability. Although you can use a 
watermark for many purposes (including branding with a faint logo), you often use it to 
identify the state of a document’s completion or to notify readers about privacy. For 
example, you could watermark the rough draft of a report with the word “DRAFT,” so 
that readers know it’s not the finished product. Likewise, a watermark of 
“CONFIDENTIAL” or “DO NOT COPY” tells readers not to share or distribute the 
document. 

Word comes with pre-defined watermark designs. To view and apply one of these, 
select the Design tab and, in the Page Background group, select Watermark, as 
indicated in the following screenshot. 

https://aka.ms/add-a-border-to-a-page
https://aka.ms/add-a-border-to-a-page
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Figure 30: Options available after selecting Watermark in the Page Background group 

You can also create your own watermark design by selecting Custom Watermark. The 
Printed Watermark dialog box opens, and provides settings you can choose for the 
watermark. Select Text watermark to access settings for the appearance of the 
watermark. Select Apply to preview your watermark, and OK to close the dialog box. In 
the following screenshot, the Printed Watermark dialog box has Text watermark 
selected, and DRAFT entered in the Text box. 



Managing references and finalizing documents 
 

 
54 

 
Figure 31: Printed Watermark dialog box with Text watermark selected and DRAFT 
entered as text 

To remove an existing watermark, simply select Remove Watermark. 

 

Video 

To review the video on watermarks, go to Insert a watermark. 

Activity: Discuss and learn 
In this activity, you’ll take part in a teacher-led discussion about page customizations. 
You’ll then apply a background color, border, and watermark to pages in a document. 

Resources required 
You will need the following resource for this activity: 

• Open L4_T1_act_company_overview.docx in this lesson’s Learning Activity 
Resources. 

  

https://aka.ms/insert-a-watermark
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Activity instructions  
Participate in the activity by following these instructions: 

1. Participate in the discussion about different ways to customize pages in Word. 

2. Follow along as the teacher demonstrates applying page colors, borders, and 
watermarks. 

Try-it: Customize pages 
 In this standalone Try-it, you’ll practice customizing pages in Word. You’ll add a 

background color, a page border, and a watermark to a page. 

Resources 
You will need the following resource for this Try-it: 

• Open L4_T1_try_quarterly_report_starter.docx in this lesson’s Learning Activity 
Resources. 

Instructions 
The following steps are the general tasks that you’ll need to perform during this Try-it: 

1. Set the page color to a color of your choice. 

2. Apply a page border using the Shadow setting. 

3. Create a watermark that prints your name diagonally in the document. Select a color 
that ensures your watermark is visible without disrupting readability. 

Topic 2: Insert and modify headers and 
footers 

 Every Word document has areas at the top and bottom of each page that are 
separate from the regular document content. The area at the top is the header, and the 
area at the bottom is the footer. You can configure these areas to display information 
such as page numbers on all or just some of the pages. Headers and footers often 
include other information about the document itself as well, such as the document title, 
author’s name, or date of publication. Some style guidelines such as MLA might even 
require you to use the header or footer for specific information. 
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Insert a built-in header and footer 
To insert a header, from the Insert tab, in the Header & Footer group, select Header. 
Then, select the built-in header you want. The following screenshot depicts the available 
Built-in header options. 

 
Figure 32: Built-in header options 

After selecting a header, you can add or change the header’s text. When you’re editing 
the header text, the Header & Footer Tools Design tab will display on the ribbon. 
However, you won’t be able to edit content in the main body of your document until 
you exit the header or footer. To exit, once you finish editing the header, in the Close 
group on the Header & Footer Tools Design tab, select Close Header and Footer, as 
demonstrated in the following screenshot. 
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Figure 33: A part of the Header & Footer Tools Design tab with Close Header and 
Footer highlighted 

To insert a footer, select the Insert tab on the ribbon. Then, in the Header & Footer 
group, select Footer. Select the built-in footer you want. As with a header, you’ll be able 
to add or edit text in the footer. When you finish, select Close Header and Footer. 

 

Additional information 

For more information and to review the video on inserting headers 
and footers, go to Insert a header or footer. 

Customize headers and footers 
Some built-in headers and footers include dynamic information about the document, 
such as the document title (from the document Properties page) or the page number. 
You can also customize the header and footer with your own information. 

To customize your header or footer, double-click the header or footer you want to edit. 
Alternatively, you can also select the Insert tab, go to the Header & Footer group, 
select Header or Footer, and then select Edit Header or Edit Footer. The following 
screenshot has Edit Footer highlighted. 

 
Figure 34: Edit Footer  

  

https://aka.ms/Insert_a_header_or_footer
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The Header & Footer Tools Design tab has tools for adding elements to your header 
or footer. To add the page number, in the Header & Footer group, select Page 
Number, and then use the available options to place the page number in the desired 
location. For example, the Plain Number 2 option adds the current page number in the 
center of the header. Plain Number 1 and Plain Number 3 place the page number on 
the left and right of the header, respectively. 

In the following screenshot, Page Number, with Top of Page and Plain Number 2 are 
selected. 

 
Figure 35: Page Number with Top of Page and Plain Number 2 selected 

 

Additional information 

For more information on modifying a header or footer, go to Edit your 
existing headers and footers. 

  

https://aka.ms/edit-your-existing-headers-and-footers
https://aka.ms/edit-your-existing-headers-and-footers
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Activity: Show and tell 
In this activity, you’ll work in a group to add, insert, and edit headers and footers in a 
document on the teacher’s computer. 

Resources required 
You will need the following resource for this activity: 

• Open L4_T2_act_company_overview.docx in this lesson’s Learning Activity 
Resources. 

Activity instructions 
As directed by the teacher, take part when it’s your turn to insert or edit a header or 
footer on the teacher’s computer. 

Try-it: Insert and modify headers and footers 
 In this leveled Try-it, you’ll practice inserting built-in headers and footers, in 

addition to customizing headers and footers to display additional information. 

Try-it 1 
In this activity, you’ll insert a built-in header and footer in a document. 

Resources 
You will need the following resource for this Try-it: 

• Open L4_T2_try1_quarterly_report_starter.docx in this lesson’s Learning Activity 
Resources. 

Instructions 
The following steps are the general tasks that you’ll need to perform during this Try-it: 

1. Add the built-in heading Integral to the document. 

2. Add a footer using the built-in style Blank (Three Columns). 

3. In the left (first) column of the footer, enter your name in place of the [Type here] 
placeholder. Delete the placeholder text in the middle and right columns. 

Try-it 2 
In this Try-it, you’ll practice modifying a footer. 
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Resources 
You will need the following resource for this Try-it: 

• Open L4_T2_try2_quarterly_report_starter.docx in this lesson’s Learning Activity 
Resources. 

Instructions 
The following steps are the general tasks that you’ll need to perform during this Try-it: 

1. Edit the footer, which has three columns. Note that only the column on the left side 
(the first column) has text. 

2. In the middle column of the footer, add a field to display the current date. 

3. Select the column on the right side (the third column) of the footer, and then add 
the page number at your current position. 

Topic 3: Set up your document for 
printing 

 Before printing your document, you should confirm that the document will print as 
you expect. This will reduce wasted paper, ink, and time. Word has a print preview 
feature that displays how the document will print. You should use it to ensure that the 
document appears how you want it to before printing. 

To open the print preview and configure options for printing, select the File tab, and 
then select Print to access the Backstage view. Your document will display how it will 
print. You can also use the print preview to zoom in and zoom out by using the Zoom 
slider on the status bar. In the options pane on the left side, you can manage the print 
settings for the current document. 

 

Did you know? 

If you customize the Quick Access Toolbar to include the Print and 
print preview options, you can more easily access the print preview 
options, and then make selections to print your document.  

Once you’re in print preview, you can use the Esc key on your 
keyboard to quickly close this feature and take you back to your 
document. 
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Print settings 
Page and printing settings are available in the Settings pane of the print preview 
window. On the bottom part of this pane is a link to the Page Setup dialog box. From 
here you can change the page settings without needing to access the Layout tab to 
manage these features. 

 
Figure 36: The Print pane in the Backstage view 

You can use Settings to manage a variety of options: 

• Select the pages you want to print. 
• Choose whether to print one side or both sides if your printer supports it. 
• Select landscape or portrait orientation and observe the effect of the change in the 

preview. 
• Customize the paper size for printing. 
• Manage the margin sizes for the document and observe those changes in the 

preview. 
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Additional information 

For more information on printing a document in Word, go to Print a 
document in Word. 

After configuring these options, select a printer, set the number of copies to print, and 
then select Print to print a hard copy of your document. 

Activity: Preview and select 
In this activity, the teacher will demonstrate how to use print preview and how to 
change print settings. 

Resources required 
You will need the following resource for this activity: 

• Open L4_T3_act_company_overview.docx in this lesson’s Learning Activity 
Resources. 

Activity instructions 
Follow along as the teacher demonstrates using print preview and print settings. 

Try-it: Set up your document for printing 
 In this standalone Try-it, you’ll practice using print preview to understand how a 

document will look prior to printing. 

Resources 
You will need the following resource for this Try-it: 

• Open L4_T3_try_quarterly_report_starter.docx in this lesson’s Learning Activity 
Resources. 

Instructions 
The following steps are the general tasks that you’ll need to perform during this Try-it: 

1. Open the print preview for this document. Note that the section on pumpkins 
spreads across two pages. 

2. Exit the print preview and in the document add a page break before the “Pumpkins” 
heading. 

3. Return to print preview and ensure that the section now stays together on one page. 

https://aka.ms/Print-a-document-in-Word
https://aka.ms/Print-a-document-in-Word
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Wrap-up 
Use these questions to check what you learned in this lesson:  

1. What is a typical use for a watermark? 

Select the correct option. 

a. To indicate the author’s name 

b. To place a frame around the borders of a page 

c. To display the current page number 

d. To share information about the state or status of the document 

2. What happens if you double-click on a header? 

Select the correct option. 

a. You remove the header. 

b. You can edit the header. 

c. The Insert Header dialog box appears. 

d. Nothing. 

3. What is a watermark? 

Select the correct option. 

a. The dimmed-out view when editing a header or footer 

b. A faint image or text behind the main content of a document 

c. A print preview setting to reduce ink usage 

d. A built-in option for headers and footers 

4. Where can you find the command for creating a header or footer? 

Select the correct option. 

a. On the context menu 

b. In the print preview window 

c. On the Insert tab 

d. On the Design tab 

e. On the Review tab 
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Lesson 5: Checking for 
document issues 
Overview 
In this module, you’ll learn about reviewing some important areas prior to publishing or 
sharing your document. You’ll learn how to view and edit metadata, and use a tool to 
remove metadata with personal information. You’ll also ensure that people with older 
versions of Word and people who use assistive technology can use your document. 

 

Video 

Why is it important to make sure a document is accessible to people 
with disabilities? Review the video Creating for everyone. What are the 
two things that stood out for you? 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. Word stores metadata as _____________________________________. 

Fill in the blank space. 

2. Which of the following tools helps ensure your document will open in older versions 
of Word? 

Select the correct option. 

a. Accessibility Checker 

b. Compatibility Checker 

c. Editor pane 

d. Document Inspector 

3. _________________________________ refers to how well people who use assistive 
technology can use a document. 

Fill in the blank space. 

  

https://aka.ms/video-creating-for-everyone
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4. Where can you find many tools for finalizing a document? 

Select all that apply. 

a. On the Info page from the File tab 

b. On the References tab 

c. In the Editor pane 

Topic 1: View and edit basic document 
properties 

 Word keeps a variety of details about your documents, many of which are available 
to you as properties. The user inputs and maintains some properties, such as the 
document title and keywords describing the document. Word automatically updates 
other properties, such as the time and date of file creation and the people who have 
worked on the document. You can also make properties of your own. 

Properties can make it much easier to organize and find your files. For example, you can 
search for documents based on keywords and document title. The dates and times of 
the file can help ensure you’re looking at the correct version of the document. 

Document properties, whether they are maintained by the user or by Word, are a form 
of metadata--which is information about the file itself. 

To view document properties, select the File tab, and then select Info. The following 
screenshot depicts the document properties screen that opens. 
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Figure 37: Document properties screen 

To edit properties, select the property you wish to change, and then enter the new text. 
Some properties such as Author require you to right-click or access the context menu, 
and then select Remove or Edit. 

By default, Word displays some of the most common and useful properties on the Info 
page. However, more properties are available if you select Show All Properties. 

Additionally, you can access the Document Properties dialog box by selecting the 
arrow next to Properties, and then selecting Advanced Properties. The following 
screenshot is of the Advanced Properties that are available after selecting the 
Properties drop-down. 

 
Figure 38: Advanced Properties available after selecting the Properties drop-down 
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The Document Properties dialog box includes the following five tabs, as reflected in 
the following screenshot: 

• The Summary tab provides options to manually enter text into the fields available, 
beginning with the Title. 

• The General tab provides you with the general metadata properties that Word 
manages. 

• The Statistics tab displays the most up-to-date information about the file that the 
app updates automatically. 

• The Contents tab has an overview of the section headings in your document. 
• The Custom tab includes options to specify properties of your own. 

 
Figure 39: The Document Properties dialog box with the Summary tab selected 

 

Additional information 

For more information on how to view or change the properties for an 
Office file, go to View or change the properties for an Office file. 

https://aka.ms/View-or-change-the-properties-for-an-Office-file
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Activity: Demonstration 
In this activity, the teacher will demonstrate how to view and change Word metadata. 

Resources required 
You will need the following resource for this activity: 

• Open L5_T1_act_company_overview.docx in this lesson’s Learning Activity 
Resources. 

Activity instructions 
Follow along as the teacher demonstrates different ways to access and change 
document properties in Word. 

Try-it: View and edit basic document properties 
 In this standalone Try-it, you’ll practice editing Word metadata. 

Resources 
You will need the following resource for this Try-it: 

• Open L5_T1_try_quarterly_report_starter.docx in this lesson’s Learning Activity 
Resources. 

Instructions 
The following steps are the general tasks that you’ll need to perform during this Try-it: 

1. Edit the Title property to Munson’s - Quarterly Report. 

2. Edit the Company property to Munson’s Pickles and Preserves Farm. 

3. Edit the Keywords property to report, quarterly, and quarterlies. 

Topic 2: Check for hidden data and 
personal information 

 Before sharing a document, you may want to remove some metadata. In some 
cases, the information is simply distracting or not necessary, such as revision marks from 
tracked changes or a watermark used prior to finishing the document. In other cases, 
the data may have personally identifiable information that you should remove for the 
privacy of people who worked on the file. 
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You should review the metadata prior to sharing it with colleagues, clients, or 
classmates. A tool called the Document Inspector can help find and remove these 
pieces of data. 

It’s important to use Document Inspector on a copy of your document and not the 
original. It can remove data that is impossible to restore. 

Begin by saving a copy of your document: select File, then Save As, and then enter a 
name in the File name box. After you’ve created a new copy, continue. 

Select the File tab, and then select Info. Select Check for Issues, and then select 
Inspect Document to open the Document Inspector dialog box. The following 
screenshot depicts the Inspect Document option. 

 
Figure 40: The Inspect Document option on the File Info page 

You can use the Document Inspector dialog box to select the types of hidden data that 
you want to review. Select Inspect to continue to the Document Inspector dialog box, 
as depicted in the following screenshot. 
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Figure 41: The Document Inspector dialog box 

Upon completion of the inspection, the Document Inspector will display a summary of 
the results. The following screenshot depicts an example of the results from the 
Document Inspector. 
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Figure 42: Sample of results from the Document Inspector 

For each type of metadata you want to remove from the document, select Remove All. 
Remember though, that you cannot use the Undo feature to restore data that you 
remove through this process. 

 

Additional information 

For more information on personal and hidden information in 
Microsoft Office, go to Remove hidden data and personal information 
by inspecting documents, presentations, or workbooks. 

https://aka.ms/Remove-hidden-data-and-personal-information-by-inspecting-documents-presentations-or-workbooks
https://aka.ms/Remove-hidden-data-and-personal-information-by-inspecting-documents-presentations-or-workbooks
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Activity: Watch me first 
In this activity, the teacher will demonstrate inspecting a Word document and removing 
hidden data from it. 

Resources required 
You will need the following resource for this activity: 

• Open L5_T2_act_company_overview.docx in this lesson’s Learning Activity 
Resources. 

Activity instructions 
Participate in the activity by following these instructions: 

1. Observe as the teacher inspects the document for hidden data. 

2. Participate in the discussion about the importance of this process. 

3. Follow along as the teacher removes selected metadata from the file. 

Try-it: Check for hidden data and personal 
information 
  In this leveled Try-it, you’ll inspect documents for hidden data. You’ll remove 
personally identifiable information, and comments left by people who worked on the 
file. 

Try-it 1 
In this Try-it, you’ll remove personally identifiable information from a document. 

Resources 
You will need the following resource for this Try-it: 

• Open L5_T2_try1_quarterly_report_starter.docx in this lesson’s Learning Activity 
Resources. 

Instructions 
The following steps are the general tasks that you’ll need to perform during this Try-it: 

1. Save a copy of the file so you have a backup. 

2. Inspect the document for hidden data. 

3. Remove all document properties and personal information. 
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Try-it 2 
In this Try-it, you’ll remove only the comments left in a document by people who 
contributed to the file. 

Resources 
You will need the following resource for this Try-it: 

• Open L5_T2_try2_quarterly_report_starter.docx in this lesson’s Learning Activity 
Resources. 

Instructions 
The following steps are the general tasks that you’ll need to perform during this Try-it: 

1. Save a copy of the file so you have a backup. 

2. Inspect the document for hidden data. 

3. Remove all comments, revisions, and versions. 

Topic 3: Check for compatibility 
 Before sharing a document, you might want to verify that the document and its 

contents are compatible with earlier versions of Word. For example, you may create a 
file in Word 2019 with objects and elements available in the newest version, but you 
may have customers using an older version of Word that doesn’t support those 
elements. 

Use the Compatibility Checker to examine the document for compatibility issues. 
Select the File tab, and then select Info. Next, select Check for Issues, and then select 
Check Compatibility. The following screenshot depicts the Check for Issues options 
with Check Compatibility highlighted. 
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Figure 43: Check for Issues options with Check Compatibility highlighted 

The Compatibility Checker dialog box indicates which elements in the file are not 
compatible. The Summary lists each incompatible element or feature found in your 
document. To learn exactly which versions are affected by the incompatibility, select 
Select versions to show, and select the version or versions you want to include, as 
demonstrated in the following screenshot. 

 
Figure 44: The Compatibility Checker dialog box with Select versions to show selected 
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Based on the information in the dialog box, you can make decisions about your content. 
In some cases, you may want to change how you present information or infographics, or 
you may decide that the degradation is acceptable. 

If you’re wondering why you need to worry about older versions, think about the file’s 
intended audience. If they aren’t part of your organization, they might not be using the 
same version of Word. If you share a file with known incompatibilities, you run the risk 
of those users not being able to use or view it as you intended. 

  

Additional information 

For additional information on the compatibility checker, go to Check 
file compatibility with earlier versions. 

Activity: Show and tell 
In this activity, the teacher will demonstrate how to use the Thesaurus. 

Resources required 
You will need the following resource for this activity: 

• Open L5_T3_act_company_overview.docx in this lesson’s Learning Activity 
Resources. 

Activity instructions 
Follow along as the teacher demonstrates the Compatibility Checker and changes the 
document to improve compatibility. 

Try-it: Check for compatibility 
 In this standalone Try-it, you’ll check a document for compatibility issues and 

make a change to improve compatibility. 

Resources 
You will need the following resource for this Try-it: 

• Open L5_T3_try_quarterly_report_starter.docx in this lesson’s Learning Activity 
Resources. 

  

https://aka.ms/Check-file-compatibility-with-earlier-versions
https://aka.ms/Check-file-compatibility-with-earlier-versions
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Instructions 
The following steps are the general tasks that you’ll need to perform during this Try-it: 

1. Check the document for compatibility issues. 

2. Resolve the issue by replacing the incompatible feature with an image of the same 
content, which you can find at the end of the document. 

Topic 4: Check for accessibility issues 
 In the modern workplace, technology helps make content available to a wider 

audience than ever before. It’s important that the content you create is available to and 
useable by as many people as possible, regardless of abilities. The term for this is 
accessibility, and It’s critical to ensure that your documents can reach as many people as 
possible. Munson’s is committed to providing products for everyone in the community, 
which makes accessibility especially important! 

For example, people with disabilities often use assistive technology, such as screen 
readers, to access Word documents and many other types of files as well. A screen 
reader is software that reads content in a document aloud for people who might have 
difficulty seeing or reading text on a computer monitor. 

Use the Accessibility Checker 
To help find potential issues, Word offers a feature called the Accessibility Checker, 
which scans the document for content that people with disabilities might find difficult to 
read. To access the Accessibility Checker, select File, select Info, select Check for 
Issues, and then select Accessibility Checker. The following screenshot depicts the 
Check for Issues options with Check Accessibility highlighted. 



Managing references and finalizing documents 
 

 
77 

 
Figure 45: Check for Issues options with Check Accessibility highlighted 

Another, perhaps easier way to access the Accessibility Checker is from the ribbon. 
Select the Review tab, and then in the Accessibility group, select Check Accessibility 
as in the following screenshot. 

 
Figure 46: Check Accessibility in the Accessibility group 

Either method will open the Check Accessibility pane, which lists all the found 
accessibility issues in Inspection Results. When you select an issue, Additional 
Information presents details about why it’s a problem, and how to fix it. The following 
screenshot depicts the Accessibility Checker pane with a sample problem selected, and 
Additional Information explaining why it’s a problem. 
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Figure 47: The Accessibility Checker pane with a sample problem selected to show 
Additional Information 

Inspection Results are grouped into the following categories based on the severity of 
the issue: 

• Errors are the highest level of severity. Items from your document that are in this 
category highlight what people with disabilities will not be able to access with screen 
readers. Specific issues in this category are typically related to a lack of alternative 
text, missing table headings, and formatting that doesn’t meet accessibility 
requirements. 

• Warnings are a sign of elements and objects in your document that might be difficult 
for those with disabilities to read. These can include text wrapping, hyperlinks that 
don’t have screen tips, and improper heading labels. 
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• Tips provide you with areas where you could improve accessibility within your 
document. The areas highlighted in this section can vary, but might include the use 
of closed captions, using a hierarchy order for styles headings, and not using 
watermarks. 

 

Additional information 

For additional information on the Accessibility Checker, go to Improve 
accessibility with the Accessibility Checker. 

 

 

Additional information 

For additional information on the general accessibility tips and 
suggestions, go to Make your Word documents accessible to people 
with disabilities. 

Activity: Show me how 
In this activity, the teacher will guide you through completing an accessibility check and 
addressing common accessibility issues. 

Resources required 
You will need the following resource for this activity: 

• Open L5_T4_act_company_overview.docx in this lesson’s Learning Activity 
Resources. 

Activity instructions 
Participate in the activity by following these instructions: 

1. Complete an accessibility check as directed by the teacher. 

2. Correct all accessibility issues as directed by the teacher. 

Try-it: Check for accessibility issues 
 In this standalone Try-it, you will scan a document for accessibility issues and 

address the problems listed in the results. 

https://aka.ms/improve-accessibility-with-the-accessibility-checker
https://aka.ms/improve-accessibility-with-the-accessibility-checker
https://aka.ms/make-your-word-documents-accessible-to-people-with-disabilities
https://aka.ms/make-your-word-documents-accessible-to-people-with-disabilities
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Resources 
You will need the following resource for this Try-it: 

• Open L5_T4_try_quarterly_report_starter.docx in this lesson’s Learning Activity 
Resources. 

Instructions 
Scan the document for accessibility issues and correct any issues you find. 

Wrap-up 
Use these questions to check what you learned in this lesson:  

1. Which of the following can you address with the Document Inspector? 

Select all that apply. 

a. Personally, identifiable information stored in metadata 

b. Accessibility issues, such as missing Alt Text 

c. Excessive repetition of words and phrases in the document  

d. Comments and revisions left in the document 

2. Be sure to _________________________________ before using the Document Inspector. 

Fill in the blank space. 

3. Which of the following might you find with the Accessibility Checker? 

Select all that apply. 

a. Missing Alt Text 

b. The use of objects not compatible with older files 

c. Comments containing personal information 

d. Problems with color contrast 

e. Blank document properties 
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4. Which of the following are valid reasons for using document properties?

Select all that apply.

a. Organizing your files

b. Making files easier to search

c. Ensuring compatibility with older versions of Word

d. Protecting the identity of people who worked on the file

Glossary 
Accessibility The quality of being usable by everyone, including people with 

disabilities and users of assistive technology. 

Bibliography A detailed list of sources used in the document. 

Citation A reference to the original source of an idea. 

Document 
Property 

The tool Word uses to store and maintain metadata, or information 
about the document. 

Endnote A reference at the end of the document. 

Footer An area at the bottom of each page. 

Footnote A reference at the end of the page. 

Header An area at the top of each page. 

Proofing The process of checking a document for errors, such as misspelled 
words, incorrect punctuation, and flawed grammar. 

Table of Contents A brief list of the major sections in a document, typically found at the 
beginning of the text. 

Thesaurus A tool that suggests synonyms. 

Watermark Text or an image that you apply behind the content of a document. 

Table 2: Glossary terms and definitions 
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Cornerstone 
Overview 
In this cornerstone, you’ll finalize the Farm-to-Table Cookbook and the Food Catalog by 
adding a table of contents, footnotes, and endnotes, as necessary. You’ll manage and 
cite references in the Food Catalog, and you’ll create a bibliography of those sources. 
You’ll also use proofing tools to catch lingering spelling and grammar errors, and you’ll 
check for any issues with compatibility or accessibility. 

Objectives 
The following table outlines the Cornerstone objectives and their corresponding MOS 
exam objectives. 

Update document 
metadata 

• 1.3.2: Modify basic document properties

Insert and modify 
headers and 
footers 

• 1.1.3: Insert and modify headers and footers

Create and update 
a table of contents 

• 4.2.1: Insert tables of contents
• 4.2.2: Customize tables of contents

Insert and modify 
footnotes 

• 4.1.1: Insert footnotes and endnotes
• 4.1.2: Modify footnote and endnote properties

Check for spelling, 
grammar, and 
accessibility issues 

• 1.4.2: Locate and correct accessibility issues

Add and update 
bibliography 
sources 

• 4.1.3: Create and modify bibliography citation sources

Insert an in-text 
citation and a 
bibliography 

• 4.1.4: Insert citations for bibliographies
• 4.2.3: Insert bibliographies
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Customize the 
pages 

• 1.1.4: Configure page background elements 

Use the Thesaurus 
and resolve 
compatibility 
issues 

• 1.4.3: Locate and correct compatibility issues 

Table 3: Cornerstone objectives 

Duration 
50 minutes 

Instructions 
1. Complete the following tasks for each file. 

2. When saving your file, add your name to the end of the filename, for example: 
“Cornerstone_Cookbook_Dwayne_Espino.” Follow your teacher’s directions for where 
to save your files. 

3. When you’re done with the Cornerstone, assess your completion and enter the 
points you think you earned within the following task lists. You can ask for help from 
your teacher if required. 

Tasks 
You will work with two files in this Cornerstone. The following steps are the tasks you 
need to complete within each file. 

File 1: Cornerstone_cookbook_starter.docx 
Task: Add metadata (2 points) 
1. Open Cornerstone_cookbook_starter.docx, and access the document properties. 

Edit the Title property to Farm-to-Table Cookbook. (1 point) (Exam objective 1.3.2) 

2. Edit the Company property to Munson’s Pickles and Preserves Farm. (1 point) 
(Exam objective 1.3.2) 

Points scored: ________ / 2 
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Task: Insert and modify headers and footers (4 points) 
1. Add a header to the document using the built-in header style Sideline. It should 

display the Title property from the previous task. (1 point) (Exam objective 1.1.3) 

2. Modify the header so that it doesn’t appear on the first page of the cookbook, since 
that is going to be the cover. (1 point) (Exam objective 1.1.3) 

3. Create a footer with page numbers on the right side of the page. (2 points) (Exam 
objective 1.1.3) 

Points scored: _________ / 4 

Task: Create and update a Table of Contents (3 points) 
1. Navigate to the blank page (page 3) and create a table of contents with the Built-in 

style Automatic Table 2. (1 point) (Exam objective 4.2.1) 

2. The name of the last recipe, August harvest stew, is incorrectly set to the style 
Heading 3. Change it to Heading 2, and then update the table of contents so the 
recipe is listed correctly in the table. (2 points) (Exam objective 4.2.2) 

Points scored: ___________ / 3 

Task: Insert and modify footnotes (4 points) 
1. Navigate to the name of the second recipe, Carrot Cake. Add a footnote with the 

following text: This recipe was contributed by Fernando Vasquez, the Beekeeper 
at Munson’s Pickles and Preserves Farm. (1 point) (Exam objective 4.1.1) 

2. Change the footnote settings so that footnotes are lowercase Roman numerals, and 
apply the change to the entire document. This first footnote should have the 
reference mark i. (2 points) (Exam objective 4.2.2) 

3. The second-to-last ingredient in August harvest stew is white rice, cooked. Add a 
footnote to the end of that line with the following text: May be substituted with 
quinoa. (1 point) (Exam objective 4.1.1) 

Points scored: ____________ / 4 
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Task: Check for spelling, grammar, and accessibility issues (4 
points) 
1. Fix all spelling and grammar mistakes in the cookbook. (1 point)  

2. Check the document for accessibility concerns. Add appropriate Alt Text to the 
Munson’s logo. (2 points) (Exam objective 1.4.2) 

3. Mark the carrot as decorative. (1 point) (Exam objective 1.4.2) 

Points scored: ____________ / 4 

FILE 1 TOTAL POINTS: ___________/ 17 

File 2: Cornerstone_food_catalog_starter.docx 
Task: Add and update bibliography sources (3 points) 
1. Open Cornerstone_food_catalog_starter.docx, and add a new bibliography source 

to the document’s list of sources. The new source is a journal article titled “Successful 
Apple Orchards” by Hu Lin. It was published in a journal called “Apples” in 2019. (2 
points) (Exam objective 4.1.3) 

2. One of the sources already in the document is missing the author’s name. Edit Farm 
Information and add the author, Gregory Peeler. (1 point) (Exam objective 4.1.3) 

Points scored: ____________ / 3 

Task: Insert an in-text citation and a bibliography (2 points) 
1. The last apple on the first page is a “Granny Smith.” The paragraph that describes it, 

ending in “…tartness rather than sweetness” is from the “Successful Apple Orchards” 
journal article. Insert a citation for that reference. (1 point) (Exam objective 4.1.4) 

2. The last page in the document is blank to leave room for a bibliography. Add a 
bibliography formatted in APA style using the built-in References style. (1 point) 
(Exam objective 4.2.3) 

Points scored: ___________ / 2 
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Task: Customize the pages (3 points) 
1. You’ll be printing this document on an attractive, glossy paper, so you want to make 

sure it’s appealing. Change the background color of all pages to Blue, Accent 1, 
Lighter 80%. (1 point) (Exam objective 1.2.4) 

2. You’re almost finished with the Food Catalog. You want to make sure that any copies 
you print out don’t get distributed. Add a watermark with the diagonal text FINAL 
DRAFT. Set the watermark color to Blue, Accent 1. (2 points) (Exam objective 1.2.4) 

Points scored: ___________ / 3 

Task: Use the Thesaurus and resolve compatibility issues (3 
points) 
1. The first page includes the most repetitive words, such as the word “eating.” In the 

sentence about Fuji apples, use the Thesaurus and replace eating with the first 
suggested synonym. (1 point) 

2. Before you send the document out to the rest of the farm, you need to be sure 
everyone can open the document. Check for compatibility issues with Word 2007 
and Word 2010 only, because a few employees may have older versions of Word. 
The bibliography issue is okay because you won’t need to update that again. But the 
WordArt that says “Food Catalog” at the top of the first page is causing problems. 
Delete it and replace it with the same text formatted with the Title style. Run the 
compatibility check again to verify that there are no additional issues. (2 points) 
(Exam objective 1.4.1) 

Points scored: _____________ / 3 

FILE 2 TOTAL POINTS: ___________/ 11 

TOTAL POINTS: ____________ / 28 
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